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The most current information about your Avid editing application is available in 
the online version of the ReadMe. You should always check online for the most 
up-to-date release notes or ReadMe because the online version is updated 
whenever new information becomes available. To view these online versions, 
select ReadMe from the Help menu of your Avid editing application, or visit the 
Knowledge Base at www.avid.com/readme.

Installing the Avid editing application directly from the Avid Installation DVD 
requires your system to support a dual-layer DVD. If your system does not have a 
DVD drive that supports a dual-layer DVD, you can download the Avid editing 
application from the Avid Download Center at 
www.avid.com/support/downloads. 

Once you install your Avid editing application, you will activate the software with 
the Avid License Control tool. The Avid License Control tool also activates 
editing options. For information about the editing options, see “Activating 
Options and Features” on page 34.

n If you have an active Avid Support Contract, you might have the option to 
upgrade your software. See the instructions provided on the Avid Download 
Center for your upgrade or that came with your upgrade kit for more information.

c If you change your system configuration — for example, by replacing your 
hard drive, replacing a network adapter, or by upgrading your operating 
system — you must first deactivate your Avid software. For information on 
deactivation, see “Deactivating the Avid Editing Application and Options” on 
page 35.
 

http://www.avid.com/support/downloads
http://www.avid.com/readme


Before Installing the Avid Editing Application

Read through the following procedures prior to installing the editing application. 
Procedures are provided for upgrade customers or new users. Choose the 
applicable procedure for your installation:

New Users
If you are a new user and have never installed the editing application on your 
system, follow the instructions from page 6 to page 19. Start with “Installing the 
Avid Editing Application” on page 6.

Existing Users
If you are upgrading from a previous version of the editing application, you must 
uninstall the previous version before installing and activating the new software. 

n Before you uninstall your Avid editing application, write down your System ID. 
You will need your old System ID to activate your new software.

Follow the instructions from page 20 to page 29. Start with “Upgrading the Avid 
Editing Application” on page 20.

Installing the Avid Editing Application

For all Avid editing applications, log in as a user with administrative privileges, 
install the application, and initially start the application as a user with 
administrative privileges. If you are working in a shared storage environment, 
mount your workspaces. You may then subsequently run the Avid editing 
application as a regular User.

n Installing the editing application software might take some time. For the 
individual editing application, it might take 5 to 15 minutes to install. Installing 
the entire editing application suite might take up to 35 minutes to install.
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(Windows) To install the Avid editing application software:

1. Quit all active applications.

2. Insert the editing application DVD.

3. Click to Install the Avid Editor Suite or Individual Product and follow the on 
screen instructions.

n If the FilesInUse dialog box appears, you can safely select Ignore and continue.

n If you receive user access warnings during the installation, select Continue 
Anyway to continue your installation.

4. When prompted, select “Yes, restart my computer.”

5. Continue with “Starting the Avid Editing Application” on page 8.

(Macintosh) To install the Avid Editing application software:

1. Quit all applications.

2. Insert the editing application DVD.

3. Double-click EditingApplicationName.pkg.

4. Click to Install the Avid Editor Suite or Individual Product and follow the on 
screen instructions.

5. When prompted, select “Yes, restart my computer.”

6. Continue with “Starting the Avid Editing Application” on page 8.
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Starting the Avid Editing Application

The installation process adds a desktop or Dock icon and a pointer to your Avid 
editing application in the Start menu. 

If you install your Avid editing application on a laptop computer, a dialog box 
might open with a message about incompatible power management schemes. 
Avid recommends you use the “High Performance” power option for Windows 7 
when you work with the Avid editing applications. Other power schemes might 
affect performance of editing functions (for example, capture and digital cuts). 

After you install the software for your Avid editing application and start the 
application for the first time, you must activate your copy of the application.

(Windows) To start your Avid editing application, do one of the 
following:

t Click Start > All Programs > Avid > Avid editing application.

t Double-click the Avid editing application desktop icon.

The Welcome window opens. 

(Macintosh) To start your Avid editing application, do one of the 
following:

1. Click the alias icon for your Avid editing application on the Dock.

2. Or, select Go > Applications, and then double-click the Avid editing 
application folder. Then double-click the Avid editing application file.
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The Welcome window opens.
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3. Select one of the options to activate your software.

t To activate using Electronic Activation, select “I want to activate my 
software using the Internet, another computer, or a volume license 
server,” click Continue. 
The Avid License Control tool opens. Follow the steps in “Activating 
the Avid Editing Application using Electronic Activation” on page 12.

t To activate with a Hardware Key or dongle, select “I want to use a 
dongle to activate my software,” attach your entitled dongle and then 
click Continue.
The system confirms your information. When the activation is 
complete, a message informs you that your software has been 
successfully activated.

t To run in Trial Mode, select “I want to run a fully-featured trial version 
of the Avid editing application for 30 days,” click Continue.
Your software has been successfully activated.
For additional information about Trial Mode, see “Running the 30-Day 
Trial” on page 30.



What Will I Need to Activate My Avid Editing Application?

Identification (ID) 
Numbers: Where you can find them:

Activation ID The inside cover of this guide.

If you purchased from the Avid web store, you receive your 
Activation ID through an Avid e-mail.

If you purchased from the Avid web store, log in to your Store 

account at http://account.avid.com/.

System ID For a new user, the inside cover of this guide.
For an existing user, you will need your old System ID.

If you purchased online, you received your System ID from 
Avid by e-mail.

The Avid editing application splash screen (Help > About 
Avid editing application).

The Console of the Avid editing application (Tools > Console, 
then scroll to System ID).

If you purchased from the Avid web store, you can view your 
System ID number by logging in to your Store account at 
http://account.avid.com/.
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Activating the Avid Editing Application using Electronic 
Activation

• With Internet access - See “Activating using Electronic Activation with an 
Internet Connection” on page 13.

• Without Internet access - See “Activating using Electronic Activation 
without an Internet Connection” on page 17.

• Through a Volume License Server - See “Activating the Avid Editing 
Application using a Volume License Server” on page 19.

System ID (continued) Once activated, the License Profile tab of the Avid License 
Control tool displays information about your system. Click 
Copy to copy the information to your Clipboard. You can then 
cut and paste from the clipboard to an e-mail or create a text 
file. This is helpful if you need to save this information for 
your records or need to send system information to Avid 
Customer Support.

Device ID Only needed if you are activating your software on a system 
that is not connected to the Internet. This will be provided to 
you through the Avid License Control tool during activation.

Identification (ID) 
Numbers: Where you can find them:
12 Installation Guide for Avid Editing Applications



Activating using Electronic Activation with an Internet 
Connection

1. With the Avid License Control tool open, click Activate next to the Avid 
editing application.
Activating using Electronic Activation with an Internet Connection 13



The following opens.

2. Select “I am connected to the Internet and will use this computer,” then click 
Continue.
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A window opens which allows you to enter system information and register 
your product.

3. Enter your system identification number in the System ID text box. To find 
your System ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.

4. Enter your activation identification number in the Activation ID text box. To 
find your Activation ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.

5. If you want to review Avid’s privacy policy, click Read Privacy Policy. 
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6. Do one of the following:

t Select “Register your software,” and then click Continue.

A registration dialog box opens. Avid’s online registration lets you 
receive important updates and maintenance information.

t Select “Don’t register your software,” and then click Activate.

The Avid License Control tool confirms your system information. 
When the activation is complete, a message informs you that your 
software has been successfully activated.

n  If you do not want to register your software now, you can register at any time by 
selecting Special > Register in your Avid editing application.

7. If you choose to register your software, do the following:

a. In the Register dialog box, type your name, address, and contact 
information in the appropriate text boxes. Asterisks (*) indicate 
required fields.

b. Click Next

A registration dialog box opens.

c. Enter the appropriate product and customer information. 

d. Click Activate and Register.

8. If the Avid editing application is open, you should restart it for the changes 
to take affect.
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Activating using Electronic Activation without an Internet 
Connection

1. With the Avid License Control tool open, click Activate next to the Avid 
editing application.

The Activation window opens.

2. Select “I am not connected to the Internet and will be using another 
computer that is connected to the Internet,” then click Continue.

3. Enter your system identification number in the System ID text box. To find 
your System ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.

n Your Device ID displays at the bottom of the Activation page, write this number 
down to use later.

4. Enter your activation identification number in the Activation ID text box. To 
find your Activation ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.

5. Click Next.
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6. Follow the instructions in the Avid License Control tool, then click Next.

7. On a computer with an Internet connection, open a Web browser and 
navigate to http://avid.com/license.

8. Follow the onscreen instructions on the web page.

The website creates a license.bin file. This file contains license information 
needed to activate your Avid editing application.
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9. Once you retrieve the license.bin file, return to the computer you want to 
activate.

10. In the Avid License Control tool, click Browse and navigate to the 
license.bin file on your system, then click Open.

The Activation tool confirms your system information. When the activation 
is complete, a message informs you that your software has been successfully 
activated and the button changes to Deactivate.

n Repeat the previous steps for each editing application or option you need to 
activate.

11. If the Avid editing application is open, you should restart for any changes to 
take effect.

Activating the Avid Editing Application using a Volume License 
Server

You can activate and manage multiple editing clients using a volume license 
server. For more information, see the FlexNet Device Manager for Avid guide on 
the Knowledge Base. 
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Upgrading the Avid Editing Application

You can upgrade your Avid editing application from either an existing software 
license or a dongle license. If you upgrade from a dongle license or are changing 
product models, then your upgrade kit includes a dongle updater card, upgrade 
code, and software activation code. Please see the instructions in your upgrade kit 
to update your software.

If you previously purchased PhraseFind, PhraseFind Language Packs or 
ScriptSync, your license activation should automatically update. If you purchase 
new options, you will be provided with a new Activation ID.

n Upgrading your dongle license to a software license disables your dongle. Once 
you have activated your software license, you do not need and are not able to use 
the dongle to run your Avid editing application.

If you upgrade your existing license and you have an active Avid Support 
Contract, please read the instructions provided on the Avid Download Center or 
that came with your upgrade kit before updating your system. All Avid Support 
Contract customers must use the Versioner.avd. file to upgrade their software as 
described in the last procedure in this topic. For more information, view the 
“Software Licensing Upgrade Process for Support Customers” topic on the Avid 
Knowledge Base (www.avid.com/US/support).

Below are high level steps you should follow if you are upgrading your Avid 
editing system, PhraseFind or ScriptSync options.
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Upgrade Workflow 

1. Uninstall your existing Avid editing application.

See “Uninstalling the Avid Editing Application” on page 36.

PhraseFind and ScriptSync uninstall with your Avid editing application.

n Before you uninstall your Avid editing application, write down your System ID. 
You will need your old System ID to activate your new software.

2. Install your new Avid editing application.

See “Installing the Avid Editing Application” on page 6.

PhraseFind and ScriptSync install with your Avid editing application. If you 
previously purchased PhraseFind, PhraseFind Language Packs or 
ScriptSync, your license activation should automatically update. If you 
purchase new options, you will be provided with a new Activation ID.

3. Activate your Avid editing application.

Depending on your setup, see the following upgrade steps. 
For more information about the Avid License Control tool, see “Activating 
the Avid Editing Application using Electronic Activation” on page 12.

4. Activate PhraseFind, PhraseFind Language Pack, or ScriptSync.

See “Activating the Avid Editing Application using Electronic Activation” 
on page 12.
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To upgrade your Avid editing application with an Internet connection 
from an existing software license:

1. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens.

2. Click Activate next to the Avid editing application.

The Activation window opens.

3. Select “I am connected to the Internet and will use this computer,” then click 
Continue.

A window opens which allows you to enter system information and register 
your product. 

4. If your Systems ID does not display, enter your system identification number 
in the System ID text box. For existing customers, use your old System ID.
To find your System ID if it does not display, see “What Will I Need to 
Activate My Avid Editing Application?” on page 11.

n If your previous editor included purchased options, for example PhraseFind or 
ScriptSync, these options will activate automatically with your upgrade.

5. Enter your activation identification number in the Activation ID text box. 
Use the Activation ID number for your new version of the software.
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6. Do one of the following:

t If you have never registered your product, select “Register your product 
with Avid Technology, Inc. now.” If you want to review Avid’s privacy 
policy, click Read Privacy Policy. Then click Next.

A registration dialog box opens. Avid’s online registration lets you 
receive important updates and maintenance information.

t Select “Don’t register at this time,” and then click Activate.

The Activation tool confirms your system information. When the 
activation is complete, a message informs you that your software has 
been successfully activated.

n  If you do not want to register your software now, you can register at any time by 
selecting Special > Register in your Avid editing application.

7. If you chose to register your software in step 6, do the following:

a. In the Register dialog box, type your name, address, and contact 
information in the appropriate text boxes. Asterisks (*) indicate 
required fields.

b. Click Next

A registration dialog box opens.

c. Enter the appropriate product and customer information.

d. Click Activate and Register.

The Activation tool confirms your system information. When the 
activation is complete, a message informs you that your software has 
been successfully activated and the button changes to Deactivate.

8. Click OK. 
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To upgrade your Avid editing application with an Internet connection 
from a dongle license to a software license:

1. Attach your dongle to your Avid editing system.

2. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens.

3. Click Activate next to the Avid editing application.

The Activation dialog box opens.

4. Select “I am connected to the Internet and will use this computer,” then click 
Continue.

A window opens which allows you to enter system information and register 
your product. 

5. If your Systems ID does not display, enter your system identification number 
in the System ID text box. For existing customers, use your old System ID.
To find your System ID if it does not display, see “What Will I Need to 
Activate My Avid Editing Application?” on page 11.

n If your previous editor included purchased options, for example PhraseFind or 
ScriptSync, these options will activate automatically with your upgrade.

6. Enter your activation identification number in the Activation ID text box. To 
find your Activation ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.
24 Installation Guide for Avid Editing Applications



Upgrading the Avid Editing Application 25

7. Do one of the following:

t If you have never registered your product, select “Register your product 
with Avid Technology, Inc. now.” If you want to review Avid’s privacy 
policy, click Read Privacy Policy. Then click Next.

A registration dialog box opens. Avid’s online registration lets you 
receive important updates and maintenance information.

t Select “Don’t register at this time,” and then click Activate.

The Activation tool confirms your system information. When the 
activation is complete, a message informs you that your software has 
been successfully activated.

n  If you do not want to register your software now, you can register at any time by 
selecting Special > Register in your Avid editing application.

8. If you chose to register your software in step 7, do the following:

a. In the Register dialog box, type your name, address, and contact 
information in the appropriate text boxes. Asterisks (*) indicate 
required fields.

b. Click Next

A registration dialog box opens.

c. Enter the appropriate product and customer information. 

d. Click Activate.



9. The system asks if you are sure you want to deactivate your dongle. Click 
OK.

The Activation tool confirms your system information. When the activation 
is complete, a message informs you that your software has been successfully 
activated.

10. Click OK.

To upgrade your Avid editing application without an Internet 
connection to a software license: 

1. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens. 

2. Click Activate next to the Avid editing application.

The Activation window opens.

3. Select “I am not connected to the Internet and will be using another 
computer that is connected to the Internet,” then click Continue.

4. If your Systems ID does not display, enter your system identification number 
in the System ID text box. For existing customers, use your old System ID.
To find your System ID if it does not display, see “What Will I Need to 
Activate My Avid Editing Application?” on page 11.

n If your previous editor included purchased options, for example PhraseFind or 
ScriptSync, these options will activate automatically with your upgrade.

n Your Device ID displays at the bottom of the Activation page, write this number 
down to use later.
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5. Enter your activation identification number in the Activation ID text box. To 
find your Activation ID, see “What Will I Need to Activate My Avid Editing 
Application?” on page 11.

n Leave the Avid License Control tool open on the system you need to activate. You 
will need to enter additional information.

6. Click Next.

7. Follow the instructions in the Avid License Control tool, then click Next.

8. On a computer with an Internet connection, open a Web browser and 
navigate to http://avid.com/license.

9. Follow the onscreen instructions on the web page.

The website creates a license.bin file. This file contains license information 
needed to activate your Avid editing application.

10. Once you retrieve the license.bin file, return to the computer you want to 
activate.

11. In the Avid License Control tool, click Browse and navigate to the 
license.bin file on your system, then click Open.

The Activation tool confirms your system information. When the activation 
is complete, a message informs you that your software has been successfully 
activated and the button changes to Deactivate.

n Repeat the previous steps for each editing application or option you need to 
activate.

12. If the Avid editing application is open, you should restart for any changes to 
take effect.

http://avid.com/license


To upgrade your Avid editing application with a dongle:

1. Make sure you have attached your dongle to your Avid editing system.

2. Navigate to the directory where DongleManager.exe is installed:

t (Windows) C:\Program Files\Avid\Utilities\DongleManager

t (Macintosh) Macintosh HD\Applications\Utilities\Avid 
Utilities\DongleManager

3. Double-click the DongleManager.exe

The Dongle Manager window opens.

4. Click the Update tab.

5. Click Open, and navigate to the location of your dongle updater (.avd) file.

6. Select the updater file and click Open.

7. Click Update.

The DongleManager.exe application updates your dongle and displays a 
“Verification Complete” message.

8. Start your Avid editing application.

The Welcome window opens.

9. Select “I want to use a dongle to activate my software.”

10. Click Continue.

The system confirms your information. When the activation is complete, a 
message informs you that your software has been successfully activated.
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To upgrade your Avid editing application using the Versioner.avd file 
(Avid Support Contract customers only): 

1. Download the Versioner.avd file for your editing application.

2. Place the Versioner.avd file in the editing application folder:

(Windows) [drive]:/Program Files/Avid/[Avid editing application]

(Macintosh) Macintosh HD/Applications/[Avid editing application]

3. Start your Avid editing application.

The Avid License Control tool opens. 

4. Click Activate next to the Avid editing application.

5. Do one of the following:

t Select “I am connected to the Internet and will use this computer.”

t Select “I am not connected to the Internet and will be using another 
computer that is connected to the Internet.”

6. Click Continue.

The Avid Activation dialog box opens. The system auto-populates your 
System ID and the Activation ID. 

n If you use a dongle, the System ID and Activation ID will only populate if you 
have your dongle attached.

7. Continue with the upgrade license activation procedure described in this 
section for the license option you selected in step 5.
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Running the 30-Day Trial

Before you purchase the Avid editing application, PhraseFind or ScriptSync, you 
can try it out for a 30-day period. If you run the 30-day trial of the Avid editing 
application, you also get a 30-day trial of PhraseFind and ScriptSync. Your 30-day 
trial of PhraseFind also includes access to all available languages during the trial. 
You do not need to activate any additional language packs at this time. However, 
you need to select your language from the Select a Language menu in the 
PhraseFind window.

If you already own an Avid editing application, you can run a 30-day trial of 
PhraseFind or ScriptSync.

After the 30 days, if you do not purchase the Avid editing application, PhraseFind 
or ScriptSync, you will no longer have access to the product and feature. The 
system keeps you informed of how many days you have left before the trial period 
ends.

n Any bins or projects created during the 30-day trial will only be usable when you 
activate a full editing license.

To use your Avid editing application for a 30-day trial period:

1. Start your Avid editing application.

The Welcome window opens.

2. Select “I want to run a fully-featured, trial version of the Avid editing 
application for 30 days.”
30 Installation Guide for Avid Editing Applications



3. Click Continue.

Your software has been successfully activated. At any time during the 
30-day trial period, you can choose to purchase a copy of your Avid editing 
application. If you choose not to purchase the software, your Avid editing 
application is deactivated when the 30-day trial expires.

To run PhraseFind for a 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Press Ctrl+F or Command+F or select Edit > Find.

The Find window opens.

3. Type a word or phrase in the text box, then click the PhraseFind button.

The system checks to see if you have PhraseFind on your system and then a 
dialog box opens.

4. Click Run Trial.

The system restarts your Avid editing application and you then have access 
to PhraseFind.

Your 30-day trial of PhraseFind also includes access to all available 
languages during the trial. You do not need to activate any additional 
language packs at this time. However, you need to select your language from 
the Select a Language menu in the PhraseFind window.

5. In the PhraseFind window, select your language from the Select a Language 
menu and wait for the PhraseFind Index to turn solid green.
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To run ScriptSync for a 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Create a script, File > New Script.

3. Browse to your script then click Open.

4. In the script, click the section where you want to place the clip (take).

The section highlights.

5. From a bin, drag the clip to the selected section in the script.

The box below the clip in the script, should highlight black. This indicates 
that the clip is selected in the script.

6. Select Script > ScriptSync.

The system checks to see if you have ScriptSync on your system and then a 
dialog box opens.

7. Click Run Trial.

You have immediate access to the ScriptSync window.

To purchase the Avid editing application during your 30-day trial 
period:

t Go to the Avid web store: http://shop.avid.com/store/ to purchase your Avid 
editing application.
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To purchase PhraseFind or ScriptSync during your 30-day trial 
period:

1. Open your Avid editing application and an Avid project.

2. For ScriptSync, follow steps 1 through 5 under “To run ScriptSync for a 
30-day trial period:” on page 32, then select Script > ScriptSync.

3. For PhraseFind, press Ctrl+F or Command+F or select Edit > Find.

The Find window opens.

4. For PhraseFind, type a word or phrase in the text box, then click the 
PhraseFind button.

The system informs you of how many days you have left on your 30-day 
trial. 

5. Click Buy.

n If the Buy button does not appear, close the Find window and relaunch your Avid 
editing application. Repeat the steps above.

The system opens the Avid web store, allowing you to purchase PhraseFind 
or ScriptSync. Once you purchase and obtain your Activation ID, you can 
activate PhraseFind or ScriptSync.

A dialog box opens informing you that activation will quit your Avid editing 
application and launch the Avid License Control tool.

6. Click Continue.

The Avid License Control tool opens.

To activate, see “Activating the Avid Editing Application using Electronic 
Activation” on page 12 to continue.
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Activating Options and Features

In addition to activating the Avid editing application, there are several editing 
options or features that can be activated through the Avid License Control Tool. 

To activate these features, follow the steps in “Activating the Avid Editing 
Application using Electronic Activation” on page 12 or see the appropriate guide 
listed below.

• PhraseFind
The PhraseFind option (phonetic find) searches and finds audio dialogue 
throughout bins in a single project. PhraseFind is purchased separately and 
includes a free language pack of your choice. For more information, see 
“Purchasing and Activating PhraseFind” in the Avid editing Help or in the 
Getting Started with PhraseFind guide.

• ScriptSync
ScriptSync uses phonetic-indexing technology to analyze the audio portion 
of a clip and match it to lines of the script text. ScriptSync is purchased 
separately. For more information, see “Purchasing and Activating 
ScriptSync” in the Avid editing Help or in the Getting Started with 
ScriptSync guide.

• PhraseFind Language Pack
Additional language packs are purchased to be used with PhraseFind. 
Language packs are purchased separately. For more information, see 
“Activating Additional Regional Language Packs” in the Avid editing Help 
or in the Getting Started with PhraseFind guide.
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• AVCHD Dolby AC-3 import or link to AMA
This feature is used to import or AMA link to AVCHD transport stream 
(.mts) files. If you are not connected to the Internet the first time you import 
or AMA link to .mts files, the system opens a dialog box and then the Avid 
License Control tool. Follow the onscreen instructions to activate this 
feature. If you are connected to the Internet, activation is automatic.

n The AVCHD Dolby AC-3 feature only appears if you use this format. You will not 
normally see this option in the Avid License Control tool.

Deactivating the Avid Editing Application and Options

If you need to move your Avid editing application to a different computer, 
deactivate the Avid editing application and options before you uninstall the Avid 
editing application.

Deactivate PhraseFind and ScriptSync first, then deactivate the Avid editing 
application.

n You must have an Internet Connection to deactivate the software and its options.

n You do not need to deactivate a Trial version.

Deactivating the Avid editing application and options:

1. From your Avid editing application, select Special > Deactivate Software 
License.

2. A message appears informing you that the Avid editing application will 
close and the Avid License Control tool will open, click Continue.

3. A dialog box opens and asks if you want to leave the Avid editing 
applications, click Leave.
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4. Or go to the following location to open the Avid License Control tool:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens. 

5. Next to the Avid editing application, PhraseFind or ScriptSync, click 
Deactivate.

If you are deactivating PhraseFind, a message appears informing you that the 
language packs associated with PhraseFind will also be deactivated. 

6. Click Yes.

The system deactivates the selected item and the button changes to Activate.

7. Click Quit to close the window.

Uninstalling the Avid Editing Application

Prior to installing the editing application, you should uninstall Digi Drivers using 
Programs and Features from the Control Panel. Reboot the system and then install 
the new editing application. If you do not remove the Digi Drivers, the AudioSuite 
plug-ins do not load and you might receive either the error message “This 
software requires installation of device driver TPkd and a reboot before running” 
or a “DAE Interface NOT Available” error message. If you see these errors on a 
clean installation on a brand new system, install Hot fix KB926255 from 
Windows Update to fix the problem.

For all Avid editing applications, log in and initially start the application as a user 
with administrative privileges. If you are working in a shared storage 
environment, mount your workspaces. You may then subsequently run the Avid 
editing application as a regular User.
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If you use any Pro Tools audio devices — for example, any of the Avid Mbox 
family of devices or the Avid Pro Tools|HD Native hardware — you must install 
the device drivers separately. Avid audio device drivers are located in the 
following directory:

• (Windows) Program Files\Avid\Utilities\
AudioDriverInstallers

• (Macintosh) Applications\Utilities\Avid Utilities\Avid 
Audio Drivers

(Windows) To uninstall the Avid editing application software do one 
of the following:

1. Quit all active applications.

2. Access the Control Panel and select Programs and Features. Then select the 
editing application and click Uninstall.

(Macintosh) To uninstall the Avid editing application software:

1. Quit all active applications.

2. Go to Applications/Avid_Uninstaller/AvidEditingApplication.

3. Double-click the AvidEditingApplication uninstaller.

4. Follow the on-screen prompts.
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Firmware Update Note

When you first start your editing application after installing, you might receive a 
dialog box requiring you to update the Avid hardware firmware. Choose to 
Update. During the update process, do not access any other applications or move 
any of the active windows. Accessing another application might result in the 
update completion dialog box being hidden. If this happens, you will see the 
update progress stay at 100% but have no option to proceed. The hidden window 
which states the update is complete and prompts you to shut down your system 
cannot be brought to the foreground. If this happens, you must shut down — not 
just restart — the system and then power it up again.
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2 Guide d'installation des applications de montage 
Avid

Les informations les plus récentes concernant votre application de montage Avid 
sont disponibles dans la version en ligne du document Lisez-moi (ReadMe). 
Recherchez systématiquement sur notre site Web les dernières notes de version ou 
le document Lisez-moi le plus récent. La documentation en ligne est mise à jour 
chaque fois que de nouvelles informations sont disponibles. Pour consulter les 
versions en ligne, sélectionnez ReadMe dans le menu d'aide de votre application 
de montage Avid ou visitez la Base de connaissances en ligne à l'adresse 
www.avid.com/readme.

Pour installer l'application de montage Avid directement depuis le DVD 
d'installation Avid, votre système doit pouvoir lire les DVD double couche. Si 
votre système ne dispose pas de lecteur DVD de ce type, vous pouvez télécharger 
l'application de montage depuis le centre de téléchargement Avid sur la page 
www.avid.com/fr/support/downloads. 

Une fois l'application de montage Avid installée, vous devrez activer le logiciel à 
l'aide de l'outil Avid License Control. Cet outil active également les options de 
montage. Pour plus d'informations sur les options de montage, reportez-vous à la 
section « Activation des options et fonctionnalités », page 69.

n Si vous possédez un contrat de support Avid valide, une mise à niveau de votre 
logiciel peut vous être proposée. Pour en savoir plus, reportez-vous aux 
procédures de mise à niveau accessibles depuis le Centre de téléchargement Avid 
ou consultez les instructions accompagnant votre kit de mise à niveau.
 

http://www.avid.com/readme
http://www.avid.com/support/downloads


c Si vous modifiez la configuration de votre système (remplacement du disque 
dur, d'un adaptateur réseau ou mise à niveau de votre système d'exploitation, 
par exemple), vous devez d'abord désactiver votre logiciel Avid. Pour plus 
d'informations sur la désactivation, reportez-vous à la section 
« Désactivation de l'application de montage Avid et de ses options », page 70.

Avant l'installation de l'application de montage Avid

Lisez les procédures suivantes avant d'installer l'application de montage. Elles 
sont destinées aux nouveaux utilisateurs, ainsi qu'aux personnes effectuant une 
mise à niveau. Sélectionnez la procédure appropriée pour votre installation.

Nouveaux utilisateurs
Si vous êtes un nouvel utilisateur et n'avez jamais installé l'application de montage 
sur votre système, suivez les instructions de la page 41 à la page 53. Commencez 
par la section « Installation de l'application de montage Avid », page 41.

Anciens utilisateurs
Si vous procédez à la mise à niveau d'une version antérieure de l'application de 
montage, désinstallez la version antérieure avant d'installer et d'activer le nouveau 
logiciel. 

n Avant de désinstaller votre application de montage Avid, notez votre ID système. 
Votre ancien ID système

 sera nécessaire pour activer votre nouveau logiciel.

Suivez les instruction de la page 54 à la page 64. Commencez par la section 
« Mise à niveau de l'application de montage Avid », page 54.
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Installation de l'application de montage Avid

Pour toutes les applications de montage Avid, connectez-vous à votre ordinateur 
en tant qu'administrateur, installez l'application, puis lancez-la pour la première 
fois en tant qu'administrateur. Si vous travaillez dans un environnement de 
stockage partagé, montez vos workspaces. Vous pourrez ensuite exécuter 
l'application de montage Avid en tant qu'utilisateur normal.

n L'installation du logiciel de l'application de montage peut être longue. Celle de la 
seule application de montage peut durer de 5 à 15 minutes. L'installation de la 
suite de montage dans son intégralité peut prendre jusqu'à 35 minutes.

(Windows) Pour installer le logiciel de l'application de montage Avid :

1. Quittez toutes les applications en cours d'exécution.

2. Insérez le DVD de l'application de montage.

3. Sélectionnez l'option Avid Editor Suite (suite de montage Avid) ou 
Individual Product (produit unique) et suivez les instructions à l'écran.

n Si la boîte de dialogue FilesInUse (Fichiers en cours d'utilisation) s'ouvre, 
sélectionnez Ignore (Ignorer) et continuez.

n Si des alertes d'accès utilisateur s'affichent à l'écran au cours de l'installation, 
sélectionnez Continue Anyway (Continuer) pour poursuivre l'installation.

4. À l'invite, sélectionnez Yes, restart my computer (Oui, redémarrer 
l'ordinateur).

5. Passez ensuite à la section « Démarrage de l'application de montage Avid », 
page 42.
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(Macintosh) Pour installer le logiciel de l'application de montage Avid :

1. Quittez toutes les applications.

2. Insérez le DVD de l'application de montage.

3. Double-cliquez sur le fichier NomApplicationMontage.pkg.

4. Sélectionnez l'option Avid Editor Suite (suite de montage Avid) ou 
Individual Product (produit unique) et suivez les instructions à l'écran.

5. À l'invite, sélectionnez Yes, restart my computer (Oui, redémarrer 
l'ordinateur).

6. Passez ensuite à la section « Démarrage de l'application de montage Avid », 
page 42.

Démarrage de l'application de montage Avid

La procédure d'installation ajoute une icône sur le bureau ou sur le Dock, ainsi 
qu'un raccourci vers l'application de montage Avid dans le menu Démarrer. 

Si l' application Avid est installée sur un ordinateur portable, il est possible qu'une 
boîte de dialogue affiche un message signalant une incompatibilité de modes de 
gestion de l'alimentation. Avid recommande d'utiliser l'option d'alimentation 
Hautes performances sous Windows 7 lorsque vous utilisez les applications de 
montage Avid. L'utilisation d'autres modes de gestion de l'alimentation risque 
d'altérer les performances des fonctions de montage (par exemple pour la capture 
ou les reports sur bande). 

Une fois le logiciel de l'application de montage Avid installé et l'application 
démarrée pour la première fois, vous devez activer votre copie de l'application.
42 Guide d'installation des applications de montage Avid



(Windows) Pour exécuter l'application Avid, effectuez l'une des 
actions suivantes :

t Cliquez sur Démarrer > Tous les programmes > Avid > Application de 
montage Avid.

t Double-cliquez sur l'icône du bureau de l'application de montage Avid.

La fenêtre d'accueil s'affiche. 

(Macintosh) Pour exécuter l'application Avid, effectuez l'une des 
actions suivantes :

1. Cliquez sur l'icône d'alias de l'application de montage Avid sur le Dock.

2. Ou sélectionnez Aller à > Applications, puis double-cliquez sur le dossier de 
l'application de montage Avid. Ensuite, double-cliquez sur le fichier de 
l'application de montage Avid.
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La fenêtre d'accueil s'affiche.

3. Sélectionnez l'une des options pour activer votre logiciel.

t Pour procéder à l'activation électronique, sélectionnez I want to activate 
my software using the Internet, another computer, or a volume license 
server (Je souhaite activer mon logiciel via Internet, un autre ordinateur 
ou un serveur de licences en volume), puis cliquez sur Continue. 
L'outil Avid License Control s'ouvre. Suivez la procédure indiquée 
dans la section « Activation électronique de l'application de montage 
Avid », page 47.



t Pour procéder à l'activation à l'aide d'une clé matérielle ou dongle, 
sélectionnez I want to use a dongle to activate my software (Je souhaite 
utiliser un dongle pour activer mon logiciel), connectez votre clé 
autorisée, puis cliquez sur Continue.
Le système vérifie vos informations. Une fois l'activation terminée, un 
message vous informe que votre logiciel a été activé avec succès.

t Pour utiliser la version d'évaluation, sélectionnez I want to run a 
fully-featured trial version of the Avid editing application for 30 days 
(Je souhaite utiliser une version d'évaluation complète de l'application 
de montage Avid pendant 30 jours), puis cliquez sur Continue.
Votre logiciel a été activé avec succès.
Pour plus d'informations sur la version d'évaluation, reportez-vous à la 
section « Utilisation de la version d'évaluation de 30 jours », page 65.

De quoi aurai-je besoin pour activer mon application de montage 
Avid ?

Numéros 
d'identification (ID) Où les trouver ?

ID d'activation Sur la couverture intérieure de ce guide.

Si vous avez acheté votre produit sur la boutique en ligne 
Avid, vous avez dû recevoir votre ID d'activation Avid par 
e-mail.
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Si vous avez acheté votre produit sur la boutique en ligne Avid, 
connectez-vous à votre compte sur la page 
http://account.avid.com/.

ID système Pour un nouvel utilisateur, sur la couverture intérieure de ce 
guide. Pour un ancien utilisateur, vous aurez besoin de votre 
ancien ID système.

Si vous avez acheté l'application en ligne, vous avez reçu votre 
ID système par e-mail.

Sur l'écran de démarrage de l'application de montage Avid 
(Help > About Avid editing application).

Sur la console de l'application de montage Avid (Tools > 
Console, puis faites défiler jusqu'à System ID).

Si vouz avez acheté votre produit sur la boutique en ligne Avid, 
vous pouvez consulter votre numéro d’ID système en vous 
connectant à votre compte sur la page http://account.avid.com/. 

Numéros 
d'identification (ID) Où les trouver ?
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Activation électronique de l'application de montage Avid
• Avec accès Internet : reportez-vous à la section « Activation électronique de 

l'application de montage Avid avec une connexion Internet », page 48.

• Sans accès Internet : reportez-vous à la section « Activation électronique de 
l'application de montage Avid sans connexion Internet », page 52.

• Via un serveur de licences en volume : reportez-vous à la section 
« Activation de l'application de montage Avid via un serveur de licences en 
volume », page 53.

ID système (suite) Après activation, l'onglet License Profile (Profil Licence) de l'outil 
Avid License Control affiche des informations sur votre système. 
Cliquez sur Copy pour copier ces informations dans le 
presse-papiers. Vous pouvez ensuite les coller à partir du 
presse-papiers dans un e-mail, ou créer un fichier texte. Vous 
pouvez ainsi sauvegarder ces informations dans vos archives 
personnelles ou les communiquer au support client Avid.

ID de périphérique Uniquement nécessaire pour l'activation de votre logiciel sur un 
système non connecté à Internet. Il vous sera fourni via l'outil 
Avid License Control au cours de l'activation.

Numéros 
d'identification (ID) Où les trouver ?
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Activation électronique de l'application de montage Avid avec 
une connexion Internet

1. Lorsque l'outil Avid License Control est ouvert, cliquez sur Activate 
(Activer) à côté de l'application de montage Avid.
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La fenêtre suivante s'ouvre.

2. Sélectionnez I am connected to the Internet and will use this computer (Cet 
ordinateur est connecté à Internet, je l'utiliserai pour l'activation), puis 
cliquez sur Continue.
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Une fenêtre vous permettant de saisir les informations système et 
d'enregistrer votre produit s'ouvre.

3. Saisissez votre numéro d'ID système dans la zone System ID. Pour trouver 
votre ID système, reportez-vous à la section « De quoi aurai-je besoin pour 
activer mon application de montage Avid ? », page 45.

4. Saisissez le numéro d'identification d'activation dans la zone Activation ID. 
Pour trouver votre ID d'activation, reportez-vous à la section « De quoi 
aurai-je besoin pour activer mon application de montage Avid ? », page 45.

5. Si vous souhaitez consulter la politique de confidentialité d'Avid, cliquez sur 
le bouton Read Privacy Policy. 
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6. Effectuez l'une des opérations suivantes :

t Sélectionnez Register your software (Enregistrer votre logiciel), puis 
cliquez sur Continue.

Une boîte de dialogue d'enregistrement s'affiche. L'enregistrement en 
ligne sur le site Avid vous permet de recevoir d'importantes mises à 
jour et informations de maintenance.

t Sélectionnez Don’t register your software (Ne pas enregistrer votre 
logiciel), puis cliquez sur Activate (Activer).

L'outil Avid License Control vérifie vos informations système. Une fois 
l'activation terminée, un message vous informe que votre logiciel a été 
activé avec succès.

n  Si vous préférez remettre l'enregistrement de votre produit à plus tard, vous 
pourrez le faire à tout moment en sélectionnant Special > Register dans votre 
application de montage Avid.

7. Si vous choisissez d'enregistrer votre produit, procédez comme suit :

a. Depuis la boîte de dialogue d'enregistrement, renseignez vos nom, 
adresse et coordonnées dans les zones appropriées. Les astérisques (*) 
désignent les champs obligatoires.

b. Cliquez sur Next.

Une boîte de dialogue d'enregistrement s'affiche.

c. Saisissez les informations appropriées (produit et client). 

d. Cliquez sur Activate and Register (Activer et enregistrer).

8. Si l'application de montage Avid est ouverte, redémarrez-la afin d'appliquer 
les modifications.
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Activation électronique de l'application de montage Avid sans 
connexion Internet

1. Lorsque l'outil Avid License Control est ouvert, cliquez sur Activate 
(Activer) à côté de l'application de montage Avid.

La fenêtre Activation s'ouvre.

2. Sélectionnez I am not connected to the Internet and will be using another 
computer that is connected to the Internet (Cet ordinateur n'est pas connecté 
à Internet, j'en utiliserai un autre pour l'activation), puis cliquez sur 
Continue.

3. Saisissez votre numéro d'ID système dans la zone System ID. Pour trouver 
votre ID système, reportez-vous à la section « De quoi aurai-je besoin pour 
activer mon application de montage Avid ? », page 45.

n Votre ID de périphérique s'affiche en bas de la page d'activation, notez-le pour 
l'utiliser plus tard.

4. Saisissez le numéro d'identification d'activation dans la zone Activation ID. 
Pour trouver votre ID d'activation, reportez-vous à la section « De quoi 
aurai-je besoin pour activer mon application de montage Avid ? », page 45.

5. Cliquez sur Next.

6. Suivez les instructions de l'outil Avid License Control, puis cliquez sur Next.

7. Ouvrez un navigateur Web sur un ordinateur connecté à Internet, puis 
rendez-vous à l'adresse http://avid.com/license.
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8. Suivez les instructions affichées sur la page Web.

Le site Web génère un fichier license.bin. Ce fichier contient les 
informations de licence nécessaires à l'activation de votre application de 
montage Avid.

9. Après avoir récupéré ce fichier license.bin, retournez sur l'ordinateur sur 
lequel vous souhaitez activer votre logiciel.

10. Dans l'outil Avid License Control, cliquez sur Browse (Parcourir) et accédez 
au fichier license.bin copié sur votre système, puis cliquez sur Open.

L'outil Activation vérifie les informations du système. Une fois l'activation 
terminée, un message vous informe que le logiciel a été activé avec succès, 
et l'intitulé du bouton se change en Deactivate (Désactiver).

n Répétez l'étape précédente pour toutes les applications de montage ou options à 
activer.

11. Si l'application de montage Avid est ouverte, redémarrez-la afin d'appliquer 
les modifications.

Activation de l'application de montage Avid via un serveur de 
licences en volume

Vous pouvez activer et gérer plusieurs clients de montage via un serveur de 
licences en volume. Pour plus d'informations, reportez-vous au guide FlexNet 
Device Manager for Avid dans la Base de connaissances. 
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Mise à niveau de l'application de montage Avid

Vous pouvez mettre à niveau l'application de montage Avid depuis une licence 
logicielle existante ou depuis une licence sur dongle. Si vous procédez à la mise à 
niveau depuis une version de licence sur dongle et changez de modèle de produit, 
votre kit de mise à niveau inclut une carte de mise à jour du dongle, un code de 
mise à niveau ainsi qu'un code d'activation du logiciel. Reportez-vous aux 
instructions de votre kit de mise à niveau pour mettre à jour votre logiciel.

Si vous avez acheté PhraseFind, des modules de prise en charge linguistique pour 
PhraseFind ou ScriptSync auparavant, votre activation de licence devrait se mettre 
à jour automatiquement. Si vous achetez de nouvelles options, vous obtiendrez un 
nouvel ID d'activation.

n La mise à niveau d'une licence sur dongle vers une licence logicielle désactive 
votre dongle. Une fois la licence logicielle activée, vous n'aurez pas besoin du 
dongle et ne pourrez l'utiliser pour exécuter votre application de montage Avid.

Si vous mettez à niveau votre licence et disposez d'un contrat de support Avid en 
cours de validité, reportez-vous aux procédures accessibles depuis le Centre de 
téléchargement Avid ou consultez les instructions qui accompagnent votre kit de 
mise à niveau avant d'effectuer la mise à niveau. Tous les clients disposant d'un 
contrat de support Avid doivent utiliser le fichier Versioner.avd pour mettre à 
niveau leur logiciel, comme décrit dans la dernière procédure de cette section. 
Pour en savoir plus, consultez l'article Software Licensing Upgrade Process for 
Support Customers (Procédure de mise à niveau de licence logicielle pour les 
souscripteurs d'un contrat de support) dans la Base de connaissances Avid 
(www.avid.com/fr/support).

Vous trouverez ci-dessous les étapes avancées à suivre si vous mettez à niveau 
votre système de montage Avid, les options PhraseFind ou ScriptSync.
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Procédure de mise à niveau 

1. Désinstallez votre application de montage Avid actuelle.

Reportez-vous à la section « Désinstallation de l'application de montage 
Avid », page 72.

PhraseFind et ScriptSync se désinstallent avec votre application de montage 
Avid.

n Avant de désinstaller votre application de montage Avid, notez votre ID système. 
Votre ancien ID système sera nécessaire pour activer votre nouveau logiciel.

2. Installez votre nouvelle application de montage Avid.

Reportez-vous à la section « Installation de l'application de montage Avid », 
page 41.

PhraseFind et ScriptSync s'installent avec votre application de montage 
Avid. Si vous avez acheté PhraseFind, des modules de prise en charge 
linguistique pour PhraseFind ou ScriptSync auparavant, votre activation de 
licence devrait se mettre à jour automatiquement. Si vous achetez de 
nouvelles options, vous obtiendrez un nouvel ID d'activation.

3. Activez votre application de montage Avid.

Selon votre configuration, reportez-vous aux étapes de mise à niveau 
suivantes. 
Pour en savoir plus sur l'outil Avid License Control, reportez-vous à la 
section « Activation électronique de l'application de montage Avid », 
page 47.

4. Activez PhraseFind, le module de prise en charge linguistique PhraseFind ou 
ScriptSync.

Reportez-vous à la section « Activation électronique de l'application de 
montage Avid », page 47.
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Mise à niveau de votre application de montage Avid avec une 
connexion Internet à partir d'une licence logicielle existante.

1. Naviguez jusqu'à l'emplacement suivant :
(Windows) Démarrer/Tous les programmes/Avid/Utilities/License Control
(Macintosh) Applications/Utilitaires/Avid Utilities/License Control

L'outil Avid License Control s'ouvre.

2. Cliquez sur Activate à côté de l'application de montage Avid.

La fenêtre Activation s'ouvre.

3. Sélectionnez I am connected to the Internet and will use this computer (Cet 
ordinateur est connecté à Internet, je l'utiliserai pour l'activation), puis 
cliquez sur Continue.

Une fenêtre vous permettant de saisir les informations système et 
d'enregistrer votre produit s'ouvre. 

4. Si votre ID système ne s'affiche pas, saisissez votre numéro d'identification 
système dans la zone System ID. Pour les anciens utilisateurs, saisissez votre 
ancien ID système.
Pour trouver votre ID système s'il ne s'affiche pas, reportez-vous à la section 
« De quoi aurai-je besoin pour activer mon application de montage Avid ? », 
page 45.

n Si votre ancien système de montage incluait des options payantes telles que 
PhraseFind ou ScriptSync, elles seront activées automatiquement en même temps 
que votre mise à niveau.

5. Saisissez le numéro d'identification d'activation dans la zone Activation ID. 
Utilisez le numéro d'ID d'activation de votre nouvelle version du logiciel.
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6. Effectuez l'une des opérations suivantes :

t Si vous n'avez jamais enregistré votre produit, sélectionnez Register 
your product with Avid Technology, Inc. now. Si vous souhaitez 
consulter la politique de confidentialité Avid, cliquez sur Read Privacy 
Policy. Cliquez ensuite sur Next.

Une boîte de dialogue d'enregistrement s'affiche. L'enregistrement en 
ligne sur le site Avid vous permet de recevoir d'importantes mises à 
jour et informations de maintenance.

t Sélectionnez Don’t register at this time puis cliquez sur Activate.

L'outil Activation vérifie les informations du système. Une fois 
l'activation terminée, un message vous informe que votre logiciel a été 
activé avec succès.

n  Si vous préférez remettre l'enregistrement de votre produit à plus tard, vous 
pourrez le faire à tout moment en sélectionnant Special > Register dans votre 
application de montage Avid.

7. Si vous avez choisi d'enregistrer votre logiciel à l'étape 6, procédez comme 
suit :

a. Depuis la boîte de dialogue d'enregistrement, renseignez vos nom, 
adresse et coordonnées dans les zones appropriées. Les astérisques (*) 
désignent les champs obligatoires.

b. Cliquez sur Next.

Une boîte de dialogue d'enregistrement s'affiche.

c. Saisissez les informations appropriées (produit et client).
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d. Cliquez sur Activate and Register (Activer et enregistrer).

L'outil Activation vérifie les informations du système. Une fois 
l'activation terminée, un message vous informe que le logiciel a été 
activé avec succès, et l'intitulé du bouton se change en Deactivate 
(Désactiver).

8. Cliquez sur OK. 

Mise à niveau de votre application de montage Avid avec une 
connexion Internet d'une licence sur dongle vers une licence 
logicielle :

1. Connectez votre dongle à votre système de montage Avid.

2. Naviguez jusqu'à l'emplacement suivant :
(Windows) Démarrer/Tous les programmes/Avid/Utilities/License Control
(Macintosh) Applications/Utilitaires/Avid Utilities/License Control

L'outil Avid License Control s'ouvre.

3. Cliquez sur Activate à côté de l'application de montage Avid.

La boîte de dialogue Activation s'affiche.

4. Sélectionnez I am connected to the Internet and will use this computer (Cet 
ordinateur est connecté à Internet, je l'utiliserai pour l'activation), puis 
cliquez sur Continue.

Une fenêtre vous permettant de saisir les informations système et 
d'enregistrer votre produit s'ouvre. 

5. Si votre ID système ne s'affiche pas, saisissez votre numéro d'identification 
système dans la zone System ID. Pour les anciens utilisateurs, saisissez votre 
ancien ID système.
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Pour trouver votre ID système s'il ne s'affiche pas, reportez-vous à la section 
« De quoi aurai-je besoin pour activer mon application de montage Avid ? », 
page 45.

n Si votre ancien système de montage incluait des options payantes telles que 
PhraseFind ou ScriptSync, elles seront activées automatiquement en même temps 
que votre mise à niveau.

6. Saisissez le numéro d'identification d'activation dans la zone Activation ID. 
Pour trouver votre ID d'activation, reportez-vous à la section « De quoi 
aurai-je besoin pour activer mon application de montage Avid ? », page 45.

7. Effectuez l'une des opérations suivantes :

t Si vous n'avez jamais enregistré votre produit, sélectionnez Register 
your product with Avid Technology, Inc. now. Si vous souhaitez 
consulter la politique de confidentialité Avid, cliquez sur Read Privacy 
Policy. Cliquez ensuite sur Next.

Une boîte de dialogue d'enregistrement s'affiche. L'enregistrement en 
ligne sur le site Avid vous permet de recevoir d'importantes mises à 
jour et informations de maintenance.

t Sélectionnez Don’t register at this time puis cliquez sur Activate.

L'outil Activation vérifie les informations du système. Une fois 
l'activation terminée, un message vous informe que votre logiciel a été 
activé avec succès.

n  Si vous préférez remettre l'enregistrement de votre produit à plus tard, vous 
pourrez le faire à tout moment en sélectionnant Special > Register dans votre 
application de montage Avid.



8. Si vous avez choisi d'enregistrer votre logiciel à l'étape 7, procédez comme 
suit :

a. Depuis la boîte de dialogue d'enregistrement, renseignez vos nom, 
adresse et coordonnées dans les zones appropriées. Les astérisques (*) 
désignent les champs obligatoires.

b. Cliquez sur Next.

Une boîte de dialogue d'enregistrement s'affiche.

c. Saisissez les informations appropriées (produit et client). 

d. Cliquez sur Activate (Activer).

9. Le système vous demande si vous êtes sûr de vouloir désactiver votre 
dongle. Cliquez sur OK.

L'outil Activation vérifie les informations du système. Une fois l'activation 
terminée, un message vous informe que votre logiciel a été activé avec 
succès.

10. Cliquez sur OK.

Mise à niveau de votre application de montage Avid sans connexion 
Internet vers une licence logicielle : 

1. Naviguez jusqu'à l'emplacement suivant :
(Windows) Démarrer/Tous les programmes/Avid/Utilities/License Control
(Macintosh) Applications/Utilitaires/Avid Utilities/License Control

L'outil Avid License Control s'ouvre. 

2. Cliquez sur Activate à côté de l'application de montage Avid.

La fenêtre Activation s'ouvre.
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3. Sélectionnez I am not connected to the Internet and will be using another 
computer that is connected to the Internet (Cet ordinateur n'est pas connecté 
à Internet, j'en utiliserai un autre pour l'activation), puis cliquez sur 
Continue.

Une fenêtre vous permettant de saisir les informations système et 
d'enregistrer votre produit s'ouvre. 

4. Si votre ID système ne s'affiche pas, saisissez votre numéro d'identification 
système dans la zone System ID. Pour les anciens utilisateurs, saisissez votre 
ancien ID système.
Pour trouver votre ID système s'il ne s'affiche pas, reportez-vous à la section 
« De quoi aurai-je besoin pour activer mon application de montage Avid ? », 
page 45.

n Si votre ancien système de montage incluait des options payantes telles que 
PhraseFind ou ScriptSync, elles seront activées automatiquement en même temps 
que votre mise à niveau.

n Votre ID de périphérique s'affiche en bas de la page d'activation, notez-le pour 
l'utiliser plus tard.

5. Saisissez le numéro d'identification d'activation dans la zone Activation ID. 
Pour trouver votre ID d'activation, reportez-vous à la section « De quoi 
aurai-je besoin pour activer mon application de montage Avid ? », page 45.

n Laissez l'outil Avid License Control ouvert sur le système à activer. Vous devrez 
saisir des informations supplémentaires.

6. Cliquez sur Next.

7. Suivez les instructions de l'outil Avid License Control, puis cliquez sur Next.



8. Ouvrez un navigateur Web sur un ordinateur connecté à Internet, puis 
rendez-vous à l'adresse http://avid.com/license.

9. Suivez les instructions affichées sur la page Web.

Le site Web génère un fichier license.bin. Ce fichier contient les 
informations de licence nécessaires à l'activation de votre application de 
montage Avid.

10. Après avoir récupéré ce fichier license.bin, retournez sur l'ordinateur sur 
lequel vous souhaitez activer votre logiciel.

11. Dans l'outil Avid License Control, cliquez sur Browse (Parcourir) et accédez 
au fichier license.bin copié sur votre système, puis cliquez sur Open.

L'outil Activation vérifie les informations du système. Une fois l'activation 
terminée, un message vous informe que le logiciel a été activé avec succès, 
et l'intitulé du bouton se change en Deactivate (Désactiver).

n Répétez l'étape précédente pour toutes les applications de montage ou options à 
activer.

12. Si l'application de montage Avid est ouverte, redémarrez-la afin d'appliquer 
les modifications.
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Pour mettre à niveau votre application de montage Avid à l'aide d'un 
dongle :

1. Vérifiez que vous avez connecté votre dongle au système de montage Avid.

2. Accédez au répertoire d'installation du fichier DongleManager.exe :

t (Windows) C:\Programmes\Avid\Utilities\DongleManager

t (Macintosh) Macintosh HD\Applications\Utilitaires\Avid 
Utilities\DongleManager

3. Double-cliquez sur DongleManager.exe.

La fenêtre de l'application DongleManager s'ouvre.

4. Cliquez sur l'onglet Update (Mettre à jour).

5. Cliquez sur Open, puis naviguez jusqu'à l'emplacement du fichier de mise à 
jour (.avd) du dongle.

6. Sélectionnez le fichier de mise à jour puis cliquez sur Open.

7. Cliquez sur Update.

L'application DongleManager.exe met à jour votre dongle puis affiche le 
message Verification Complete (Vérification terminée).

8. Démarrez votre application de montage Avid.

La fenêtre d'accueil s'affiche.

9. Sélectionnez I want to use a dongle to activate my software (Je souhaite 
utiliser un dongle pour activer mon logiciel).

10. Cliquez sur Continue.

Le système vérifie vos informations. Une fois l'activation terminée, un 
message vous informe que votre logiciel a été activé avec succès.
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Pour mettre à niveau votre application de montage Avid à l'aide du 
fichier Versioner.avd (réservé aux souscripteurs d'un contrat de 
support Avid) : 

1. Téléchargez le fichier Versioner.avd correspondant à votre application de 
montage.

2. Déplacez le fichier Versioner.avd dans le dossier de l'application de 
montage :

(Windows) [lecteur]:/Programmes/Avid/[Application de montage Avid]

(Macintosh) Macintosh HD/Applications/[Application de montage Avid]

3. Démarrez votre application de montage Avid.

L'outil Avid License Control s'ouvre. 

4. Cliquez sur Activate à côté de l'application de montage Avid.

5. Effectuez l'une des opérations suivantes :

t Sélectionnez I am connected to the Internet and will use this computer 
(Cet ordinateur est connecté à Internet, je l'utiliserai pour l'activation).

t Sélectionnez I am not connected to the Internet and will be using 
another computer that is connected to the Internet (Cet ordinateur n'est 
pas connecté à Internet, j'en utiliserai un autre pour l'activation).

6. Cliquez sur Continue.

La boîte de dialogue Avid Activation s'affiche. Le système remplit 
automatiquement l'ID système et l'ID d'activation. 

n Si vous utilisez un dongle, l'ID système et l'ID d'activation seront uniquement 
indiqués si le dongle est connecté.
64 Guide d'installation des applications de montage Avid



7. Poursuivez la procédure de mise à niveau de licence décrite dans cette 
section, selon l'option de licence sélectionnée à l'étape 5.

Utilisation de la version d'évaluation de 30 jours

Avant d'acheter l'application de montage Avid, PhraseFind ou ScriptSync, vous 
pouvez l'essayer pendant une période de 30 jours. Si vous exécutez la version 
d'évaluation de 30 jours de l'application de montage Avid, vous disposez aussi d'une 
version d'évaluation de 30 jours de PhraseFind et ScriptSync. Votre version 
d'évaluation de 30 jours de PhraseFind inclut également l'accès à toutes les langues 
disponibles pendant cette période. Il n'est donc pas nécessaire d'activer de modules 
de prise en charge linguistique supplémentaires. Cependant, vous devez sélectionner 
votre langue dans le menu Select a Language de la fenêtre PhraseFind.

Si vous possédez déjà une application de montage Avid, vous pouvez exécuter une 
version d'évaluation de 30 jours de PhraseFind ou ScriptSync.

Une fois les 30 jours écoulés, si vous n'achetez pas l'application de montage Avid, 
PhraseFind ou ScriptSync, vous n'aurez plus accès au produit ni à ses 
fonctionnalités. Le système vous tient informé du nombre de jours restants avant 
la fin de la période d'évaluation.

n Tous les chutiers ou projets créés pendant la période d'évaluation de 30 jours 
pourront uniquement être utilisés lorsque vous aurez activé une licence de 
montage complète.
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Pour utiliser la période d'évaluation de 30 jours de votre application 
de montage Avid :

1. Démarrez votre application de montage Avid.

La fenêtre d'accueil s'affiche.

2. Sélectionnez I want to run a fully-featured, trial version of the Avid editing 
application for 30 days (Je souhaite exécuter une version d'évaluation 
entièrement fonctionnelle de l'application de montage Avid pendant 30 jours).

3. Cliquez sur Continue.

Votre logiciel a été activé avec succès. Vous pouvez, à tout moment au cours 
de la période d'évaluation de 30 jours, choisir d'acheter une copie de 
l'application de montage Avid. Si vous choisissez de ne pas acheter le 
logiciel, votre application sera désactivée à la fin de la période d'évaluation 
de 30 jours.

Pour utiliser la période d'évaluation de 30 jours de PhraseFind :

1. Ouvrez votre application de montage Avid et un projet Avid.

2. AAppuyez sur Ctrl+F ou Commande+F, ou sélectionnez Edit > Find.

La fenêtre Find (Rechercher) s'affiche.

3. Saisissez un mot ou une phrase dans la zone de texte, puis cliquez sur le 
bouton PhraseFind.

Le système vérifie si PhraseFind est installé sur votre système, puis une boîte 
de dialogue s'ouvre.

4. Cliquez sur Run Trial (Exécuter la version d'essai).

Le système redémarre votre application de montage Avid. Vous avez dès lors 
accès à PhraseFind.
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Votre version d'évaluation de 30 jours de PhraseFind inclut également l'accès 
à toutes les langues disponibles pendant cette période. Il n'est donc pas 
nécessaire d'activer de modules de prise en charge linguistique 
supplémentaires. Cependant, vous devez sélectionner votre langue dans le 
menu Select a Language de la fenêtre PhraseFind.

5. Dans la fenêtre PhraseFind, sélectionnez votre langue dans le menu Select a 
Language, puis attendez que l'index PhraseFind s'affiche en vert fixe.

Pour utiliser la période d'évaluation de 30 jours de ScriptSync :

1. Ouvrez votre application de montage Avid et un projet Avid.

2. Créez un script, File > New Script.

3. Accédez à votre script, puis cliquez sur Open.

4. Dans le script, cliquez sur la section dans laquelle vous souhaitez placer le 
clip (prise).

La section est mise en surbrillance.

5. À partir d'un chutier, faites glisser le clip vers la section sélectionnée dans le 
script.

La boîte en dessous du clip dans le script devrait être surlignée en noir pour 
indiquer que le clip est sélectionné dans le script.

6. Sélectionnez Script > ScriptSync.

Le système vérifie si ScriptSync est installé sur votre système, puis une boîte 
de dialogue s'ouvre.

7. Cliquez sur Run Trial (Exécuter la version d'essai).

Vous accédez immédiatement à la fenêtre ScriptSync.
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Pour acheter l'application de montage Avid au cours de la période 
d'évaluation de 30 jours :

t Accédez à la boutique en ligne Avid : http://shop.avid.com/store/ pour 
acheter votre application de montage Avid.

Pour acheter PhraseFind ou ScriptSync au cours de la période 
d'évaluation de 30 jours :

1. Ouvrez votre application de montage Avid et un projet Avid.

2. Pour ScriptSync, suivez les étapes 1 à 5 de la section « Pour utiliser la 
période d'évaluation de 30 jours de ScriptSync : », page 67, puis 
sélectionnez Script > ScriptSync.

3. Appuyez sur Ctrl+F ou Commande+F, ou sélectionnez Edit > Find.

La fenêtre Find s'affiche.

4. Pour PhraseFind, saisissez un mot ou une phrase dans la zone de texte, puis 
cliquez sur le bouton PhraseFind.

Le système vous informe du nombre de jours restants pour votre période 
d'évaluation de 30 jours. 

5. Cliquez sur Buy (Acheter).

n Si le bouton Buy n'apparaît pas, fermez la fenêtre Find et relancez votre 
application de montage Avid. Répétez les étapes ci-dessus.

Le système ouvre la boutique en ligne Avid, où vous pouvez acheter 
PhraseFind ou ScriptSync. Une fois le produit acheté et votre ID d'activation 
reçu, vous pouvez activer PhraseFind ou ScriptSync.

Une boîte de dialogue s'ouvre pour vous indiquer que le processus d'activation 
fermera votre application de montage Avid et lancera l'outil Avid License 
Control.
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6. Cliquez sur Continue.

L'outil Avid License Control s'ouvre.

Pour procéder à l'activation, reportez-vous à la section « Activation 
électronique de l'application de montage Avid », page 47 pour continuer.

Activation des options et fonctionnalités

En plus de l'activation de l'application de montage Avid, plusieurs fonctionnalités 
et options de montage peuvent être activées via l'outil Avid License Control. 

Pour ce faire, suivez les étapes de la section « Activation électronique de 
l'application de montage Avid », page 47 ou reportez-vous au guide approprié 
répertorié ci-dessous.

• PhraseFind
L'option PhraseFind (recherche phonétique) recherche des dialogues audio 
dans les chutiers d'un projet unique. PhraseFind est vendu séparément et 
inclut un module de prise en charge linguistique gratuit de votre choix. Pour 
plus d'informations, reportez-vous à la section Purchasing and Activating 
PhraseFind (Achat et activation de PhraseFind) de l'aide de l'application de 
montage Avid ou au guide Getting Started with PhraseFind (Guide de 
démarrage de PhraseFind).

• ScriptSync
ScriptSync utilise une technologie d'indexation phonétique pour analyser la 
section audio d'un clip et la synchroniser avec les lignes d'un script. 
ScriptSync est vendu séparément. Pour plus d'informations, reportez-vous à 
la section Purchasing and Activating ScriptSync (Achat et activation de 
ScriptSync) de l'aide de l'application de montage Avid ou au guide Getting 
Started with ScriptSync (Guide de démarrage de ScriptSync).
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• Module de prise en charge linguistique PhraseFind
Des modules de prise en charge linguistique supplémentaires à utiliser avec 
PhraseFind sont disponibles. Ces modules sont vendus séparément. Pour plus 
d'informations, reportez-vous à la section Activating Additional Regional 
Language Packs (Activation de modules de prise en charge linguistique 
supplémentaires) de l'aide de l'application de montage Avid ou au guide 
Getting Started with PhraseFind (Guide de démarrage de PhraseFind).

• Importation AVCHD Dolby AC-3 ou liaison AMA
Cette fonctionnalité permet d'importer ou d'établir une liaison AMA avec 
des fichiers de flux de transport AVCHD (.mts). Si vous n'êtes pas connecté 
à Internet la première fois que vous importez ou établissez une liaison AMA 
vers des fichiers .mts, le système ouvre une boîte de dialogue, puis l'outil 
Avid License Control. Suivez les instructions à l'écran pour activer cette 
fonctionnalité. Si vous êtes connecté à Internet, l'activation est automatique.

n La fonctionnalité AVCHD Dolby AC-3 s'affiche uniquement si vous utilisez ce 
format. Elle n'est généralement pas affichée dans l'outil Avid License Control.

Désactivation de l'application de montage Avid et de ses options

Si vous devez installer l'application de montage Avid sur un autre ordinateur, 
désactivez l'application de montage Avid et ses options avant de désinstaller 
l'application.

Désactivez d'abord PhraseFind et ScriptSync, puis l'application de montage Avid.

n Vous devez être connecté à Internet pour désactiver le logiciel et ses options.

n Il n'est pas nécessaire de désactiver une version d'évaluation.
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Désactivation de l'application de montage Avid et de ses options :

1. Dans votre application de montage Avid, sélectionnez Special > Deactivate 
Software License (Spécial > Désactiver la licence logicielle).

2. Un message indiquant que l'application de montage Avid sera fermée et 
l'outil Avid License Control ouvert s'affiche ; cliquez sur Continue.

3. Une boîte de dialogue vous demandant si vous souhaitez fermer les 
applications de montage Avid s'ouvre ; cliquez sur Leave (Quitter).

4. Ou accédez à l'emplacement suivant pour ouvrir l'outil Avid License 
Control :
(Windows) Démarrer/Tous les programmes/Avid/Utilities/License Control
(Macintosh) Applications/Utilitaires/Avid Utilities/License Control

L'outil Avid License Control s'ouvre. 

5. Cliquez sur Deactivate (Désactiver), à côté de l'application de montage Avid, 
PhraseFind ou ScriptSync.

Si vous désactivez PhraseFind, un message indiquant que les modules de 
prise en charge linguistique associés seront également désactivés s'affiche. 

6. Cliquez sur Yes.

Le système désactive l'élément sélectionné, et l'intitulé du bouton change en 
Activate (Activer).

7. Cliquez sur Quit pour fermer la fenêtre.
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Désinstallation de l'application de montage Avid 

Avant d'installer l'application de montage, désinstallez également les pilotes Digi 
à l'aide de l'option Programmes et fonctionnalités du Panneau de configuration. 
Redémarrez le système puis installez la nouvelle application de montage. Si vous 
ne supprimez pas les pilotes Digidesign, le chargement des plug-ins AudioSuite 
sera impossible et vous risquez d'obtenir le message d'erreur This software 
requires installation of device driver TPkd and a reboot before running (Ce 
logiciel nécessite l'installation du pilote de périphérique TPkd, suivie d'un 
redémarrage) ou DAE Interface NOT Available (Interface DAE NON disponible). 
Si ces erreurs s'affichent sur une version nouvellement installée effectuée sur un 
système lui aussi récemment installé, installez le hot fix KB926255 à partir de 
Windows Update pour résoudre le problème.

Pour toutes les applications de montage Avid, connectez-vous et lancez 
l'application pour la première fois en tant qu'utilisateur disposant des droits 
d'administration. Si vous travaillez dans un environnement de stockage partagé, 
montez vos workspaces. Vous pourrez ensuite exécuter l'application de montage 
Avid en tant qu'utilisateur normal.

Si vous utilisez des périphériques audio Pro Tools (par exemple, l'un des 
périphériques de la famille Avid Mbox ou du matériel Avid Pro Tools|HD Native), 
vous devez installer séparément les pilotes des périphériques. Les pilotes des 
périphériques audio Avid se trouvent dans le répertoire suivant :

• (Windows) Programmes\Avid\Utilities\
AudioDriverInstallers

• (Macintosh) Applications\Utilitaires\Avid Utilities\
Avid Audio Drivers
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(Windows) Pour désinstaller le logiciel de l'application de montage 
Avid, effectuez l'une des opérations suivantes :

1. Quittez toutes les applications en cours d'exécution.

2. Accédez au Panneau de configuration, puis sélectionnez Programmes et 
Fonctionnalités. Sélectionnez ensuite l'application de montage et cliquez sur 
Uninstall (Désinstaller).

(Macintosh) Pour désinstaller le logiciel de l'application de montage 
Avid :

1. Quittez toutes les applications en cours d'exécution.

2. Accédez à Applications/Avid_Uninstaller/ApplicationMontageAvid.

3. Double-cliquez sur le programme de désinstallation ApplicationMontageAvid.

4. Suivez les instructions à l'écran.

Note de mise à jour du firmware

Lorsque vous exécutez pour la première fois l'application de montage que vous 
venez d'installer, une boîte de dialogue vous invitera peut-être à mettre à jour le 
firmware du matériel Avid. Choisissez l'option Update (Mettre à jour). Lors de la 
procédure de mise à jour, n'ouvrez aucune autre application et ne déplacez aucune 
des fenêtres actives. Accéder à une autre application risque de masquer la boîte de 
dialogue signalant la fin de la procédure de mise à jour. Le cas échéant, la 
progression de la mise à jour restera figée à 100 % mais vous ne disposerez 
d'aucune option pour finaliser la procédure. La fenêtre masquée qui vous signale 
la fin de la mise à jour et vous invite à éteindre votre système ne peut pas être 
rappelée au premier plan. Vous devrez dans ce cas éteindre votre système, et non 
pas seulement le redémarrer, puis le remettre sous tension.
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3 Installationshandbuch für Avid-Editing-Anwen-
dungen

Die aktuellsten Informationen zu Ihrer Avid-Editing-Anwendung finden Sie in 
der Online-Version der Readme-Datei. Sie sollten immer online nach den 
neuesten Versionshinweisen oder Readme-Dateien suchen, da die Online- 
Versionen aktualisiert werden, sobald neue Informationen verfügbar sind. Um 
diese Online-Versionen zu finden, können Sie entweder die Readme-Option aus 
dem Hilfemenü Ihrer Avid-Editing-Anwendung wählen oder die Knowledge Base 
unter www.avid.com/readme besuchen.

Für die Installation der Avid-Editing-Anwendung direkt von der Avid-Installations- 
DVD aus muss Ihr System Dual-Layer-DVDs unterstützen. Wenn Ihr System kein 
Dual-Layer-DVDs unterstützendes DVD-Laufwerk besitzt, können Sie die 
Avid-Editing-Anwendung direkt im Avid-Download-Center unter 
www.avid.com/support/downloads herunterladen. 

Sobald Sie Ihre Avid-Editing-Anwendung installieren, aktivieren Sie die Software 
mit dem Avid License Control-Tool. Das Avid License Control-Tool aktiviert 
ebenfalls Editing-Erweiterungsoptionen. Informationen über die Editing- 
Erweiterungen finden Sie unter „Aktivieren von Erweiterungen und Funktionen“ 
auf Seite 104.

n Wenn Sie über einen laufenden Avid-Supportvertrag verfügen, haben Sie eventuell 
die Möglichkeit, ein Software-Upgrade durchzuführen. Weitere Informationen 
können Sie den Anweisungen zu Ihrem Upgrade entnehmen, die Sie entweder im 
Avid-Download-Center oder in Ihrem Upgrade-Kit finden.
 

http://www.avid.com/support/downloads
http://www.avid.com/readme


c Falls Sie Ihre Systemkonfiguration ändern möchten – indem Sie 
beispielsweise die Festplatte oder einen Netzwerk-Adapter austauschen oder 
das Betriebssystem aktualisieren –, müssen Sie zuvor Ihre Avid-Software 
deaktivieren. Informationen zur Deaktivierung finden Sie unter 
„Deaktivieren von Avid-Editing-Anwendung und -Erweiterungen“ auf 
Seite 106.

Vor dem Installieren der Avid-Editing-Anwendung

Lesen Sie die folgenden Anleitungen durch, bevor Sie die Editing-Anwendung 
installieren. Dieses Handbuch enthält Anleitungen sowohl für Upgrade-Kunden 
als auch für neue Anwender. Wählen Sie die für Ihre Installation relevante 
Anleitung:

Neue Anwender
Wenn Sie ein neuer Anwender sind und noch nie die betreffende Editing-Anwendung 
auf Ihrem System installiert haben, folgen Sie den Anweisungen von Seite 77 bis 
Seite 89. Beginnen Sie mit „Installieren der Avid-Editing-Anwendung“ auf 
Seite 77.

Registrierte Anwender
Bei einem Upgrade von einer früheren Version der Editing-Anwendung müssen 
Sie die vorherige Version deinstallieren, um die neue Software installieren und 
aktivieren zu können. 

n Notieren Sie sich Ihre System-ID, bevor Sie Ihre Avid-Editing-Anwendung 
deinstallieren. Sie benötigen Ihre alte System-ID, um Ihre neue Software zu 
aktivieren. 

Folgen Sie den Anweisungen von Seite 90 bis Seite 99. Beginnen Sie mit 
„Durchführen von Upgrades der Avid-Editing-Anwendung“ auf Seite 90.
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Installieren der Avid-Editing-Anwendung

Loggen Sie sich für alle Avid-Editing-Anwendungen als Benutzer mit 
Administratorrechten ein, installieren Sie die Anwendung und führen Sie den 
ersten Start als Benutzer mit Administratorrechten aus. Falls Sie in einer 
Zentralspeicher-Umgebung arbeiten, müssen Sie Ihre Arbeitsbereiche mounten. 
Anschließend können Sie die Avid-Editing-Anwendung als normaler Benutzer 
ausführen.

n Das Installieren der Editing-Anwendung kann einige Zeit in Anspruch nehmen. 
Für eine einzelne Editing-Anwendung dauert die Installation in der Regel 5 bis 
15 Minuten. Die Installation des gesamten Editing-Systems kann bis zu 
35 Minuten dauern.

(Windows) So installieren Sie die Avid-Editing-Anwendung:

1. Beenden Sie alle aktiven Anwendungen.

2. Legen Sie die DVD der Editing-Anwendung ein.

3. Wählen Sie, ob Sie das Editing-System von Avid oder das einzelne Produkt 
installieren möchten, und folgen Sie den Anweisungen auf dem Bildschirm.

n Falls die Meldung angezeigt wird, dass Dateien verwendet werden, können Sie 
problemlos auf „Ignorieren“ (Ignore) klicken und fortfahren.

n Sollten während der Installation Warnmeldungen der Benutzerzugriffsverwaltung 
angezeigt werden, klicken Sie auf „Trotzdem fortfahren“ (Continue Anyway), um 
die Installation fortzusetzen.

4. Wenn Sie dazu aufgefordert werden, wählen Sie die Option zum sofortigen 
Neustart des Computers.

5. Fahren Sie fort mit „Starten der Avid-Editing-Anwendung“ auf Seite 78.
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(Mac) So installieren Sie die Avid-Editing-Anwendung:

1. Beenden Sie alle Anwendungen.

2. Legen Sie die DVD der Editing-Anwendung ein.

3. Doppelklicken Sie auf die Datei Name der Editing-Anwendung.pkg.

4. Wählen Sie, ob Sie das Editing-System von Avid oder das einzelne Produkt 
installieren möchten, und folgen Sie den Anweisungen auf dem Bildschirm.

5. Wenn Sie dazu aufgefordert werden, wählen Sie die Option zum sofortigen 
Neustart des Computers.

6. Fahren Sie fort mit „Starten der Avid-Editing-Anwendung“ auf Seite 78.

Starten der Avid-Editing-Anwendung

Während des Installationsprozesses werden für Ihre Avid-Editing-Anwendung ein 
Desktop- oder Dock-Symbol und ein Eintrag im Startmenü erstellt. 

Wenn Sie Ihre Avid-Editing-Anwendung auf einem Laptop installieren, wird 
möglicherweise eine Meldung bezüglich inkompatibler Energieverwaltungs- 
einstellungen angezeigt. Für die Arbeit mit den Avid-Editing-Anwendungen ist es 
empfehlenswert, die Einstellung „Höchstleistung“ (High Performance) für 
Windows 7 zu wählen. Andere Energieverwaltungseinstellungen könnten die 
Leistungsfähigkeit bestimmter Editing-Funktionen beeinträchtigen (z. B. 
Einspielen und digitales Schneiden). 

Nachdem Sie die Software für Ihre Avid-Editing-Anwendung installiert haben 
und die Anwendung zum ersten Mal gestartet haben, müssen Sie Ihre Kopie 
aktivieren.
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(Windows) Sie haben folgende Möglichkeiten, Ihre Avid-Editing- 
Anwendung zu starten:

t Klicken Sie auf „Start > Alle Programme > Avid > 
Avid-Editing-Anwendung“.

t Doppelklicken Sie auf das Desktop-Symbol der Avid-Editing-Anwendung.

Das Willkommen-Fenster öffnet sich. 

(Mac) Sie haben folgende Möglichkeiten, Ihre Avid-Editing- 
Anwendung zu starten:

1. Klicken Sie auf dem Dock auf das Alias-Symbol für Ihre Avid-Editing- 
Anwendung.

2. Oder wählen Sie „Start > Programme“ und doppelklicken Sie anschließend 
auf den Ordner der Avid-Editing-Anwendung. Doppelklicken Sie danach auf 
die Programmdatei der Avid-Editing-Anwendung.
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3. Wählen Sie eine der Optionen, um Ihre Software zu aktivieren.

t Um die Aktivierung elektronisch durchzuführen, wählen Sie „I want to 
activate my software using the Internet, another computer, or a volume 
license server“ und klicken Sie auf „Continue“. 
Das Avid License Control-Tool öffnet sich. Folgen Sie den Anweisungen 
unter „Elektronische Aktivierung der Avid-Editing-Anwendung“ auf 
Seite 83.

t Um die Aktivierung mit einem Hardware-Schlüssel oder Dongle 
durchzuführen, wählen Sie „I want to use a dongle to activate my 
software“, schließen Sie den Dongle an und klicken Sie auf „Continue“.
Das System bestätigt Ihre Daten. Nach Abschluss der Aktivierung wird 
durch eine Meldung bestätigt, dass Ihre Software erfolgreich aktiviert 
wurde.

t Um die Anwendung im Testmodus auszuführen, klicken Sie auf „I want to 
run a fully-featured trial version of [die Avid-Editing-Anwendung] for 30 
days“ und klicken Sie auf „Continue“.
Die Aktivierung Ihrer Software war erfolgreich.
Weitere Informationen zum Testmodus finden Sie unter „Verwenden der 
30-Tage-Testversion“ auf Seite 100.

Was benötige ich, um meine Avid-Editing-Anwendungen zu 
aktivieren?

Identifikations-
Nummern (IDs): Diese finden Sie hier:

Aktivierungs-ID Auf der Umschlaginnenseite dieses Handbuchs.
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Wenn Sie die Anwendung im Avid Store gekauft haben, 
sendet Ihnen Avid Ihre Aktivierungs-ID per E-Mail.

Wenn Sie die Anwendung im Avid Store gekauft haben, 
loggen Sie sich in Ihren Store-Account ein unter 
http://account.avid.com/.

System-ID Neue Anwender finden die ID auf der Umschlaginnenseite 
dieses Handbuchs.
Bereits registrierte Anwender benötigen ihre alte 
System-ID.

Wenn Sie Ihre Avid-Software online gekauft haben, wurde 
Ihnen die System-ID von Avid per E-Mail zugeschickt.

Auf dem Splash Screen der Avid-Software (Hilfe > 
Informationen zur Avid-Editing-Anwendung).

Auf der Konsole der Avid-Editing-Anwendung (Tools > 
Konsole, dann herunterscrollen zur System-ID).

Wenn Sie die Anwendung im Avid Store gekauft haben, 
können Sie Ihre System-ID in Ihrem Store-Account 
einsehen unter http://account.avid.com/.

Identifikations-
Nummern (IDs): Diese finden Sie hier:
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Elektronische Aktivierung der Avid-Editing-Anwendung
• Mit Internetzugang – siehe „Elektronische Aktivierung mit Internetzugang“ 

auf Seite 84.

• Ohne Internetzugang – siehe „Elektronische Aktivierung ohne 
Internetverbindung“ auf Seite 88.

• Über einen Volumenlizenz-Server – siehe „Aktivieren der 
Avid-Editing-Anwendung über einen Volumenlizenz-Server“ auf Seite 89.

System-ID (Fortsetzung) Sobald die Aktivierung abgeschlossen ist, zeigt Ihnen im 
Avid License Control-Tool die „Licence 
Profile“-Registerkarte Informationen zu Ihrem System an. 
Klicken Sie auf „Copy“, um die Informationen in die 
Zwischenablage zu kopieren. Anschließend können Sie die 
Informationen in eine E-Mail oder eine Textdatei einfügen. 
Dies kann dann nützlich sein, wenn Sie diese Informationen 
sicher aufbewahren wollen oder Systeminformationen an den 
Avid-Kundensupport senden müssen.

Device-ID (Gerätekennung) Nur erforderlich, wenn Sie Ihre Software auf einem Computer 
aktivieren, der keine Verbindung mit dem Internet hat. Die 
Device-ID erhalten Sie über das Avid License Control-Tool 
während der Aktivierung.

Identifikations-
Nummern (IDs): Diese finden Sie hier:
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Elektronische Aktivierung mit Internetzugang

1. Öffnen Sie das Avid License Control-Tool und klicken Sie neben der 
Avid-Editing-Anwendung auf „Activate“.
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Das folgende Fenster wird geöffnet:

2. Wählen Sie „I am connected to the Internet and will use this computer“ und 
klicken Sie auf „Continue“.
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Ein Fenster wird geöffnet, in dem Sie Systeminformationen eingeben und 
Ihr Produkt registrieren können.

3. Geben Sie Ihre System-ID in das entsprechende Textfeld ein. Wie Sie Ihre 
System-ID finden, erfahren Sie unter „Was benötige ich, um meine 
Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

4. Geben Sie Ihre Aktivierungs-ID in das entsprechende Textfeld ein. Wie Sie 
Ihre Aktivierungs-ID finden, erfahren Sie unter „Was benötige ich, um 
meine Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

5. Wenn Sie die Datenschutzerklärung von Avid lesen möchten, klicken Sie auf 
„Read Privacy Policy“. 
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6. Sie haben folgende Möglichkeiten:

t Wählen Sie „Register your software“ und klicken Sie dann auf 
„Continue“.

Ein Registrierungs-Dialogfeld wird geöffnet. Wenn Sie sich online bei 
Avid registrieren, erhalten Sie wichtige Updates und Wartungs- 
informationen.

t Wählen Sie „Don’t register your software“ und klicken Sie 
anschließend auf „Activate“.

Das Avid License Control-Tool bestätigt Ihre Systeminformationen. 
Nach Abschluss der Aktivierung wird durch eine Meldung bestätigt, 
dass Ihre Software erfolgreich aktiviert wurde.

n Falls Sie Ihre Software zu diesem Zeitpunkt nicht registrieren möchten, können Sie 
dies auch später jederzeit tun, indem Sie in Ihrer Avid-Editing-Anwendung auf 
„Special > Register“ klicken.

7. Wenn Sie die Software registrieren möchten, gehen Sie folgendermaßen vor:

a. Geben Sie im Registrierungs-Dialogfeld Ihren Namen, Ihre Adresse 
und Ihre Kontaktinformationen in die entsprechenden Textfelder ein. 
Pflichtfelder sind mit einem Sternchen (*) gekennzeichnet.

b. Klicken Sie auf „Next“.

Ein Registrierungs-Dialogfeld wird geöffnet.

c. Geben Sie die entsprechenden Produkt- und Kundeninformationen ein. 

d. Klicken Sie auf „Activate and Register“.

8. Falls die Avid-Editing-Anwendung geöffnet ist, starten Sie sie bitte erneut, 
damit die Änderungen wirksam werden.
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Elektronische Aktivierung ohne Internetverbindung

1. Öffnen Sie das Avid License Control-Tool und klicken Sie neben der 
Avid-Editing-Anwendung auf „Activate“.

Das Aktivierungstool wird geöffnet.

2. Wählen Sie „I am not connected to the Internet and will be using another 
computer that is connected to the Internet“ und klicken Sie auf „Continue“.

3. Geben Sie Ihre System-ID in das entsprechende Textfeld ein. Wie Sie Ihre 
System-ID finden, erfahren Sie unter „Was benötige ich, um meine 
Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

n Ihre Device-ID wird am unteren Ende der Aktivierungs-Seite angezeigt. Notieren 
Sie sie für später.

4. Geben Sie Ihre Aktivierungs-ID in das entsprechende Textfeld ein. Wie Sie 
Ihre Aktivierungs-ID finden, erfahren Sie unter „Was benötige ich, um 
meine Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

5. Klicken Sie auf „Next“.

6. Folgen Sie den Anweisungen im Avid License Control-Tool und klicken Sie 
auf „Next“.

7. Öffnen Sie auf einem Computer mit Internetverbindung einen Webbrowser 
und navigieren Sie zu http://avid.com/license.

8. Folgen Sie den Anweisungen auf der Website.

Die Website erstellt eine license.bin-Datei. Diese Datei enthält 
Lizenzinformationen, die für das Aktivieren Ihrer Avid-Editing-Anwendung 
benötigt werden.
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9. Sobald Sie die license.bin-Datei erhalten, fahren Sie an dem Computer fort, 
auf dem Sie die Avid-Editing-Anwendung aktivieren möchten.

10. Öffnen Sie das Avid License Control-Tool, klicken Sie auf „Browse“, 
wählen Sie die auf Ihrem System abgelegte license.bin-Datei aus und 
klicken Sie dann auf „Open“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach Abschluss der 
Aktivierung wird durch eine Meldung bestätigt, dass Ihre Software erfolgreich 
aktiviert wurde, und die Schaltfläche verändert sich zu „Deactivate“.

n Wiederholen Sie diese Schritte für alle Editing-Anwendungen oder 
-Erweiterungen, die Sie aktivieren möchten.

11. Falls die Avid-Editing-Anwendung geöffnet ist, starten Sie diese neu, damit 
die Änderungen wirksam werden.

Aktivieren der Avid-Editing-Anwendung über einen 
Volumenlizenz-Server

Über einen Volumenlizenz-Server können Sie mehrere Editing-Clients aktivieren 
und verwalten. Weitere Informationen entnehmen Sie der Anleitung FlexNet 
Device Manager for Avid in der Knowledge Base. 
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Durchführen von Upgrades der Avid-Editing-Anwendung

Upgrades Ihrer Avid-Editing-Anwendung können entweder auf der Grundlage 
einer vorhandenen Softwarelizenz oder einer Dongle-Lizenz durchgeführt 
werden. Falls Sie das Upgrade auf der Grundlage einer Dongle-Lizenz 
durchführen und das Produktmodell wechseln, enthält Ihr Upgrade-Kit eine 
Dongle-Aktualisierungskarte, einen Upgrade-Code und einen Software- 
Aktivierungscode. Anweisungen zu dem Software-Upgrade finden Sie in Ihrem 
Upgrade-Kit.

Wenn Sie zuvor bereits PhraseFind, PhraseFind-Sprachpakete oder ScriptSync 
erworben haben, sollte das Update Ihrer Lizenz automatisch erfolgen. Wenn Sie 
neue Erweiterungen erwerben, wird eine neue Aktivierungs-ID an Sie vergeben.

n Durch ein Upgrade Ihrer Dongle-Lizenz auf eine Softwarelizenz wird Ihr Dongle 
deaktiviert. Sobald Sie Ihre Softwarelizenz aktiviert haben, benötigen Sie den 
Dongle nicht länger zum Ausführen Ihrer Avid-Editing-Anwendung und können 
ihn auch nicht wieder verwenden.

Wenn Sie ein Upgrade Ihrer vorhandenen Lizenz durchführen und über einen 
laufenden Avid-Supportvertrag verfügen, können Sie weitere Informationen den 
Anweisungen zu Ihrem Upgrade entnehmen, die Sie entweder im Avid-Download- 
Center oder in Ihrem Upgrade-Kit finden. Alle Avid-Support-Vertragskunden müssen 
die Datei Versioner.avd verwenden, um Upgrades ihrer Software durchführen zu 
können. Eine Beschreibung hierzu finden Sie am Ende dieses Kapitels. Weitere 
Informationen finden Sie unter „Software Licensing Upgrade Process for Support 
Customers“ in der Avid Knowledge Base (www.avid.com/US/support).

Folgen Sie den nachstehenden wichtigen Anweisungen, wenn Sie ein Upgrade 
Ihres Avid-Editing-Systems, der PhraseFind- oder der ScriptSync-Erweiterung 
durchführen.
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Upgrade-Workflow 

1. Deinstallieren Sie Ihre bestehende Avid-Editing-Anwendung.

Siehe „Deinstallieren der Avid-Editing-Anwendung“ auf Seite 107.

PhraseFind und ScriptSync werden zusammen mit Ihrer Avid-Editing- 
Anwendung deinstalliert.

n Notieren Sie Ihre System-ID, bevor Sie Ihre Avid-Editing-Anwendung deinstallieren. 
Sie benötigen Ihre alte System-ID, um Ihre neue Software zu aktivieren.

2. Installieren Sie Ihre neue Avid-Editing-Anwendung.

Siehe „Installieren der Avid-Editing-Anwendung“ auf Seite 77.

PhraseFind und ScriptSync werden zusammen mit Ihrer Avid-Editing- 
Anwendung installiert. Wenn Sie zuvor bereits PhraseFind, PhraseFind- 
Sprachpakete oder ScriptSync erworben haben, sollte das Update Ihrer 
Lizenz automatisch erfolgen. Wenn Sie neue Erweiterungen erwerben, 
wird eine neue Aktivierungs-ID an Sie vergeben.

3. Aktivieren Sie Ihre Avid-Editing-Anwendung.

Folgen Sie den folgenden Anweisungen zum Durchführen von Upgrades. 
Weitere Informationen zum Avid License Control-Tool finden Sie unter 
„Elektronische Aktivierung der Avid-Editing-Anwendung“ auf Seite 83.

4. Aktivieren Sie PhraseFind, ein PhraseFind-Sprachpaket oder ScriptSync.

Siehe „Elektronische Aktivierung der Avid-Editing-Anwendung“ auf Seite 83.
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So aktualisieren Sie Ihre Avid-Editing-Anwendung online auf der 
Grundlage einer vorhandenen Softwarelizenz:

1. Rufen Sie das folgende Verzeichnis auf:
(Windows) Start\Alle Programme\Avid\Utilities\License Control
(Mac) Programme/Dienstprogramme/Avid Utilities/License Control

Das Avid License Control-Tool öffnet sich.

2. Klicken Sie auf „Activate“ neben der Avid-Editing-Anwendung.

Das Aktivierungstool wird geöffnet.

3. Wählen Sie „I am connected to the Internet and will use this computer“ und 
klicken Sie auf „Continue“.

Ein Fenster wird geöffnet, in dem Sie Systeminformationen eingeben und 
Ihr Produkt registrieren können. 

4. Wenn Ihre System-ID nicht angezeigt wird, geben Sie sie in das entsprechende 
Textfeld ein. Anwender, die bereits Kunden sind, nutzen ihre alte System-ID.
Wie Sie Ihre System-ID finden, wenn sie nicht angezeigt wird, erfahren Sie 
unter „Was benötige ich, um meine Avid-Editing-Anwendungen zu 
aktivieren?“ auf Seite 81.

n Wenn zu Ihrer bisherigen Editing-Anwendung erworbene Erweiterungen wie 
PhraseFind oder ScriptSync gehörten, werden diese mit dem Upgrade 
automatisch aktiviert.

5. Geben Sie Ihre Aktivierungs-ID in das entsprechende Textfeld ein. 
Verwenden Sie die Aktivierungs-ID für die neue Version Ihrer Software.
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6. Sie haben folgende Möglichkeiten:

t Sollten Sie Ihr Produkt noch nicht registriert haben, wählen Sie 
„Register your product with Avid Technology, Inc. now“. Wenn Sie die 
Datenschutzerklärung von Avid lesen möchten, klicken Sie auf „Read 
Privacy Policy“. Klicken Sie anschließend auf „Next“.

Ein Registrierungs-Dialogfeld wird geöffnet. Wenn Sie sich online bei 
Avid registrieren, erhalten Sie wichtige Updates und Wartungs- 
informationen.

t Wählen Sie „Don’t register at this time“ und klicken Sie anschließend 
auf „Activate“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach 
Abschluss der Aktivierung wird durch eine Meldung bestätigt, dass 
Ihre Software erfolgreich aktiviert wurde.

n Falls Sie Ihre Software zu diesem Zeitpunkt nicht registrieren möchten, können Sie 
dies auch später jederzeit tun, indem Sie in Ihrer Avid-Editing-Anwendung auf 
„Special > Register“ klicken.

7. Wenn Sie sich in Schritt 6 für die Registrierung der Software entschieden 
haben, gehen Sie folgendermaßen vor:

a. Geben Sie im Registrierungs-Dialogfeld Ihren Namen, Ihre Adresse 
und Ihre Kontaktinformationen in die entsprechenden Textfelder ein. 
Pflichtfelder sind mit einem Sternchen (*) gekennzeichnet.

b. Klicken Sie auf „Next“.

Ein Registrierungs-Dialogfeld wird geöffnet.

c. Geben Sie die entsprechenden Produkt- und Kundeninformationen ein.
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d. Klicken Sie auf „Activate and Register“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach 
Abschluss der Aktivierung wird durch eine Meldung bestätigt, dass 
Ihre Software erfolgreich aktiviert wurde, und die Schaltfläche 
verändert sich zu „Deactivate“.

8. Klicken Sie auf „OK“. 

So aktualisieren Sie Ihre Avid-Editing-Anwendung online von einer 
Dongle-Lizenz auf eine Softwarelizenz:

1. Schließen Sie den Dongle an Ihr Avid-Editing-System an.

2. Rufen Sie das folgende Verzeichnis auf:
(Windows) Start\Alle Programme\Avid\Utilities\License Control
(Mac) Programme/Dienstprogramme/Avid Utilities/License Control

Das Avid License Control-Tool öffnet sich.

3. Klicken Sie auf „Activate“ neben der Avid-Editing-Anwendung.

Das Aktivierungs-Dialogfeld wird geöffnet.

4. Wählen Sie „I am connected to the Internet and will use this computer“ und 
klicken Sie auf „Continue“.

Ein Fenster wird geöffnet, in dem Sie Systeminformationen eingeben und 
Ihr Produkt registrieren können. 

5. Wenn Ihre System-ID nicht angezeigt wird, geben Sie sie in das entsprechende 
Textfeld ein. Anwender, die bereits Kunden sind, nutzen ihre alte System-ID.
Wie Sie Ihre System-ID finden, wenn sie nicht angezeigt wird, erfahren Sie 
unter „Was benötige ich, um meine Avid-Editing-Anwendungen zu 
aktivieren?“ auf Seite 81.
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n Wenn zu Ihrer bisherigen Editing-Anwendung erworbene Erweiterungen wie 
PhraseFind oder ScriptSync gehörten, werden diese mit dem Upgrade 
automatisch aktiviert.

6. Geben Sie Ihre Aktivierungs-ID in das entsprechende Textfeld ein. Wie Sie 
Ihre Aktivierungs-ID finden, erfahren Sie unter „Was benötige ich, um 
meine Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

7. Sie haben folgende Möglichkeiten:

t Sollten Sie Ihr Produkt noch nicht registriert haben, wählen Sie 
„Register your product with Avid Technology, Inc. now“. Wenn Sie die 
Datenschutzerklärung von Avid lesen möchten, klicken Sie auf „Read 
Privacy Policy“. Klicken Sie anschließend auf „Next“.

Ein Registrierungs-Dialogfeld wird geöffnet. Wenn Sie sich online bei 
Avid registrieren, erhalten Sie wichtige Updates und Wartungs- 
informationen.

t Wählen Sie „Don’t register at this time“ und klicken Sie anschließend 
auf „Activate“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach 
Abschluss der Aktivierung wird durch eine Meldung bestätigt, dass 
Ihre Software erfolgreich aktiviert wurde.

n Falls Sie Ihre Software zu diesem Zeitpunkt nicht registrieren möchten, können Sie 
dies auch später jederzeit tun, indem Sie in Ihrer Avid-Editing-Anwendung auf 
„Special > Register“ klicken.



8. Wenn Sie sich in Schritt 7 für die Registrierung der Software entschieden 
haben, gehen Sie folgendermaßen vor:

a. Geben Sie im Registrierungs-Dialogfeld Ihren Namen, Ihre Adresse 
und Ihre Kontaktinformationen in die entsprechenden Textfelder ein. 
Pflichtfelder sind mit einem Sternchen (*) gekennzeichnet.

b. Klicken Sie auf „Next“.

Ein Registrierungs-Dialogfeld wird geöffnet.

c. Geben Sie die entsprechenden Produkt- und Kundeninformationen ein. 

d. Klicken Sie auf „Activate“.

9. Sie werden durch eine Warnung des Systems aufgefordert, die Deaktivierung 
Ihres Dongles zu bestätigen. Klicken Sie auf „OK“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach Abschluss 
der Aktivierung wird durch eine Meldung bestätigt, dass Ihre Software 
erfolgreich aktiviert wurde.

10. Klicken Sie auf „OK“.

So aktualisieren Sie Ihre Avid-Editing-Anwendung offline auf eine 
Softwarelizenz: 

1. Rufen Sie das folgende Verzeichnis auf:
(Windows) Start\Alle Programme\Avid\Utilities\License Control
(Mac) Programme/Dienstprogramme/Avid Utilities/License Control

Das Avid License Control-Tool öffnet sich. 

2. Klicken Sie auf „Activate“ neben der Avid-Editing-Anwendung.

Das Aktivierungsfenster wird geöffnet.
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3. Wählen Sie „I am not connected to the Internet and will be using another 
computer that is connected to the Internet“ und klicken Sie auf „Continue“.

Ein Fenster wird geöffnet, in dem Sie Systeminformationen eingeben und 
Ihr Produkt registrieren können. 

4. Wenn Ihre System-ID nicht angezeigt wird, geben Sie sie in das entsprechende 
Textfeld ein. Anwender, die bereits Kunden sind, nutzen ihre alte System-ID.
Wie Sie Ihre System-ID finden, wenn sie nicht angezeigt wird, erfahren Sie 
unter „Was benötige ich, um meine Avid-Editing-Anwendungen zu 
aktivieren?“ auf Seite 81.

n Wenn zu Ihrer bisherigen Editing-Anwendung erworbene Erweiterungen wie 
PhraseFind oder ScriptSync gehörten, werden diese mit dem Upgrade 
automatisch aktiviert.

n Ihre Device-ID wird am unteren Ende der Aktivierungs-Seite angezeigt. Notieren 
Sie sie für später.

5. Geben Sie Ihre Aktivierungs-ID in das entsprechende Textfeld ein. Wie Sie 
Ihre Aktivierungs-ID finden, erfahren Sie unter „Was benötige ich, um 
meine Avid-Editing-Anwendungen zu aktivieren?“ auf Seite 81.

n Lassen Sie das Avid License Control-Tool auf dem System geöffnet, das Sie 
aktivieren möchten. Sie werden aufgefordert, zusätzliche Informationen 
einzugeben.

6. Klicken Sie auf „Next“.

7. Folgen Sie den Anweisungen im Avid License Control-Tool und klicken Sie 
auf „Next“.

8. Öffnen Sie auf einem Computer mit Internetverbindung einen Webbrowser 
und navigieren Sie zu http://avid.com/license. 

http://avid.com/license


9. Folgen Sie den Anweisungen auf der Website.

Die Website erstellt eine license.bin-Datei. Diese Datei enthält 
Lizenzinformationen, die für das Aktivieren Ihrer Avid-Editing-Anwendung 
benötigt werden.

10. Sobald Sie die license.bin-Datei erhalten, fahren Sie an dem Computer fort, 
auf dem Sie die Avid-Editing-Anwendung aktivieren möchten.

11. Öffnen Sie das Avid License Control-Tool, klicken Sie auf „Browse“, 
wählen Sie die auf Ihrem System abgelegte license.bin-Datei aus und 
klicken Sie dann auf „Open“.

Das Aktivierungstool bestätigt Ihre Systeminformationen. Nach Abschluss 
der Aktivierung wird durch eine Meldung bestätigt, dass Ihre Software 
erfolgreich aktiviert wurde, und die Schaltfläche verändert sich zu 
„Deactivate“.

n Wiederholen Sie diese Schritte für alle Editing-Anwendungen oder 
-Erweiterungen, die Sie aktivieren möchten.

12. Falls die Avid-Editing-Anwendung geöffnet ist, starten Sie diese neu, damit 
die Änderungen wirksam werden.

So aktualisieren Sie Ihre Avid-Editing-Anwendung mit einem Dongle:

1. Vergewissern Sie sich, dass der Dongle an Ihr Avid-Editing-System 
angeschlossen ist.

2. Gehen Sie in das Verzeichnis, in dem die Datei „DongleManager.exe“ zu 
finden ist:

t (Windows) C:\Programme\Avid\Utilities\DongleManager

t (Mac) Macintosh HD/Programme/Dienstprogramme/Avid 
Utilities/DongleManager
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3. Doppelklicken Sie auf die Datei „DongleManager.exe“.

Das Dongle Manager-Fenster wird geöffnet.

4. Klicken Sie auf die „Update“-Registerkarte.

5. Klicken Sie auf „Open“ und navigieren Sie zum Speicherort Ihrer 
Dongle-Aktualisierungsdatei (.avd).

6. Wählen Sie die Aktualisierungsdatei aus und klicken Sie auf „Open“.

7. Klicken Sie auf „Update“.

Die Anwendung „DongleManager.exe“ aktualisiert Ihren Dongle und zeigt 
eine Meldung an, wenn die Verifizierung abgeschlossen ist.

8. Starten Sie Ihre Avid-Editing-Anwendung.

Das Willkommen-Fenster öffnet sich.

9. Wählen Sie „I want to use a dongle to activate my software“.

10. Klicken Sie auf „Continue“.

Das System bestätigt Ihre Daten. Nach Abschluss der Aktivierung wird 
durch eine Meldung bestätigt, dass Ihre Software erfolgreich aktiviert 
wurde.

So aktualisieren Sie Ihre Avid-Editing-Anwendung mit Hilfe der Datei 
„Versioner.avd“ (nur für Kunden mit Avid-Supportverträgen): 

1. Laden Sie die zu Ihrer Editing-Anwendung gehörende Datei „Versioner.avd“ 
herunter.

2. Speichern Sie die Datei „Versioner.avd“ im Ordner der Editing-Anwendung:

(Windows) C:\Programme\Avid\[Avid-Editing-Anwendung]

(Mac) Macintosh HD/Programme/[Avid-Editing-Anwendung]
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3. Starten Sie Ihre Avid-Editing-Anwendung.

Das Avid License Control-Tool öffnet sich. 

4. Klicken Sie auf „Activate“ neben der Avid-Editing-Anwendung.

5. Sie haben folgende Möglichkeiten:

t Wählen Sie „I am connected to the Internet and will use this computer“.

t Wählen Sie „I am not connected to the Internet and will be using 
another computer that is connected to the Internet“.

6. Klicken Sie auf „Continue“.

Das Avid-Aktivierungs-Dialogfeld wird geöffnet. Die Eingabefelder für Ihre 
System-ID und Aktivierungs-ID werden automatisch vom System 
ausgefüllt. 

n Falls Sie einen Dongle verwenden, werden diese Felder nur dann automatisch 
ausgefüllt, wenn Sie Ihren Dongle angeschlossen haben.

7. Fahren Sie mit der Upgrade-Lizenzaktivierung fort wie in diesem Abschnitt 
beschrieben (je nachdem, welche Lizenzoption Sie in Schritt 5 gewählt 
haben).

Verwenden der 30-Tage-Testversion

Bevor Sie die Avid-Editing-Anwendung, PhraseFind oder ScriptSync erwerben, 
können Sie diese Programme im Rahmen einer 30-Tage-Testversion ausprobieren. 
Wenn Sie die 30-Tage-Testversion der Avid-Editing-Anwendung nutzen, bekommen 
Sie auch eine 30-Tage-Testlizenz für PhraseFind und ScriptSync. Ihre 30-Tage- 
Testversion von PhraseFind umfasst außerdem Zugang zu allen verfügbaren 
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Sprachen für die Dauer der Testlizenz. Sie müssen in dieser Zeit keine zusätzlichen 
Sprachpakete aktivieren. Sie müssen jedoch im PhraseFind-Fenster im „Select a 
Language“-Menü Ihre Sprache einstellen.

Wenn Sie bereits eine Avid-Editing-Anwendung erworben haben, können Sie 
PhraseFind oder ScriptSync in einer 30-Tage-Testversion verwenden.

Wenn Sie nach Ablauf der 30 Tage weder die Avid-Editing-Anwendung noch 
PhraseFind oder ScriptSync erwerben, haben Sie keinen Zugang mehr zu dem 
Produkt und seinen Funktionen. Das System teilt Ihnen mit, wie viele Tage noch 
bis zum Ablauf der Testlizenz bleiben.

n Sämtliche Bins und Projekte, die während der 30-Tage-Testphase erstellt wurden, 
können nur im Falle einer vollständigen Editing-Lizenzaktivierung weiterhin 
verwendet werden.

So testen Sie Ihre Avid-Editing-Anwendung 30 Tage lang:

1. Starten Sie Ihre Avid-Editing-Anwendung.

Das Willkommen-Fenster öffnet sich.

2. Wählen Sie „I want to run a fully-featured, trial version of [die 
Avid-Editing-Anwendung] for 30 days“.

3. Klicken Sie auf „Continue“.

Die Aktivierung Ihrer Software war erfolgreich. Sie können sich während 
der 30-Tage-Testphase jederzeit dazu entscheiden, eine Vollversion Ihrer 
Avid-Editing-Anwendung zu erwerben. Wenn Sie die Software nicht kaufen, 
wird Ihre Avid-Editing-Anwendung nach Ablauf der 30 Tage deaktiviert.
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So aktivieren Sie für PhraseFind eine Testphase von 30 Tagen:

1. Starten Sie Ihre Avid-Editing-Anwendung und öffnen Sie anschließend ein 
Projekt.

2. Drücken Sie Strg + F oder Befehl + F und wählen Sie „Edit > Find“.

Das „Find“-Fenster öffnet sich.

3. Geben Sie ein Wort oder einen Satz in das Textfeld ein und klicken Sie dann 
auf die PhraseFind-Schaltfläche.

Das System prüft, ob sich PhraseFind auf Ihrem System befindet, und öffnet 
anschließend ein Dialogfenster.

4. Klicken Sie auf „Run Trial“.

Das System startet Ihre Avid-Editing-Anwendung neu. Danach haben Sie 
Zugang zu PhraseFind.

Ihre 30-Tage-Testversion von PhraseFind umfasst außerdem den Zugang zu 
allen verfügbaren Sprachen für die Dauer der Testlizenz. Sie müssen in 
dieser Zeit keine zusätzlichen Sprachpakete aktivieren. Sie müssen jedoch 
im PhraseFind-Fenster im „Select a Language“-Menü Ihre Sprache 
einstellen.

5. Wählen Sie im PhraseFind-Fenster im „Select a Language“-Menü Ihre 
Sprache aus und warten Sie, bis der PhraseFind-Index grün wird.

So aktivieren Sie für ScriptSync die Testphase von 30 Tagen:

1. Starten Sie Ihre Avid-Editing-Anwendung und öffnen Sie anschließend ein 
Projekt.

2. Erstellen Sie ein Script über „File > New Script“.

3. Navigieren Sie zu Ihrem Script und klicken Sie auf „Open“.
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4. Klicken Sie in dem Script die Sektion an, in der Sie den Clip (Take) ablegen 
wollen.

Die ausgewählte Sektion leuchtet auf.

5. Ziehen Sie den Clip aus einer Bin in die ausgewählte Sektion.

Das Feld unterhalb des im Script abgelegten Clips sollte jetzt schwarz 
aufleuchten. Dadurch wird dieser Clip als im Script ausgewählt markiert.

6. Wählen Sie „Script > ScriptSync“.

Das System prüft, ob sich ScriptSync auf Ihrem System befindet, und öffnet 
anschließend ein Dialogfenster.

7. Klicken Sie auf „Run Trial“.

Sie haben sofortigen Zugang zum ScriptSync-Fenster.

So erwerben Sie die Avid-Editing-Anwendung innerhalb der 
30-Tage-Testphase:

t Besuchen Sie den Avid Store unter http://shop.avid.com/store/, um Ihre 
Avid-Editing-Anwendung zu erwerben.

So erwerben Sie PhraseFind oder ScriptSync während der 
30-Tage-Testphase:

1. Starten Sie Ihre Avid-Editing-Anwendung und öffnen Sie anschließend ein 
Projekt.

2. ScriptSync: Folgen Sie den unter „So aktivieren Sie für ScriptSync die 
Testphase von 30 Tagen:“ auf Seite 102 aufgeführten Schritten 1 bis 5 und 
wählen Sie dann „Script > ScriptSync“.

3. Drücken Sie Strg + F oder Befehl + F und wählen Sie „Edit > Find“.

Das „Find“-Fenster öffnet sich.
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4. PhraseFind: Geben Sie ein Wort oder einen Satz in das Textfeld ein und 
klicken Sie dann auf die PhraseFind-Schaltfläche.

Das System teilt Ihnen mit, wie viele Tage noch bis zum Ablauf Ihrer 
30-Tage-Testlizenz bleiben. 

5. Klicken Sie auf „Buy“.

n Sollte die „Buy“-Schaltfläche nicht erscheinen, schließen Sie das „Find“-Fenster 
und starten Sie Ihre Avid-Editing-Anwendung neu. Führen Sie die oben 
aufgeführten Schritte erneut aus.

Der Avid Store wird geöffnet und Sie können PhraseFind oder ScriptSync 
kaufen. Sobald Sie nach dem Kauf Ihre Aktivierungs-ID erhalten, können 
Sie PhraseFind oder ScriptSync aktivieren.

In einem Dialogfenster wird Ihnen mitgeteilt, dass durch die Aktivierung 
Ihre Avid-Editing-Anwendung beendet und das Avid License Control-Tool 
geöffnet wird.

6. Klicken Sie auf „Continue“.

Das Avid License Control-Tool öffnet sich.

Wie Sie die Aktivierung durchführen, erfahren Sie unter „Elektronische 
Aktivierung der Avid-Editing-Anwendung“ auf Seite 83.

Aktivieren von Erweiterungen und Funktionen

Neben der Avid-Editing-Anwendung können mehrere weitere Editing-Erweiterungs- 
optionen oder -Funktionen über das Avid License Control-Tool aktiviert werden. 

Folgen Sie zur Aktivierung dieser Funktionen den unter „Elektronische Aktivierung 
der Avid-Editing-Anwendung“ auf Seite 83 aufgeführten Schritten oder entnehmen 
Sie weitere Informationen den unten aufgeführten entsprechenden Anleitungen.
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• PhraseFind
Mit Hilfe der PhraseFind-Erweiterung („phonetic find“) können Sie Bins in 
einem einzelnen Projekt nach Audio-Dialogen durchsuchen. PhraseFind ist 
separat erhältlich und umfasst ein kostenloses Sprachpaket Ihrer Wahl. 
Weitere Informationen finden Sie unter „Purchasing and Activating 
PhraseFind“ in der Avid-Editing-Hilfe oder in der Anleitung Getting Started 
with PhraseFind.

• ScriptSync
ScriptSync nutzt Technologien zur phonetischen Indexierung, um die 
Audioinhalte eines Clips auszuwerten und den Zeilen des Script-Textes 
zuzuordnen. ScriptSync ist separat erhältlich. Weitere Informationen finden 
Sie unter „Purchasing and Activating ScriptSync“ in der Avid-Editing-Hilfe 
oder in der Anleitung Getting Started with ScriptSync.

• PhraseFind-Sprachpaket
Es können zusätzliche Sprachpakete zur Verwendung in PhraseFind erworben 
werden. Sprachpakete sind separat erhältlich. Weitere Informationen finden Sie 
unter „Activating Additional Regional Language Packs“ in der Avid-Editing- 
Hilfe oder in der Anleitung Getting Started with PhraseFind.

• Import von AVCHD Dolby AC-3 oder Verlinkung mit AMA
Diese Funktion wird verwendet, um AVCHD-Transportströme (.mts- 
Dateien) zu importieren oder AMA-Links zu diesen herzustellen. Wenn Sie 
bei dem ersten Import von .mts-Dateien oder Erstellen von AMA-Links 
nicht mit dem Internet verbunden sind, wird ein Dialogfenster und 
anschließend das Avid License Control-Tool geöffnet. Folgen Sie den 
Anweisungen auf dem Bildschirm, um diese Funktion zu aktivieren. Bei 
bestehender Internetverbindung erfolgt die Aktivierung automatisch.

n Die AVCHD Dolby AC-3-Funktion erscheint nur bei Verwendung dieses Formats. 
Normalerweise ist diese Option nicht im Avid License Control-Tool sichtbar.
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Deaktivieren von Avid-Editing-Anwendung und -Erweiterungen

Wenn Sie Ihre Avid-Editing-Anwendung auf einem anderen Computer verwenden 
wollen, müssen Sie Avid-Editing-Anwendung und -Erweiterungen vor der 
Deinstallation deaktivieren.

Deaktivieren Sie zuerst PhraseFind und ScriptSync und anschließend die 
Avid-Editing-Anwendung.

n Sie benötigen eine Internetverbindung für die Deaktivierung von Software und 
Erweiterungen.

n Die Testversion muss nicht deaktiviert werden.

So deaktivieren Sie die Avid-Editing-Anwendung und -Erweiterungen:

1. Wählen Sie in der Avid-Editing-Anwendung „Special > Deactivate Software 
License“.

2. Sie werden durch eine Mitteilung darüber informiert, dass die Avid-Editing- 
Anwendung geschlossen und das Avid License Control-Tool geöffnet wird. 
Klicken Sie auf „Continue“.

3. Sie werden in einem Dialogfenster gefragt, ob Sie die Avid-Editing- 
Anwendung verlassen möchten. Klicken Sie auf „Leave“.

4. Gehen Sie alternativ zu folgendem Verzeichnis, um das Avid License 
Control-Tool zu öffnen:
(Windows) Start\Alle Programme\Avid\Utilities\License Control
(Mac) Programme/Dienstprogramme/Avid Utilities/License Control

Das Avid License Control-Tool öffnet sich. 
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5. Klicken Sie neben der Avid-Editing-Anwendung, PhraseFind oder 
ScriptSync auf „Deactivate“.

Wenn Sie PhraseFind deaktivieren, wird Ihnen in einer Nachricht mitgeteilt, 
dass die in PhraseFind enthaltenen Sprachpakete ebenfalls deaktiviert 
werden. 

6. Klicken Sie auf „Yes“.

Die ausgewählte Anwendung wird vom System deaktiviert und die 
Schaltfläche verändert sich zu „Activate“.

7. Klicken Sie auf „Quit“, um das Fenster zu schließen.

Deinstallieren der Avid-Editing-Anwendung

Vor der Installation der Editing-Anwendung müssen Sie die Digi-Treiber mit 
Hilfe der Systemsteuerungsoption „Software“ deinstallieren. Starten Sie das 
System neu und installieren Sie anschließend die neue Editing-Anwendung. Wenn 
Sie die Digi-Treiber nicht entfernen, werden die AudioSuite-Plug-Ins nicht 
geladen und Sie erhalten möglicherweise die Fehlermeldung „This software 
requires installation of device driver TPkd and a reboot before running“ oder 
„DAE Interface NOT Available“. Wenn diese Fehlermeldungen bei einer 
Neuinstallation auf einem neuen System angezeigt werden, installieren Sie den 
Hotfix KB926255 von Windows Update, um das Problem zu beheben.

Führen Sie für alle Avid-Editing-Anwendungen den ersten Log-In und Start als 
Benutzer mit Administratorrechten aus. Falls Sie in einer Zentralspeicher- 
Umgebung arbeiten, müssen Sie Ihre Arbeitsbereiche mounten. Anschließend 
können Sie die Avid-Editing-Anwendung als normaler Benutzer ausführen.
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Falls Sie Pro Tools-Audiogeräte verwenden – etwa Geräte aus der Avid Mbox- 
Produktfamilie oder Avid Pro Tools|HD Native-Hardware –, müssen Sie die 
Gerätetreiber separat installieren. Audiogerätetreiber von Avid werden im 
folgenden Verzeichnis gespeichert:

• (Windows) Programme\Avid\Utilities\AudioDriverInstallers
• (Mac) Programme/Dienstprogramme/Avid Utilities/Avid Audio Drivers

(Windows) So deinstallieren Sie die Avid-Editing-Anwendung:

1. Beenden Sie alle aktiven Anwendungen.

2. Wählen Sie „Start > Systemsteuerung > Software“. Wählen Sie anschließend 
die Editing-Anwendung und klicken Sie auf „Deinstallieren“.

(Mac) So deinstallieren Sie die Avid-Editing-Anwendung:

1. Beenden Sie alle aktiven Anwendungen.

2. Rufen Sie das Verzeichnis 
„Programme/Avid_Uninstaller/Avid-Editing-Anwendung“ auf.

3. Doppelklicken Sie auf das Deinstallationsprogramm der Avid-Editing- 
Anwendung.

4. Folgen Sie den Anweisungen auf dem Bildschirm.
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Hinweis zur Firmware-Aktualisierung

Wenn Sie Ihre Editing-Anwendung nach der Installation zum ersten Mal starten, 
werden Sie möglicherweise aufgefordert, die Firmware der Avid-Hardware zu 
aktualisieren. Klicken Sie auf „Update“. Greifen Sie während der Aktualisierung 
nicht auf andere Anwendungen zu und verschieben Sie keines der aktiven Fenster. 
Wenn Sie auf eine andere Anwendung zugreifen, kann dies dazu führen, dass das 
Dialogfeld zur Fertigstellung des Updates verborgen bleibt. In diesem Fall wird 
der Fortschritt dauerhaft mit 100 % angezeigt, Sie haben aber keine Möglichkeit 
fortzufahren. Das verborgene Fenster, in dem die Aktualisierung als abgeschlossen 
angezeigt wird und Sie aufgefordert werden, das System herunterzufahren, kann 
dann nicht mehr in den Vordergrund geholt werden. Wenn dies geschieht, müssen 
Sie das System herunterfahren – nicht nur neu starten – und anschließend wieder 
einschalten.
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4 Manuale di installazione per le applicazioni di 
montaggio Avid

Le informazioni più aggiornate sull'applicazione di montaggio Avid in uso sono 
disponibili nella versione online del file ReadMe. È consigliabile verificare la 
versione più aggiornata delle note di rilascio o del ReadMe online, poiché la 
versione online viene aggiornata non appena sono disponibili nuove informazioni. 
Per visualizzare le versioni online, scegliere ReadMe dalla guida in linea 
dell'applicazione di montaggio Avid in uso o consultare la Knowledge Base 
all'indirizzo www.avid.com/readme.

Per poter installare l'applicazione di montaggio Avid direttamente dal DVD 
d'installazione è necessario che il sistema in uso supporti DVD dual layer. Se il 
sistema in uso non possiede un lettore DVD che supporta DVD dual layer, è 
possibile scaricare l'applicazione di montaggio Avid tramite l'area download Avid 
all'indirizzo www.avid.com/support/downloads. 

Una volta installata l'applicazione di montaggio Avid, è possibile attivare il 
relativo software usando lo strumento Avid License Control. Con lo strumento 
Avid License Control è possibile attivare anche opzioni di montaggio. Per 
maggiori informazioni riguardo alle opzioni di montaggio, vedere “Attivazione 
Opzioni e Funzionalità” a pagina 141.

n In presenza di un contratto di assistenza Avid attivo, potrebbe essere possibile 
aggiornare il software. Per ulteriori informazioni, vedere le istruzioni concernenti 
l’aggiornamento disponibili nell'area download Avid o fornite con il kit di 
aggiornamento.
 

http://www.avid.com/readme
http://www.avid.com/support/downloads


c Prima di modificare la configurazione del sistema, ad esempio sostituendo 
l'unità disco rigido o l'adattatore di rete oppure aggiornando il sistema 
operativo, è necessario disattivare il software Avid. Per informazioni sulle 
procedure di disattivazione vedere “Disattivazione dell'applicazione di 
montaggio Avid e delle opzioni” a pagina 142.

Prima di installare l'applicazione di montaggio Avid

Prima di installare l'applicazione di montaggio, consultare le seguenti procedure.  
Sono disponibili procedure sia per utenti che eseguono l'aggiornamento 
all'applicazione, sia per nuovi utenti. Scegliere la procedura applicabile:

Nuovi utenti
I nuovi utenti che non hanno mai installato l'applicazione di montaggio devono 
seguire le istruzioni contenute nelle pagine da  pagina 113 a pagina 125. 
Cominciare da “Installazione dell'applicazione di montaggio Avid” a pagina 113.

Utenti esistenti
Gli utenti che eseguono l'aggiornamento da una versione precedente 
dell'applicazione di montaggio devono invece disinstallare la versione precedente 
del software prima di installare quella nuova. 

n Prima di procedere alla disinstallazione dell'applicazione di montaggio Avid 
prendere nota del numero di identificazione del sistema. È necessario possedere il 
numero di identificazione del vecchio sistema

 per poter attivare il nuovo software.

Seguire le istruzioni contenute nelle pagine da pagina 126 a pagina 136. 
Cominciare da “Aggiornamento dell'applicazione di montaggio Avid” a 
pagina 126.
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Installazione dell'applicazione di montaggio Avid

Per tutte le applicazioni di montaggio Avid: accedere come utente con privilegi di 
amministratore, effettuare l'installazione dell'applicazione e procedere al primo 
avvio dell'applicazione come utente con privilegi di amministratore. Se si lavora 
in un ambiente di archiviazione condiviso, montare le aree di lavoro. In seguito, 
sarà possibile eseguire l'applicazione di montaggio Avid come utente comune.

n L'installazione del software dell'applicazione di montaggio Avid può richiedere 
un certo tempo. L'installazione di una singola applicazione di montaggio può 
richiedere da 5 a 15 minuti. L'installazione dell'intera suite di montaggio può 
invece richiedere fino a 35 minuti.

(Windows) Per installare il software dell'applicazione di montaggio 
Avid:

1. Chiudere tutte le applicazioni attive.

2. Inserire il DVD dell'applicazione di montaggio.

3. Scegliere l'opzione Install the Avid Editor Suite or Individual Product 
(Installazione Avid Editor Suite o prodotti individuali) e seguire le istruzioni 
visualizzate.

n Se viene visualizzata la finestra di dialogo FilesInUse (File in uso), è possibile 
fare clic su Ignora e continuare.

n Se durante l'installazione vengono visualizzati avvisi relativi all'accesso utenti, 
fare clic su Procedere ugualmente e procedere con l'installazione.

4. Quando richiesto selezionare "Yes, restart my computer" (Sì, riavviare il 
computer).

5. Passare alla sezione “Avvio dell'applicazione di montaggio Avid” a 
pagina 114.



(Macintosh) Per installare il software dell'applicazione di montaggio 
Avid:

1. Chiudere tutte le applicazioni.

2. Inserire il DVD dell'applicazione di montaggio.

3. Fare doppio clic su EditingApplicationName.pkg.

4. Scegliere l'opzione Install the Avid Editor Suite or Individual Product 
(Installazione Avid Editor Suite o prodotti individuali) e seguire le istruzioni 
visualizzate.

5. Quando richiesto selezionare "Yes, restart my computer" (Sì, riavviare il 
computer).

6. Passare alla sezione “Avvio dell'applicazione di montaggio Avid” a 
pagina 114.

Avvio dell'applicazione di montaggio Avid

Con il processo d’installazione vengono aggiunte un'icona sul desktop o nel Dock 
e una voce riguardante l’applicazione di montaggio Avid nel menu Start. 

Se l'applicazione di montaggio Avid viene installata in un computer portatile, 
potrebbe essere visualizzata una finestra di dialogo indicante la presenza di 
combinazioni per il risparmio di energia incompatibili. Su Windows 7, Avid 
consiglia l'utilizzo dell'opzione di risparmio energetico "Alte prestazioni" durante 
le lavorazioni con le applicazioni di montaggio Avid. Altre combinazioni, infatti, 
potrebbero avere ripercussioni sulle prestazioni di alcune funzioni di montaggio 
quali l'acquisizione e i tagli digitali. 

Dopo aver installato il software dell'applicazione di montaggio Avid e aver 
avviato l'applicazione per la prima volta, è necessario procedere all'attivazione 
della propria copia dell'applicazione.
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(Windows) Per avviare l'applicazione di montaggio Avid, eseguire 
una delle seguenti operazioni:

t Fare clic su Start > Tutti i programmi > Avid > Applicazione di montaggio 
Avid.

t Fare doppio clic sull'icona del desktop dell'applicazione di montaggio Avid.

Verrà visualizzata la finestra iniziale. 

(Macintosh) Per avviare l'applicazione di montaggio Avid, eseguire 
una delle seguenti operazioni:

1. Fare clic sull'icona dell'alias dell'applicazione di montaggio Avid sul Dock.

2. Oppure scegliere Vai > Applicazioni, quindi fare doppio clic sulla cartella 
dell'applicazione di montaggio Avid. In seguito, fare doppio clic sul file 
dell'applicazione di montaggio Avid.
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Viene visualizzata la finestra iniziale.

3. Per attivare il software selezionare una delle seguenti opzioni.

t Per procedere all'attivazione usando l'opzione Electronic Activation 
(Attivazione elettronica), selezionare la voce "I want to activate my 
software using the Internet, another computer, or a volume license 
server" (Attivazione software tramite Internet, un altro computer o un 
server di licenze a volume), e fare clic su Avanti. 
Si apre lo strumento Avid License Control. Seguire le stesse procedure 
descritte in “Attivazione dell'applicazione di montaggio Avid tramite 
Electronic Activation (Attivazione elettronica)” a pagina 119.



t Per procedere all'attivazione usando l'opzione Hardware Key oppure un 
dongle, selezionare la voce "I want to use a dongle to activate my 
software" (Attivazione software tramite dongle), collegare il dongle 
autorizzato e fare clic su Avanti.
Il sistema conferma le informazioni. Al completamento 
dell'attivazione, un messaggio indica che il software è stato attivato 
correttamente.

t Per avviare la modalità di prova, selezionare "I want to run a 
fully-featured trial version of the Avid editing application for 30 days" 
(Attivazione versione di prova completa dell'applicazione di montaggio 
Avid per 30 giorni) e fare clic su Avanti.
Il software è stato attivato correttamente.
Per ulteriori informazioni sulla modalità di prova, vedere “Attivazione 
applicazione di prova di 30 giorni” a pagina 137.

Per attivare l'applicazione di montaggio Avid è necessario essere 
in possesso di:

Numeri di 
identificazione (ID): Dove trovare questi numeri:

Numero di attivazione La copertina interna di questo manuale.

Se l'acquisto è stato effettuato tramite Avid webstore, l'utente 
riceverà il numero di attivazione tramite e-mail da parte di Avid.

Se l'acquisto è stato effettuato tramite Avid webstore, accedere al 
proprio conto all'indirizzo http://account.avid.com/.
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Numero di identificazione 
del sistema

Per nuovi utenti, la copertina interna di questa guida.
Per utenti già esistenti, è necessario fornire il numero di 
identificazione del vecchio sistema.

Se l'applicazione è stata acquistata online, l'utente ha ricevuto il 
numero di identificazione del sistema tramite e-mail da parte di Avid.

La schermata di caricamento dell'applicazione di montaggio Avid 
(Guida in linea > Info su applicazione di montaggio Avid).

La consolle dell'applicazione di montaggio Avid (Strumenti > 
Consolle, in seguito scorrere il cursore fino a localizzare il 
numero di identificazione del sistema).

Se l'acquisto è stato effettuato tramite Avid webstore, è possibile 
visualizzare il proprio numero di identificazione del sistema 
accedendo al proprio conto all'indirizzo http://account.avid.com/.

Numero di identificazione 
del sistema (continua)

Una volta attivata l'applicazione, nella scheda Profilo Licenza 
dello strumento Avid License Control verranno visualizzate le 
informazioni concernenti il proprio sistema. Fare clic su Copia per 
copiare le informazioni nella clipboard. In seguito è possibile tagliare 
queste informazioni dalla clipboard e incollarle all'interno di 
un’e-mail oppure creare un file di testo. Questo si rivela 
particolarmente utile quando è necessario salvare queste informazioni 
oppure per inviare informazioni di sistema al Servizio Clienti Avid.

Numeri di 
identificazione (ID): Dove trovare questi numeri:
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Attivazione dell'applicazione di montaggio Avid tramite 
Electronic Activation (Attivazione elettronica)

• Con connessione Internet - Vedere “Attivazione dell'applicazione di 
montaggio Avid tramite Electronic Activation (Attivazione elettronica) con 
connessione ad Internet” a pagina 120.

• Senza connessione Internet - Vedere “Attivazione dell'applicazione di 
montaggio Avid tramite Electronic Activation (Attivazione elettronica) 
senza connessione ad Internet” a pagina 124.

• Tramite Server di licenze a volume - Vedere “Attivazione dell'applicazione di 
montaggio Avid utilizzando l'opzione Server di licenze a volume” a pagina 125.

Numero del dispositivo Richiesto unicamente in caso di attivazione del software su 
sistema non collegato a Internet. Questo numero viene fornito agli 
utenti tramite lo strumento Avid License Control nel corso 
dell'attivazione.

Numeri di 
identificazione (ID): Dove trovare questi numeri:
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Attivazione dell'applicazione di montaggio Avid tramite 
Electronic Activation (Attivazione elettronica) con connessione 
ad Internet

1. Aprire lo strumento Avid License Control, fare clic su Attivare situato 
accanto all'applicazione di montaggio Avid.
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Si apre quanto segue.

2. Selezionare “I am connected to the Internet and will use this computer” 
(Sono collegato a Internet e utilizzerò questo computer), quindi fare clic su 
Avanti.
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Si apre una finestra che permette di inserire informazioni di sistema e di 
registrare il prodotto.

3. Immettere il numero di identificazione del sistema nella casella di testo 
System ID. Per localizzare il proprio numero di identificazione del sistema, 
vedere “Per attivare l'applicazione di montaggio Avid è necessario essere in 
possesso di:” a pagina 117.

4. Immettere il proprio numero di attivazione nella casella di testo Activation 
ID. Per localizzare il proprio numero di attivazione, vedere “Per attivare 
l'applicazione di montaggio Avid è necessario essere in possesso di:” a 
pagina 117.
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5. Per visualizzare l'informativa sulla privacy di Avid, fare clic su Informativa 
sulla Privacy. 

6. Eseguire una delle seguenti operazioni:

t Selezionare "Register your software" (Avviare registrazione software), 
quindi fare clic su Avanti.

Viene visualizzata una finestra di dialogo di registrazione. La 
registrazione online Avid consente di ricevere importanti 
aggiornamenti e informazioni di manutenzione.

t Selezionare "Don't register your software" (Non avviare registrazione 
software), quindi fare clic su Attivare.

Lo strumento Avid License Control conferma le informazioni di 
sistema. Al completamento dell'attivazione, un messaggio indica che il 
software è stato attivato correttamente.

n  Se non si desidera registrare il software in quel momento, è possibile eseguire 
l'operazione in un secondo tempo scegliendo Speciale > Registrazione 
nell'applicazione di montaggio Avid.

7. Se si decide di registrare il software, eseguire le seguenti operazioni:

a. Nella finestra di dialogo Registrazione digitare il nome, l'indirizzo e le 
informazioni di contatto nelle caselle di testo appropriate. Gli asterischi 
(*) indicano campi obbligatori.

b. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo di registrazione.

c. Immettere le informazioni del prodotto e del cliente appropriate. 

d. Fare clic su Attivazione e registrazione.

8. Nel caso l'applicazione di montaggio Avid fosse aperta, sarà necessario 
riavviarla affinché le modifiche vengano registrate.
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Attivazione dell'applicazione di montaggio Avid tramite Electronic 
Activation (Attivazione elettronica) senza connessione ad Internet

1. Aprire lo strumento Avid License Control, fare clic su Attivare situato 
accanto all'applicazione di montaggio Avid.

Si apre la finestra Attivazione.

2. Selezionare “I am not connected to the Internet and will be using another 
computer that is connected to the Internet” (Non sono collegato a Internet e 
utilizzerò un altro computer collegato a Internet), quindi fare clic su Avanti.

3. Immettere il numero di identificazione del sistema nella casella di testo 
System ID. Per localizzare il proprio numero di identificazione del sistema, 
vedere “Per attivare l'applicazione di montaggio Avid è necessario essere in 
possesso di:” a pagina 117.

n Il numero del dispositivo viene visualizzato in fondo alla pagina Attivazione - Si 
consiglia di prendere nota di tale numero.

4. Immettere il proprio numero di attivazione nella casella di testo Activation 
ID. Per localizzare il proprio numero di attivazione, vedere “Per attivare 
l'applicazione di montaggio Avid è necessario essere in possesso di:” a 
pagina 117.

5. Fare clic su Avanti.

6. Seguire le istruzioni fornite dallo strumento Avid License Control, quindi 
fare clic su Avanti.

7. Su computer collegato a Internet, aprire un browser e andare alla pagina 
http://avid.com/license. 
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8. Seguire le istruzioni visualizzate nella pagina web.

Il sito web crea un file license.bin. Questo file contiene informazioni 
riguardanti la licenza necessarie per l'attivazione dell'applicazione di 
montaggio Avid.

9. Una volta recuperato il file license.bin, tornare sul computer sul quale si 
desidera effettuare l'attivazione.

10. Aprire lo strumento Avid License Control e fare clic su Cerca per localizzare 
il file license.bin all'interno del sistema, quindi fare clic su Apri.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è stato 
attivato correttamente e il pulsante visualizza la scritta Disattivare.

n Per ogni applicazione di montaggio o opzione da attivare è necessario ripetere 
tutti i passaggi descritti in precedenza.

11. Nel caso l'applicazione di montaggio Avid fosse aperta, sarà necessario 
riavviarla affinché le modifiche vengano registrate.

Attivazione dell'applicazione di montaggio Avid utilizzando 
l'opzione Server di licenze a volume

Con l'utilizzo di un server di licenze a volume è possibile attivare e gestire 
molteplici client. Per ulteriori informazioni, consultare il manuale FlexNet Device 
Manager for Avid all'interno della Knowledge Base. 
Attivazione dell'applicazione di montaggio Avid utilizzando l'opzione Server di licenze a 



Aggiornamento dell'applicazione di montaggio Avid

È possibile aggiornare l'applicazione di montaggio Avid da una licenza software 
esistente o da una licenza su dongle. Se si aggiorna da una licenza su dongle o si cambia 
modello di prodotto, il kit di aggiornamento include una scheda di aggiornamento del 
dongle, un codice di aggiornamento e un codice di attivazione del software. Per 
aggiornare il software, consultare le istruzioni incluse nel kit di aggiornamento.

Se erano già stati acquistati i prodotti PhraseFind, PhraseFind Language Pack o 
ScriptSync, l'attivazione della licenza viene aggiornata automaticamente. Nel 
caso di acquisto di nuove opzioni, viene fornito un nuovo numero di attivazione.

n Aggiornando la licenza da dongle a software, viene disabilitato il dongle. Una 
volta attivata la licenza software, il dongle non è più necessario né valido per 
l'esecuzione dell'applicazione di montaggio Avid.

Se si aggiorna una licenza esistente e si dispone di un contratto di supporto Avid 
valido, prima di aggiornare il sistema leggere le istruzioni disponibili nell'area 
download Avid o incluse nel kit di aggiornamento. Tutti coloro che hanno 
sottoscritto un contratto di supporto Avid devono utilizzare il file Versioner.avd. 
per aggiornare il proprio software come descritto nell'ultima procedura relativa a 
questo argomento. Per ulteriori informazioni visualizzare l'argomento "Software 
Licensing Upgrade Process for Support Customers" (Processo di aggiornamento 
delle licenze software per clienti con contratto di supporto) nella Knowledge Base 
di Avid (www.avid.com/US/support).

Di seguito vengono descritte procedure di livello più alto da seguire per 
aggiornare il sistema di montaggio Avid e le opzioni PhraseFind o ScriptSync.
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Procedura di aggiornamento 

1. Disinstallare l'applicazione di montaggio Avid esistente.

Vedere “Disinstallazione dell'applicazione di montaggio Avid” a pagina 144.

PhraseFind e ScriptSync saranno disinstallati insieme all'applicazione di 
montaggio Avid.

n Prima di procedere alla disinstallazione dell'applicazione di montaggio Avid 
prendere nota del numero di identificazione del sistema. Per attivare il nuovo 
software è necessario possedere il numero di identificazione del vecchio sistema.

2. Avviare l'installazione della nuova applicazione di montaggio Avid.

Vedere “Installazione dell'applicazione di montaggio Avid” a pagina 113.

PhraseFind e ScriptSync saranno installati insieme all'applicazione di 
montaggio Avid. Se erano già stati acquistati i prodotti PhraseFind, 
PhraseFind Language Pack o ScriptSync, l'attivazione della licenza viene 
aggiornata automaticamente. Nel caso di acquisto di nuove opzioni, allora 
verrà fornito un nuovo numero di attivazione.

3. Per attivare l'applicazione di montaggio Avid.

A seconda della configurazione in uso, seguire i seguenti passaggi di 
aggiornamento. 
Per ulteriori informazioni sullo strumento Avid License Control, vedere 
“Attivazione dell'applicazione di montaggio Avid tramite Electronic 
Activation (Attivazione elettronica)” a pagina 119.

4. Per attivare PhraseFind, PhraseFind Language Pack o ScriptSync.

Vedere “Attivazione dell'applicazione di montaggio Avid tramite Electronic 
Activation (Attivazione elettronica)” a pagina 119.
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Per aggiornare l'applicazione di montaggio Avid con connessione 
Internet da una licenza software esistente:

1. Andare alla seguente posizione:
(Windows) Start/Tutti i programmi/Avid/Utility/Controllo Licenze
(Macintosh) Applicazioni/Utility/Avid Utility/Controllo Licenze

Si apre lo strumento Avid License Control.

2. Fare clic sull'opzione Attivare relativa all'applicazione di montaggio Avid.

Viene visualizzata la finestra Attivazione.

3. Selezionare “I am connected to the Internet and will use this computer” 
(Sono collegato a Internet e utilizzerò questo computer), quindi fare clic su 
Avanti.

Si apre una finestra che permette di inserire informazioni di sistema e di 
registrare il prodotto. 

4. Nel caso non venisse visualizzato il numero di identificazione del sistema, 
sarà necessario inserirlo manualmente nella casella di testo System ID. I 
clienti esistenti devono utilizzare il numero di identificazione del vecchio 
sistema.
Se non dovesse comparire il numero di identificazione del sistema, per 
localizzarlo vedere “Per attivare l'applicazione di montaggio Avid è 
necessario essere in possesso di:” a pagina 117.

n Nel caso la vecchia applicazione di montaggio includesse opzioni acquistate in 
precedenza, quali ad esempio PhraseFind o ScriptSync, queste opzioni verranno 
automaticamente attivate durante l'aggiornamento.

5. Immettere il proprio numero di attivazione nella casella di testo Activation 
ID. Utilizzare il numero di attivazione della nuova versione del software.
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6. Eseguire una delle seguenti operazioni:

t Se il prodotto non è mai stato registrato, selezionare "Register your 
product with Avid Technology, Inc. now" (Effettuare registrazione del 
prodotto presso Avid Technology, Inc. adesso). Per visualizzare 
l'informativa sulla privacy di Avid, fare clic su Informativa sulla 
privacy. Quindi, fare clic su Avanti.

Viene visualizzata una finestra di dialogo di registrazione. La 
registrazione online Avid consente di ricevere importanti 
aggiornamenti e informazioni di manutenzione.

t Selezionare "Don't register at this time" (Non effettuare la registrazione 
adesso), quindi fare clic su Attivare.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è 
stato attivato correttamente.

n  Se non si desidera registrare il software in quel momento, è possibile eseguire 
l'operazione in un secondo tempo selezionando Speciale > Registrazione 
nell'applicazione di montaggio Avid.

7. Se si è scelto di registrare il software nel passaggio 6, eseguire le seguenti 
operazioni:

a. Nella finestra di dialogo Registrazione digitare il nome, l'indirizzo e le 
informazioni di contatto nelle caselle di testo appropriate. Gli asterischi 
(*) indicano campi obbligatori.

b. Fare clic su Avanti

Viene visualizzata una finestra di dialogo di registrazione.

c. Immettere le informazioni del prodotto e del cliente appropriate.
Aggiornamento dell'applicazione di montaggio Avid 129



d. Fare clic su Attivazione e registrazione.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è 
stato attivato correttamente e il pulsante visualizza la scritta Disattivare.

8. Fare clic su OK. 

Per aggiornare l'applicazione di montaggio Avid con connessione 
Internet da licenza dongle a licenza software:

1. Collegare il dongle al sistema di montaggio Avid.

2. Andare alla seguente posizione:
(Windows) Start/Tutti i programmi/Avid/Utility/Controllo Licenze
(Macintosh) Applicazioni/Utility/Avid Utility/Controllo Licenze

Si apre lo strumento Avid License Control.

3. Fare clic sull'opzione Attivare relativa all'applicazione di montaggio Avid.

Viene visualizzata la finestra di dialogo Attivazione.

4. Selezionare “I am connected to the Internet and will use this computer” 
(Sono collegato a Internet e utilizzerò questo computer), quindi fare clic su 
Avanti.

Si apre una finestra che permette di inserire informazioni di sistema e di 
registrare il prodotto. 

5. Nel caso non venisse visualizzato il numero di identificazione del sistema, 
sarà necessario inserirlo manualmente nella casella di testo System ID. I 
clienti esistenti devono utilizzare il numero di identificazione del vecchio 
sistema.
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Se non dovesse comparire il numero di identificazione del sistema, per 
localizzarlo vedere “Per attivare l'applicazione di montaggio Avid è 
necessario essere in possesso di:” a pagina 117.

n Nel caso la vecchia applicazione di montaggio includesse opzioni acquistate in 
precedenza, quali ad esempio PhraseFind o ScriptSync, queste opzioni verranno 
automaticamente attivate durante l'aggiornamento.

6. Immettere il proprio numero di attivazione nella casella di testo Activation 
ID. Per localizzare il proprio numero di attivazione, vedere “Per attivare 
l'applicazione di montaggio Avid è necessario essere in possesso di:” a 
pagina 117.

7. Eseguire una delle seguenti operazioni:

t Se il prodotto non è mai stato registrato, selezionare "Register your 
product with Avid Technology, Inc. now" (Effettuare registrazione del 
prodotto presso Avid Technology, Inc. adesso). Per visualizzare 
l'informativa sulla privacy di Avid, fare clic su Informativa sulla 
privacy. Quindi, fare clic su Avanti.

Viene visualizzata una finestra di dialogo di registrazione. La 
registrazione online Avid consente di ricevere importanti 
aggiornamenti e informazioni di manutenzione.

t Selezionare "Don't register at this time" (Non effettuare la registrazione 
adesso), quindi fare clic su Attivare.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è 
stato attivato correttamente.



n  Se non si desidera registrare il software in quel momento, è possibile eseguire 
l'operazione in un secondo tempo scegliendo Speciale > Registrazione 
nell'applicazione di montaggio Avid.

8. Se si è scelto di registrare il software nel passaggio 7, eseguire le seguenti 
operazioni:

a. Nella finestra di dialogo Registrazione digitare il nome, l'indirizzo e le 
informazioni di contatto nelle caselle di testo appropriate. Gli asterischi 
(*) indicano campi obbligatori.

b. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo di registrazione.

c. Immettere le informazioni del prodotto e del cliente appropriate. 

d. Fare clic su Attivare.

9. Il sistema chiederà conferma della disattivazione del dongle. Fare clic su 
OK.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è stato 
attivato correttamente.

10. Fare clic su OK.
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Per aggiornare l'applicazione di montaggio Avid senza connessione 
Internet a una licenza software: 

1. Andare alla seguente posizione:
(Windows) Start/Tutti i programmi/Avid/Utility/Controllo Licenze
(Macintosh) Applicazioni/Utility/Avid Utility/Controllo Licenze

Si apre lo strumento Avid License Control. 

2. Fare clic sull'opzione Attivare relativa all'applicazione di montaggio Avid.

Viene visualizzata la finestra Attivazione.

3. Selezionare “I am not connected to the Internet and will be using another 
computer that is connected to the Internet” (Non sono collegato a Internet e 
utilizzerò un altro computer collegato a Internet), quindi fare clic su Avanti.

Si apre una finestra che permette di inserire informazioni di sistema e di 
registrare il prodotto. 

4. Nel caso non venisse visualizzato il numero di identificazione del sistema, 
sarà necessario inserirlo manualmente nella casella di testo System ID. I 
clienti esistenti devono utilizzare il numero di identificazione del vecchio 
sistema.
Se non dovesse comparire il numero di identificazione del sistema, per 
localizzarlo vedere “Per attivare l'applicazione di montaggio Avid è 
necessario essere in possesso di:” a pagina 117.

n Nel caso la vecchia applicazione di montaggio includesse opzioni acquistate in 
precedenza, quali ad esempio PhraseFind o ScriptSync, queste opzioni verranno 
automaticamente attivate durante l'aggiornamento.

n Il numero del dispositivo viene visualizzato in fondo alla pagina Attivazione - Si 
consiglia di prendere nota di tale numero.



5. Immettere il proprio numero di attivazione nella casella di testo Activation 
ID. Per localizzare il proprio numero di attivazione, vedere “Per attivare 
l'applicazione di montaggio Avid è necessario essere in possesso di:” a 
pagina 117.

n Lasciare lo strumento Avid License Control aperto sul sistema che si desidera 
attivare. Sarà necessario inserire ulteriori informazioni.

6. Fare clic su Avanti.

7. Seguire le istruzioni fornite dallo strumento Avid License Control, quindi 
fare clic su Avanti.

8. Su computer collegato a Internet, aprire un browser e andare alla pagina 
http://avid.com/license.

9. Seguire le istruzioni visualizzate nella pagina web.

Il sito web crea un file license.bin. Questo file contiene informazioni 
riguardanti la licenza necessarie per l'attivazione dell'applicazione di 
montaggio Avid.

10. Una volta recuperato il file license.bin, tornare sul computer sul quale si 
desidera effettuare l'attivazione.

11. Aprire lo strumento Avid License Control e fare clic su Cerca per localizzare 
il file license.bin all'interno del sistema, quindi fare clic su Apri.

Lo strumento Attivazione conferma le informazioni di sistema. Al 
completamento dell'attivazione, un messaggio indica che il software è stato 
attivato correttamente e il pulsante visualizza la scritta Disattivare.

n Per ogni applicazione di montaggio o opzione da attivare è necessario ripetere 
tutti i passaggi descritti in precedenza.
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12. Nel caso l'applicazione di montaggio Avid fosse aperta, sarà necessario 
riavviarla affinché le modifiche vengano registrate.

Per aggiornare l'applicazione di montaggio Avid mediante un dongle:

1. Verificare di aver collegato il dongle al sistema di montaggio Avid.

2. Andare alla directory dove è stato installato DongleManager.exe:

t (Windows) C:\Programmi\Avid\Utility\DongleManager

t (Macintosh) Macintosh HD\Applicazioni\Utility\Avid 
Utility\DongleManager

3. Fare doppio clic sull'icona DongleManager.exe.

Viene visualizzata la finestra Dongle Manager.

4. Fare clic sulla scheda Aggiornamento.

5. Fare clic su Apri, quindi selezionare la posizione del file di aggiornamento 
del dongle (.avd).

6. Selezionare il file di aggiornamento e fare clic su Apri.

7. Fare clic su Aggiorna.

L'applicazione DongleManager.exe aggiorna il dongle e visualizza il 
messaggio "Verification Complete" (Verifica completata).

8. Avviare l'applicazione di montaggio Avid.

Verrà visualizzata la finestra iniziale.

9. Selezionare l'opzione "I want to use a dongle to activate my software" 
(Attivazione software tramite dongle).

10. Fare clic su Avanti.

Il sistema conferma le informazioni. Al completamento dell'attivazione, un 
messaggio indica che il software è stato attivato correttamente.



Per aggiornare l'applicazione di montaggio Avid utilizzando il file 
Versioner.avd (solo clienti con contratto di supporto Avid): 

1. Scaricare il file Versioner.avd per l'applicazione di montaggio.

2. Mettere il file Versioner.avd nella cartella dell'applicazione di montaggio:

(Windows) [drive]:/Programmi/Avid/[Applicazione di montaggio Avid]

(Macintosh) Macintosh HD/Applicazioni/[Applicazione di montaggio Avid]

3. Avviare l'applicazione di montaggio Avid.

Si apre lo strumento Avid License Control. 

4. Fare clic sull'opzione Attivare relativa all'applicazione di montaggio Avid.

5. Eseguire una delle seguenti operazioni:

t Selezionare “I am connected to the Internet and will use this computer” 
(Sono collegato a Internet e utilizzerò questo computer).

t Selezionare “I am not connected to the Internet and will be using 
another computer that is connected to the Internet” (Non sono collegato 
a Internet e utilizzerò un altro computer collegato a Internet).

6. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Attivazione Avid. Il sistema produce 
in automatico il numero di identificazione del sistema e il numero di 
attivazione. 

n Nel caso di utilizzo di dongle, il numero di identificazione del sistema e il numero 
di attivazione verranno prodotti solo se il dongle è inserito.

7. Proseguire con le operazioni di attivazione dell'aggiornamento della licenza 
descritte nella presente sezione e corrispondenti all'opzione selezionata nel 
passaggio 5.
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Attivazione applicazione di prova di 30 giorni

Prima dell'acquisto di un'applicazione di montaggio Avid e dell'opzione 
PhraseFind o ScriptSync, è possibile effettuare una prova della durata di 30 giorni. 
Con l'attivazione dell'applicazione di montaggio Avid di prova per 30 giorni, 
verranno attivate per una prova dello stesso periodo anche le opzioni PhraseFind e 
ScriptSync. Il periodo di prova di 30 giorni di PhraseFind comprende anche 
accesso a tutte le lingue disponibili. Non è necessario attivare alcun pacchetto 
lingue aggiuntivo. È necessario però selezionare la lingua che si desidera 
utilizzare dal menu Seleziona una lingua all'interno della finestra PhraseFind.

Se già si possiede un'applicazione di montaggio Avid, è possibile attivare una 
prova della durata di 30 giorni di PhraseFind o ScriptSync.

Passato il periodo di prova di 30 giorni, se si decide di non acquistare né l'applicazione 
di montaggio Avid né le opzioni PhraseFind o ScriptSync, non sarà più possibile 
accedere al prodotto e alle sue funzionalità. Il sistema provvede a tenere aggiornati gli 
utenti sui giorni di prova rimanenti prima del termine del periodo di prova.

n Qualsiasi bin o progetto creato nel corso dei 30 giorni di prova potrà essere 
utilizzato unicamente dopo aver provveduto all'attivazione di una licenza 
normale.

Per utilizzare l'applicazione di montaggio Avid per un periodo di 
prova di 30 giorni:

1. Avviare l'applicazione di montaggio Avid.

Viene visualizzata la finestra iniziale.

2. Selezionare "I want to run a fully-featured trial version of the Avid editing 
application for 30 days" (Attivazione versione di prova completa 
dell'applicazione di montaggio Avid per 30 giorni).
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3. Fare clic su Avanti.

Il software è stato attivato correttamente. Nel corso del periodo di prova di 30 
giorni è possibile acquistare l'applicazione di montaggio Avid in qualsiasi 
momento. Se si sceglie di non acquistare il software, l'applicazione di montaggio 
Avid viene disattivata al termine del periodo di prova di 30 giorni.

Per attivare PhraseFind per un periodo di prova di 30 giorni:

1. Avviare l'applicazione di montaggio Avid, quindi aprire un progetto Avid.

2. Per PhraseFind, premere Ctrl+F o Command+F oppure selezionare Edit > 
Trova.

Viene visualizzata la finestra Trova.

3. Inserire una parola o una frase all'interno della casella di testo, quindi fare 
clic sul pulsante PhraseFind.

Il sistema verifica l'esistenza di PhraseFind sul sistema in uso e quindi viene 
visualizzata una finestra di dialogo.

4. Fare clic su Avviare prova.

Il sistema provvede a riavviare l'applicazione di montaggio Avid e una volta 
riavviata sarà possibile accedere all'opzione PhraseFind.

Il periodo di prova di 30 giorni di PhraseFind comprende anche accesso a 
tutte le lingue disponibili. Non è necessario attivare alcun pacchetto lingue 
aggiuntivo. È necessario però selezionare la lingua che si desidera utilizzare 
dal menu Seleziona una lingua all'interno della finestra PhraseFind.

5. Nella finestra PhraseFind, selezionare la lingua che si desidera utilizzare dal 
menu Seleziona una lingua e attendere che l'indicatore PhraseFind diventi 
completamente verde.
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Per attivare ScriptSync per un periodo di prova di 30 giorni:

1. Avviare l'applicazione di montaggio Avid, quindi aprire un progetto Avid.

2. Creare uno script, File > Nuovo script.

3. Individuare lo script creato, quindi fare clic su Apri.

4. All'interno dello script, fare clic sulla sezione dove si desidera mettere la clip 
(take).

La sezione si illumina.

5. Trascinare la clip dal bin alla sezione stabilita all'interno dello script.

Il riquadro sotto la clip nello script dovrebbe diventare nero. Questo indica 
che la clip è stata selezionata nello script.

6. Selezionare Script > ScriptSync.

Il sistema verifica l'esistenza di ScriptSync sul sistema in uso e quindi viene 
visualizzata una finestra di dialogo.

7. Fare clic su Avviare prova.

Consente accesso immediato alla finestra ScriptSync.

Per acquistare l'applicazione di montaggio Avid nel corso del 
periodo di prova di 30 giorni:

t Per acquistare l'applicazione di montaggio Avid visitare l' Avid web store: 
http://shop.avid.com/store/  
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Per acquistare l'opzione PhraseFind o ScriptSync nel corso del 
periodo di prova di 30 giorni:

1. Avviare l'applicazione di montaggio Avid, quindi aprire un progetto Avid.

2. Per ScriptSync, seguire i passaggi da 1 a 5 sotto “Per attivare ScriptSync per 
un periodo di prova di 30 giorni:” a pagina 139, quindi selezionare Script > 
ScriptSync.

3. Per PhraseFind, premere Ctrl+F o Command+F oppure selezionare Edit > 
Trova.

Viene visualizzata la finestra Trova.

4. Per PhraseFind, inserire una parola o una frase all'interno della casella di 
testo, quindi fare clic sul pulsante PhraseFind.

Il sistema provvede a tenere aggiornati gli utenti sui giorni di prova 
rimanenti prima del termine del periodo di prova. 

5. Fare clic su Acquista.

n Nel caso il pulsante Acquista non dovesse comparire, chiudere la finestra Trova e 
riavviare l'applicazione di montaggio Avid. Ripetere i passaggi descritti in 
precedenza.

Il sistema apre l'Avid web store, in modo da permettere l'acquisto di 
PhraseFind o ScriptSync. Una volta effettuato l'acquisto e ottenuto il numero 
di attivazione, è possibile procedere all'attivazione di PhraseFind o 
ScriptSync.

Si apre una finestra di dialogo che avverte che l'attivazione avrà come effetto 
la chiusura dell'applicazione di montaggio Avid e l'avvio dello strumento 
Avid License Control.
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6. Fare clic su Avanti.

Si apre lo strumento Avid License Control.

Per procedere all'attivazione, vedere “Attivazione dell'applicazione di 
montaggio Avid tramite Electronic Activation (Attivazione elettronica)” a 
pagina 119 per continuare.

Attivazione Opzioni e Funzionalità

Tramite lo strumento Avid License Control è possibile non solo attivare 
l'applicazione di montaggio Avid, ma anche un gran numero di opzioni di 
montaggio e di altre funzionalità. 

Per attivare queste funzionalità, seguire i passaggi descritti a “Attivazione 
dell'applicazione di montaggio Avid tramite Electronic Activation (Attivazione 
elettronica)” a pagina 119 oppure vedere il manuale relativo elencato di seguito.

• PhraseFind
L'opzione PhraseFind (ricerca fonetica) ricerca e individua dialoghi audio 
all'interno dei bin di un singolo progetto. PhraseFind è acquistabile 
separatamente e comprende un pacchetto gratuito di lingue a vostra scelta. 
Per ulteriori informazioni, vedere la sezione "Purchasing and Activating 
PhraseFind" (Acquisto e attivazione PhraseFind) nella Guida in linea per il 
montaggio Avid oppure nel manuale Getting Started with PhraseFind .

• ScriptSync
ScriptSync utilizza una tecnologia di classificazione di tipo fonetico per 
analizzare la porzione di audio di una clip e trovarne la corrispondenza nel 
testo dello script. L'opzione ScriptSync è acquistabile separatamente. Per 
ulteriori informazioni, vedere la sezione "Purchasing and Activating 
ScriptSync" (Acquisto e attivazione ScriptSync) nella Guida in linea per il 
montaggio Avid oppure nel manuale Getting Started with ScriptSync .
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• PhraseFind Language Pack
Sono disponibili ulteriori pacchetti lingue per PhraseFind. I pacchetti lingue 
sono acquistabili separatamente. Per ulteriori informazioni, vedere la 
sezione "Activating Additional Regional Language Packs" (Attivazione 
pacchetti lingue aggiuntivi) nella Guida in linea per il montaggio Avid 
oppure nel manuale Getting Started with PhraseFind.

• Importazione AVCHD Dolby AC-3 o link ad AMA
Questa funzionalità è utilizzata per importare o eseguire AMA link di file di 
flusso di trasporto AVCHD (.mts). Se durante la prima importazione o AMA 
link di file .mts non dovesse esserci connessione ad Internet, il sistema 
visualizza una finestra di dialogo e quindi apre lo strumento Avid License 
Control. Per attivare questa funzionalità seguire le istruzioni visualizzate. In 
caso di connessione ad Internet presente, l'attivazione avviene in automatico.

n La funzionalità AVCHD Dolby AC-3 compare solo se si utilizza questo formato. 
Solitamente quest'opzione non compare nello strumento Avid License Control.

Disattivazione dell'applicazione di montaggio Avid e delle opzioni

Per spostare l'applicazione di montaggio Avid da un computer a un altro è 
necessario disattivare l'applicazione di montaggio Avid e le varie opzioni prima di 
procedere alla loro disinstallazione.

Disattivare prima PhraseFind e ScriptSync, in seguito procedere alla 
disattivazione dell'applicazione di montaggio Avid.

n Per poter disattivare l'applicazione e le opzioni è necessario essere collegati a 
Internet.

n Non è necessario disattivare la versione prova.
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Disattivazione dell'applicazione di montaggio Avid e delle opzioni:

1. All'interno dell'applicazione di montaggio Avid, selezionare Speciale > 
Disattivazione licenze software.

2. Un messaggio avverte che l'applicazione di montaggio Avid sta per essere 
chiusa e che lo strumento Avid License Control sta per aprirsi, quindi fare 
clic su Avanti.

3. Viene visualizzata una finestra di dialogo che chiede se si desidera uscire 
dall'applicazione di montaggio Avid, fare clic su Uscire.

4. Oppure aprire lo strumento Avid License Control andando su:
(Windows) Start/Tutti i programmi/Avid/Utility/Controllo Licenze
(Macintosh) Applicazioni/Utility/Avid Utility/Controllo Licenze

Si apre lo strumento Avid License Control. 

5. Fare clic su Disattivare relativo all'applicazione di montaggio Avid e alle 
opzioni PhraseFind o ScriptSync.

Al momento della disattivazione di PhraseFind, compare un messaggio per 
informare che anche i pacchetti lingue associati a PhraseFind saranno 
disattivati. 

6. Fare clic su Sì.

Il sistema disattiva gli elementi selezionati e il pulsante visualizza la scritta 
Attivare.

7. Fare clic su Chiudi per chiudere la finestra.
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Disinstallazione dell'applicazione di montaggio Avid

Prima di installare l'applicazione di montaggio è necessario disinstallare i driver 
Digi tramite l'opzione Programmi e funzionalità all'interno del Pannello di 
controllo. Riavviare il sistema, quindi installare la nuova applicazione di 
montaggio. Se non si rimuovono i driver Digi i plug-in AudioSuite non verranno 
caricati ed è possibile ricevere il messaggio di errore "This software requires 
installation of device driver TPkd and a reboot before running" (Prima di eseguire 
il software è necessario installare driver TPkd e riavviare il sistema) oppure il 
messaggio di errore "DAE Interface NOT Available" (Interfaccia DAE NON 
disponibile). Se questi errori vengono visualizzati in un'installazione da zero su un 
sistema nuovo, installare la correzione rapida KB926255 di Windows Update per 
risolvere il problema.

Per tutte le applicazioni di montaggio Avid: accedere come utente con privilegi di 
amministratore e procedere al primo avvio dell'applicazione. Se si lavora in un 
ambiente di archiviazione condiviso, montare le aree di lavoro. In seguito, sarà 
possibile eseguire l'applicazione di montaggio Avid come utente comune.

Se si utilizzano dispositivi audio Pro Tools (ad esempio uno dei dispositivi della 
famiglia Avid Mbox o l'hardware Avid Pro Tools|HD Native) è necessario 
installare i driver del dispositivo separatamente. I driver del dispositivo audio 
Avid si trovano nella seguente directory:

• (Windows) Programmi\Avid\Utility\
AudioDriverInstallers

• (Macintosh) Applicazioni\Utility\Utility Avid\Driver 
Audio Avid
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(Windows) Per disinstallare l'applicazione di montaggio Avid, 
eseguire una delle seguenti operazioni:

1. Chiudere tutte le applicazioni attive.

2. Aprire il Pannello di controllo e selezionare Programmi e funzionalità. 
Quindi selezionare l'applicazione di montaggio e fare clic su Disinstalla.

(Macintosh) Per disinstallare l'applicazione di montaggio Avid:

1. Chiudere tutte le applicazioni attive.

2. Scegliere il percorso 
Applicazioni/Avid_Uninstaller/AvidEditingApplication.

3. Fare doppio clic sul file di disinstallazione AvidEditingApplication.

4. Seguire le istruzioni visualizzate.

Nota sull'aggiornamento firmware

Al primo avvio dell'applicazione di montaggio dopo l'installazione, potrebbe 
essere visualizzata una finestra di dialogo che richiede l'aggiornamento del 
firmware dell'hardware Avid. Eseguire l'aggiornamento. Durante il processo di 
aggiornamento, non accedere ad altre applicazioni né spostare le finestre attive. Se 
si accede a un'altra applicazione, la finestra del completamento 
dell'aggiornamento potrebbe venire nascosta. In tal caso, sarà possibile vedere che 
l'avanzamento dell'aggiornamento è al 100% ma non sarà possibile procedere in 
alcun modo. La finestra nascosta che indica il completamento dell'aggiornamento 
e richiede di arrestare il sistema non può essere portata in primo piano. In tal caso, 
è necessario arrestare (e non riavviare) il sistema e accenderlo di nuovo.
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5 Guía de instalación para aplicaciones de edición 
Avid

La información más reciente sobre tu aplicación de edición Avid está disponible 
en la versión online de este documento Léeme. Siempre debes consultar la web 
para obtener los documentos Léeme más actualizados, porque la versión online se 
actualiza cada vez que hay nueva información. Para ver estas versiones online, 
selecciona ReadMe en el menú Help de tu aplicación de edición Avid, o visita el 
Centro de Consultas en www.avid.com/es/readme.

Para poder instalar la aplicación de edición de Avid directamente desde el DVD 
de instalación de Avid, tu sistema debe admitir DVDs de doble capa. Si tu sistema 
no tiene un lector de DVDs adecuado, puedes descargar la aplicación de edición 
de Avid del Centro de Descargas de Avid en www.avid.com/support/downloads. 

Una vez que hayas instalado la aplicación, activarás el software con la 
herramienta Avid License Control. Esta herramienta también activa las opciones 
de edición. Para más información sobre las opciones de edición, consulta 
“Activación de opciones y características” en la página 176.

n Si tienes un Contrato de Soporte Avid activo, podrías tener la opción de 
actualizar tu software. Consulta las instrucciones suministradas en el Centro de 
Descargas de Avid o las que vienen con el kit de actualización para obtener más 
información.

c Si cambias la configuración del sistema (por ejemplo, sustituyendo el disco 
duro, reemplazando un adaptador de red o actualizando tu sistema 
operativo), debes desactivar antes el software de Avid. Para más información 
sobre la desactivación, consulta “Desactivación de la aplicación de edición 
Avid y opciones” en la página 177.
 

http://www.avid.com/readme
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Antes de instalar la aplicación de edición Avid

Lee los siguientes procedimientos antes de instalar esta aplicación. Se indica el 
procedimiento apropiado tanto para los clientes que actualizan la versión como 
para nuevos usuarios. Elige el procedimiento correspondiente a tu instalación:

Nuevos Usuarios
Si eres un usuario nuevo y nunca has instalado la aplicación de edición en tu 
sistema, sigue las instrucciones desde la página 149 hasta la página 161. 
Comienza con “Instalación de la aplicación de edición Avid” en la página 149.

Usuarios existentes
Si vas a actualizar desde una versión anterior, debes desinstalar esa versión antes 
de instalar y activar el nuevo software. 

n Antes de desinstalar tu aplicación, apunta tu ID de sistema. Necesitarás tu 
antiguo ID

 de sistema para activar tu nuevo software.

Sigue las instrucciones desde la página 162 hasta la página 171. Comienza con 
“Actualización de la aplicación de edición Avid” en la página 162.
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Instalación de la aplicación de edición Avid

Para todas las aplicaciones de edición Avid, inicia sesión como usuario con 
privilegios administrativos, instala la aplicación e iníciala al principio 
manteniendo esos privilegios. Si estás trabajando en un entorno de 
almacenamiento compartido, monta tus espacios de trabajo. Posteriormente 
podrás ejecutar la aplicación como un usuario normal.

n La instalación del software puede llevar algún tiempo. La instalación de las 
aplicaciones de edición individuales puede llevar de 5 a 15 minutos. La 
instalación de la suite completa puede tardar hasta 35 minutos.

(Windows) Para instalar el software de la aplicación de edición Avid:

1. Cierra todas las aplicaciones activas.

2. Inserta el DVD.

3. Haz clic para instalar la suite de edición Avid o el producto individual y 
sigue las instrucciones en pantalla.

n Si aparece el cuadro de diálogo “FilesInUse”, puedes seleccionar “Ignore and 
continue” (Omitir y continuar).

n Si recibes advertencias de acceso de usuario durante la instalación, continúa de 
todos modos.

4. Cuando se te solicite, acepta reiniciar el ordenador.

5. Pasa a la sección “Inicio de la instalación de la aplicación de edición Avid” 
en la página 150.
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(Macintosh) Para instalar el software de la aplicación de edición Avid:

1. Cierra todas las aplicaciones.

2. Inserta el DVD de la aplicación.

3. Haz doble clic en EditingApplicationName.pkg.

4. Haz clic para instalar la suite de edición Avid o el producto individual y 
sigue las instrucciones en pantalla.

5. Cuando se te solicite, acepta reiniciar el ordenador.

6. Pasa a la sección “Inicio de la instalación de la aplicación de edición Avid” 
en la página 150.

Inicio de la instalación de la aplicación de edición Avid

El proceso de instalación agrega un icono en el escritorio y un acceso a la 
aplicación en el menú de Inicio. 

Si la instalas en un ordenador portátil, puede que se abra un cuadro de diálogo con 
un mensaje sobre sistemas de gestión de energía incompatibles. Avid recomienda 
utilizar la opción de potencia “High Performance” para Windows 7 cuando 
trabajes con las aplicaciones de edición Avid. Otros sistemas de alimentación 
pueden afectar el rendimiento de las funciones de edición (por ejemplo, la captura 
y el volcado). 

Después de desinstalar el software para tu aplicación de edición Avid e iniciar la 
aplicación por primera vez, debes activar tu copia de la aplicación.
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(Windows) Para iniciar la aplicación de edición Avid, ejecuta una de 
las siguientes opciones:

t Haz clic en Inicio > Todos los programas > Avid > Aplicación de edición Avid.

t Haz doble clic en el icono de la aplicación de edición Avid del escritorio.

Se abre la ventana de Bienvenida. 

(Macintosh) Para iniciar la aplicación de edición Avid, ejecuta una de 
las siguientes opciones:

1. Haz doble clic en el icono de acceso directo de la aplicación de edición Avid 
en el Dock.

2. O selecciona Ir > Aplicaciones y haz doble clic en la carpeta de la aplicación 
de edición Avid. A continuación, haz doble clic en el archivo de la 
aplicación.
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3. Selecciona una de las opciones para activar tu software.

t Para activar utilizando la activación electrónica, selecciona “I want to 
activate my software using the Internet, another computer, or a volume 
license server” (“Quiero activar mi software utilizando Internet, otro 
ordenador o un servidor de licencias por volumen”) y haz clic en 
Continue. 
Se abre la herramienta Avid License Control. Sigue los pasos que se 
especifican en “Activación de la aplicación de edición Avid mediante 
activación electrónica” en la página 155.

t Para activar con una Hardware Key o llave, selecciona “I want to use a 
dongle to activate my software” (“Quiero utilizar una llave para activar 
mi software”), conecta tu llave autorizada y después haz clic en 
Continue.
El sistema confirma tu información. Al completarse la activación, 
aparece un mensaje informando de que tu software se ha activado 
correctamente.

t Para funcionar en modo Trial Mode (modo de prueba), selecciona “I 
want to run a fully-featured trial version of the Avid editing application 
for 30 days” (“Quiero ejecutar una versión de prueba con todas las 
características de la aplicación de edición Avid durante 30 días”) y 
después haz clic en Continue.
Tu software se ha activado con éxito.
Para obtener más información sobre el modo de prueba, consulta 
“Ejecución de la versión de prueba de 30 días” en la página 172.
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¿Qué necesito para activar mi aplicación de edición Avid?

Números de 
identificación (ID): Dónde puedes encontrarlos:

ID de activación La portada interior de esta guía.

Si hiciste tu compra en la Tienda Avid online, recibiste tu ID 
de activación en un mensaje de correo electrónico.

Si hiciste tu compra en la Tienda Avid online, inicia sesión en 

tu cuenta de la Tienda Avid en http://account.avid.com/.

ID de sistema Para un nuevo usuario, la portada interior de esta guía.
Para un usuario existente, necesitarás tu antiguo ID de 
sistema.

Si realizaste tu compra online, Avid te envió tu número de 
serie por correo electrónico.

La pantalla de inicio de la aplicación de edición Avid (Help > 
About).

La Consola de la aplicación de edición Avid (Tools > Console, 
después desplázate hasta System ID).

Si realizaste tu compra en la Tienda Avid online, puedes ver tu 
número de ID de sistema accediendo a tu cuenta de la Tienda 
Avid en http://account.avid.com/.
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Activación de la aplicación de edición Avid mediante activación 
electrónica

• Con acceso a Internet - Consulta “Activación de la aplicación de edición 
Avid mediante activación electrónica con una conexión a Internet” en la 
página 156.

• Sin acceso a Internet - Consulta “Activación de la aplicación de edición Avid 
mediante activación electrónica sin una conexión a Internet” en la 
página 160.

• A través un servidor de licencias por volumen - Consulta “Activación de la 
aplicación de adición Avid utilizando un servidor de licencias por volumen” 
en la página 161.

ID de sistema (continuación) Una vez activada, la pestaña License Profile de la herramienta 
Avid License Control muestra información sobre el sistema. 
Haz clic en copiar para copiar la información al portapapeles 
Puedes copiarla y pegarla desde el portapapeles a un correo 
electrónico o crear un archivo de texto. Esto es útil si necesitas 
guardar esta información como referencia o por si necesitas 
enviar información sobre el sistema a Avid Customer Support.

ID de dispositivo Solo se necesita si activas el software en un sistema que no 
esté conectado a Internet. Esto se te proporcionará a través de 
la herramienta Avid License Control durante la activación.

Números de 
identificación (ID): Dónde puedes encontrarlos:
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Activación de la aplicación de edición Avid mediante activación 
electrónica con una conexión a Internet

1. Con la herramienta Avid License Control abierta, haz clic en Activate al lado 
de la aplicación de edición Avid.
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Se abre lo siguiente.

2. Selecciona “I am connected to the Internet and will use this computer” 
(“Estoy conectado a Internet y voy a usar este ordenador”) y haz clic en 
Continue.
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Se abre una ventana que te permite introducir la información de sistema y 
registrar tu producto.

3. Introduce tu número de identificación del sistema en el cuadro de texto 
System ID. Para encontrar tu ID de sistema, consulta “¿Qué necesito para 
activar mi aplicación de edición Avid?” en la página 154.

4. Introduce tu número de identificación de activación del sistema en la caja de 
texto Activation ID. Para encontrar tu ID de activación, consulta “¿Qué 
necesito para activar mi aplicación de edición Avid?” en la página 154.

5. Si quieres revisar la política de privacidad de Avid, haz clic en Read Privacy 
Policy. 
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6. Ejecuta uno de estos procedimientos:

t Selecciona “Register your software” (“Registrar tu software”) y haz 
clic en Continue.

Se abre un cuadro de diálogo de registro. El registro online de Avid te 
permite recibir actualizaciones importantes e información de 
mantenimiento.

t Selecciona “Don’t register at this time” (“No registrar ahora”) y luego 
haz clic en Activate.

La herramienta Avid License Control confirma tu información de 
sistema. Al completarse la activación, aparece un mensaje informando 
de que tu software se ha activado correctamente.

n  Si no deseas registrar tu software ahora, puedes registrarte en cualquier 
momento seleccionando Special > Register en tu aplicación de edición Avid.

7. Si decides registrar el software, haz lo siguiente:

a. En el cuadro de diálogo Register, escribe tu nombre, dirección e 
información de contacto en los cuadros de texto correspondientes. Los 
asteriscos (*) indican campos obligatorios.

b. Haz clic en Next.

Se abre un cuadro de diálogo de registro.

c. Introduce el producto correspondiente y la información del cliente. 

d. Haz clic en Activate and Register (“Activar y registrar”).

8. Si la aplicación está abierta, tendrás que reiniciar para que los cambios 
surtan efecto.
Activación de la aplicación de edición Avid mediante activación electrónica con una 
conexión a Internet 
159



Activación de la aplicación de edición Avid mediante activación 
electrónica sin una conexión a Internet

1. Con la herramienta Avid License Control abierta, haz clic en Activate al lado 
de la aplicación de edición Avid.

Se abrirá la ventana de activación.

2. Selecciona “I am not connected to the Internet and will be using another 
computer that is connected to the Internet” (“No estoy conectado a Internet y 
voy a usar otro ordenador con conexión a Internet”) y haz clic en Continue.

3. Introduce tu número de identificación del sistema en el cuadro de texto 
System ID. Para encontrar tu ID de sistema, consulta “¿Qué necesito para 
activar mi aplicación de edición Avid?” en la página 154.

n El ID de dispositivo aparece en la parte inferior de la página de activación; anota 
este número para utilizarlo más tarde.

4. Introduce tu número de identificación de activación del sistema en la caja de 
texto Activation ID. Para encontrar tu ID de activación, consulta “¿Qué 
necesito para activar mi aplicación de edición Avid?” en la página 154.

5. Haz clic en Next.

6. Sigue las instrucciones de la herramienta Avid License Control y haz clic en 
Next.

7. En el ordenador que disponga de conexión a Internet, abre una ventana del 
explorador web y ve a la siguiente dirección: http://avid.com/license. 

8. Sigue las instrucciones de la página web..

La web crea un archivo license.bin. Este archivo contiene información de 
licencia necesaria para la activación de tu aplicación de edición Avid.
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9. Guarda el archivo license.bin y regresa con él al ordenador que quieres 
activar..

10. En la herramienta Avid License Control, haz clic en Browse y busca el 
archivo license.bin en el sistema; después haz clic en Open.

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente y el botón cambia a Deactivate.

n Repite los pasos previos para cada aplicación de edición u opción que tengas que 
activar.

11. Si la aplicación está abierta, deberías reiniciar el equipo para que los 
cambios surtan efecto.

Activación de la aplicación de adición Avid utilizando un servidor 
de licencias por volumen

Puedes activar y gestionar varios clientes de edición utilizando un servidor de 
licenciamiento por volumen. Para más información, consulta la guía FlexNet 
Device Manager for Avid en el Centro de Consultas. 
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Actualización de la aplicación de edición Avid

Puedes actualizar tu aplicación de edición Avid, ya sea con una licencia de 
software existente o una llave de licencia. Si actualizas desde una llave de licencia 
y estás cambiando modelos de producto, entonces tu kit de actualización incluirá 
una tarjeta de actualización de la llave, un código de actualización y un código de 
activación del software. Por favor, consulta las instrucciones en el kit de 
actualización para actualizar tu software.

Si has comprado previamente PhraseFind, PhraseFind Language Packs o 
ScriptSync, la activación de tu licencia debería actualizarse automáticamente. Si 
compras nuevas opciones, se te proporcionará un nuevo ID de activación.

n Al actualizar tu licencia de llave a una licencia de software se desactiva la llave. 
Una vez que hayas activado la licencia de software, no necesitas la llave y no la 
puedes utilizar para ejecutar la aplicación de edición Avid.

Si actualizas tu licencia actual y tienes activado un Contrato de Soporte Avid, lee 
las instrucciones que se proporcionan en el Centro de Descargas de Avid o que 
vienen con el kit de actualización antes de actualizar el sistema. Todos los clientes 
del Contrato de Soporte Avid deben utilizar el archivo Versioner.avd para 
actualizar su software como se describe en el último procedimiento sobre este 
tema. Para obtener más información, lee el tema “Software Licensing Upgrade 
Process for Support Customers” del Centro de Consultas de Avid (en inglés) 
(www.avid.com/us/support).

A continuación se muestran algunos de los pasos que deberías seguir si estás 
actualizando opciones de tu sistema de edición Avid, PhraseFind o ScriptSync.
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Actualizar el Workflow 

1. Desinstalar tu aplicación de edición Avid actual.

Consulta “Desinstalación de la aplicación de edición Avid” en la página 179.

PhraseFind y ScriptSync se desinstalan con tu aplicación de edición Avid.

n Antes de desinstalar tu aplicación, apunta tu ID de sistema. Necesitarás tu 
antiguo ID de sistema para activar tu nuevo software.

2. Instala tu nueva aplicación de edición Avid.

Consulta “Instalación de la aplicación de edición Avid” en la página 149.

PhraseFind y ScriptSync se instalan con tu aplicación de edición Avid. Si 
has comprado previamente PhraseFind, PhraseFind Language Packs o 
ScriptSync, la activación de tu licencia debería actualizarse 
automáticamente. Si compras nuevas opciones, se te proporcionará un nuevo 
ID de activación.

3. Para activar tu aplicación de edición Avid:

Dependiendo de tu configuración, consulta los siguientes pasos de 
activación. 
Para más información sobre la herramienta Avid License Control, consulta 
“Activación de la aplicación de edición Avid mediante activación 
electrónica” en la página 155.

4. Activa PhraseFind, PhraseFind Language Pack o ScriptSync.

Consulta “Activación de la aplicación de edición Avid mediante activación 
electrónica” en la página 155.
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Para actualizar tu aplicación de edición Avid con una conexión a 
Internet desde una licencia de software existente:

1. Ve a la siguiente ubicación:
- (Windows) Inicio/Todos los Programas/Avid/Utilities/License Control
- (Macintosh) Aplicaciones/Utilidades/Avid Utilities/License Control

Se abre la herramienta Avid License Control.

2. Haz clic en Activate al lado de la aplicación de edición Avid.

Se abrirá la ventana de activación.

3. Selecciona “I am connected to the Internet and will use this computer” 
(“Estoy conectado a Internet y voy a usar este ordenador”) y haz clic en 
Continue.

Se abre una ventana que te permite introducir la información de sistema y 
registrar tu producto. 

4. Si no aparece tu ID de sistema, introduce tu número de identificación de 
sistema en la caja de texto de ID de sistema. Si ya eres cliente, utiliza tu 
antiguo ID de sistema.
Para encontrar tu ID de sistema si no aparece, consulta “¿Qué necesito para 
activar mi aplicación de edición Avid?” en la página 154.

n Si tu editor previo incluía opciones compradas, como PhraseFind o ScriptSync, 
estas opciones se activarán automáticamente con tu actualización.

5. Introduce tu número de identificación de activación del sistema en la caja de 
texto Activation ID. Utiliza el número de ID de activación para tu nueva 
versión del software.
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6. Ejecuta uno de estos procedimientos:

t Si nunca has registrado tu producto, selecciona “Register your product 
with Avid Technology, Inc. now” (“Registrar tu producto con Avid 
ahora”). Si deseas consultar la política de privacidad de Avid, haz clic 
en Read Privacy Policy. A continuación, haz clic en Next.

Se abre un cuadro de diálogo de registro. El registro online de Avid te 
permite recibir actualizaciones importantes e información de 
mantenimiento.

t Selecciona “Don’t register at this time” (“No registrar ahora”) y luego 
haz clic en Activate.

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente.

n  Si no deseas registrar tu software ahora, puedes registrarte en cualquier 
momento seleccionando Special > Register en tu aplicación de edición Avid.

7. Si decides registrar el software en el paso 6, haz lo siguiente:

a. En el cuadro de diálogo Register, escribe tu nombre, dirección e 
información de contacto en los cuadros de texto correspondientes. Los 
asteriscos (*) indican campos obligatorios.

b. Haz clic en Next.

Se abre un cuadro de diálogo de registro.

c. Introduce el producto correspondiente y la información del cliente.

d. Haz clic en Activate and Register (“Activar y registrar”).

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente y el botón cambia a Deactivate.
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8. Haz clic en OK. 

Para actualizar tu aplicación de edición Avid con una conexión a 
Internet desde una licencia de llave a una licencia de software:

1. Conecta la llave a tu sistema de edición Avid.

2. Ve a la siguiente ubicación:
- (Windows) Inicio/Todos los Programas/Avid/Utilities/License Control
- (Macintosh) Aplicaciones/Utilidades/Avid Utilities/License Control

Se abre la herramienta Avid License Control.

3. Haz clic en Activate al lado de la aplicación de edición Avid.

Se abrirá el cuadro de diálogo de activación.

4. Selecciona “I am connected to the Internet and will use this computer” 
(“Estoy conectado a Internet y voy a usar este ordenador”) y haz clic en 
Continue.

Se abre una ventana que te permite introducir la información de sistema y 
registrar tu producto. 

5. Si no aparece tu ID de sistema, introduce tu número de identificación en la 
caja de texto de ID de sistema. Si ya eres cliente, utiliza tu antiguo ID de 
sistema.
Para encontrar tu ID de sistema si no aparece, consulta “¿Qué necesito para 
activar mi aplicación de edición Avid?” en la página 154.

n Si tu editor previo incluye opciones compradas, como PhraseFind o ScriptSync, 
estas opciones se activarán automáticamente con tu actualización.

6. Introduce tu número de identificación de activación del sistema en la caja de 
texto Activation ID. Para encontrar tu ID de activación, consulta “¿Qué 
necesito para activar mi aplicación de edición Avid?” en la página 154.
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7. Ejecuta uno de estos procedimientos:

t Si nunca has registrado tu producto, selecciona “Register your product 
with Avid Technology, Inc. now” (“Registrar tu producto con Avid 
ahora”). Si deseas revisar la política de privacidad de Avid, haz clic en 
Read Privacy Policy. A continuación, haz clic en Next.

Se abre un cuadro de diálogo de registro. El registro online de Avid te 
permite recibir actualizaciones importantes e información de 
mantenimiento.

t Selecciona “Don’t register at this time” (“No registrar ahora”) y luego 
haz clic en Activate.

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente.

n  Si no deseas registrar tu software ahora, puedes registrarte en cualquier 
momento seleccionando Special > Register en tu aplicación de edición Avid.

8. Si decides registrar el software en el paso 7, haz lo siguiente:

a. En el cuadro de diálogo Register, escribe tu nombre, dirección e 
información de contacto en los cuadros de texto correspondientes. Los 
asteriscos (*) indican campos obligatorios.

b. Haz clic en Next.

Se abre un cuadro de diálogo de registro.

c. Introduce el producto correspondiente y la información del cliente. 

d. Haz clic en Activate.



9. El sistema te pregunta si estás seguro de que quieres desactivar tu llave. Haz 
clic en OK.

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente.

10. Haz clic en OK.

Para actualizar tu aplicación de edición Avid sin una conexión a 
Internet a una licencia de software: 

1. Ve a la siguiente ubicación:
(Windows) Inicio/Todos los Programas/Avid/Utilities/License Control
(Macintosh) Aplicaciones/Utilidades/Avid Utilities/License Control

Se abre la herramienta Avid License Control. 

2. Haz clic en Activate al lado de la aplicación de edición Avid.

Se abrirá la ventana de activación.

3. Selecciona “I am not connected to the Internet and will be using another 
computer that is connected to the Internet” (“No estoy conectado a Internet y 
voy a usar otro ordenador con conexión a Internet”) y haz clic en Continue.

Se abre una ventana que te permite introducir la información de sistema y 
registrar tu producto. 

4. Si no aparece tu ID de sistema, introduce tu número de identificación de 
sistema en la caja de texto de ID de sistema. Si ya eres cliente, utiliza tu 
antiguo ID de sistema.
Para encontrar tu ID de sistema si no aparece, consulta “¿Qué necesito para 
activar mi aplicación de edición Avid?” en la página 154.
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n Si tu editor previo incluía opciones compradas, como PhraseFind o ScriptSync, 
estas opciones se activarán automáticamente con tu actualización.

n El ID de dispositivo aparece en la parte inferior de la página de activación; anota 
este número para utilizarlo más tarde.

5. Introduce tu número de identificación de activación del sistema en la caja de 
texto Activation ID. Para encontrar tu ID de activación, consulta “¿Qué 
necesito para activar mi aplicación de edición Avid?” en la página 154.

n Deja la herramienta Avid License Control abierta en el sistema que necesites 
activar. Necesitarás introducir información adicional.

6. Haz clic en Next.

7. Sigue las instrucciones de la herramienta Avid License Control y haz clic en 
Next.

8. En el ordenador que disponga de conexión a Internet, abre una ventana del 
explorador web y ve a la siguiente dirección: http://avid.com/license.

9. Sigue las instrucciones de la página web.

La web crea un archivo license.bin. Este archivo contiene información de 
licencia necesaria para la activación de tu aplicación de edición Avid.

10. Guarda el archivo license.bin y regresa con él al ordenador que quieres 
activar.

11. En la herramienta Avid License Control, haz clic en Browse y busca el 
archivo license.bin en el sistema; después haz clic en Open.

La herramienta de activación confirma la información del sistema. Al 
completarse la activación, aparece un mensaje informando de que tu 
software se ha activado correctamente y el botón cambia a Deactivate.
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n Repite los pasos previos para cada aplicación de edición u opción que tengas que 
activar.

12. Si la aplicación de edición está abierta, deberías reiniciar para que los 
cambios surtan efecto.

Para actualizar tu aplicación de edición Avid con una llave (dongle):

1. Asegúrate de haber conectado la llave a tu sistema de edición Avid.

2. Ve al directorio donde está instalado DongleManager.exe:

t (Windows) C:\Archivos de programa\Avid\Utilidades\DongleManager

t (Macintosh) Macintosh HD\Aplicaciones\Utilidades\Avid 
Utilities\DongleManager

3. Haz doble clic en DongleManager.exe.

Se abre la ventana Dongle Manager.

4. Haz clic en la pestaña Update (“Actualizar”).

5. Haz clic en Open y ve a la ubicación del archivo de actualización de la llave 
(.avd).

6. Selecciona el archivo de actualización y haz clic en Open.

7. Haz clic en Update.

La aplicación DongleManager.exe actualiza la llave y muestra el mensaje 
“Verification Complete” (“Verificación completada”).

8. Inicia la aplicación de edición Avid.

Se abre la ventana de Bienvenida.

9. Selecciona “I want to use a dongle to activate my software” (“Quiero utilizar 
una llave para activar mi software”).
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10. Haz clic en Continue.

El sistema confirma tu información. Al completarse la activación, aparece un 
mensaje informando de que tu software se ha activado correctamente.

Para actualizar tu aplicación de edición Avid utilizando el archivo 
Versioner.avd (solo clientes con Contrato de Soporte Avid): 

1. Descarga el archivo Versioner.avd para tu aplicación de edición.

2. Coloca el archivo Versioner.avd en la carpeta de la aplicación de edición:

(Windows) [unidad]:/Archivos de programa/Avid/[aplicación de edición 
Avid]

(Macintosh) Macintosh HD/Aplicaciones/[aplicación de edición Avid]

3. Inicia la aplicación de edición Avid.

Se abre la herramienta Avid License Control. 

4. Haz clic en Activate al lado de la aplicación de edición Avid.

5. Ejecuta uno de estos procedimientos:

t Selecciona “I am connected to the Internet and will use this computer” 
(“Estoy conectado a Internet y voy a usar este ordenador”).

t Selecciona “I am not connected to the Internet and will be using 
another computer that is connected to the Internet” (“No estoy 
conectado a Internet y voy a usar otro ordenador con conexión a 
Internet”).

6. Haz clic en Continue.

Se abrirá el cuadro de diálogo de Activación de Avid. El sistema completará 
automáticamente tu ID de sistema e ID de activación. 
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n Si utilizas una llave, el ID de sistema e ID de activación solo se completarán si 
tienes tu llave conectada.

7. Continúa con el procedimiento de actualización de la activación de la 
licencia descrito en esta sección según la opción de licencia que hayas 
seleccionado en el paso 5.

Ejecución de la versión de prueba de 30 días

Antes de comprar la aplicación de edición Avid, PhraseFind o ScriptSync, puedes 
probarla durante un periodo de 30 días. Si ejecutas la versión de prueba de 30 días 
de la aplicación de edición Avid, también obtienes 30 días de prueba de 
PhraseFind y ScriptSync. Tu versión de prueba de 30 días de PhraseFind también 
incluye acceso a todos los idiomas disponibles durante el periodo de prueba. No 
tienes que activar ningún paquete adicional de idiomas esta vez. Sin embargo, 
debes seleccionar tu idioma del menú Select a Language en la ventana 
PhraseFind.

Si ya tienes una aplicación de edición Avid, puedes ejecutar una versión de 30 
días de PhraseFind o ScriptSync.

Después de 30 días, si no compras la aplicación de edición Avid, PhraseFind o 
ScriptSync, ya no tendrás acceso al producto y la oferta. El sistema va indicando 
cuántos días te quedan antes de que acabe el periodo de prueba.

n Cualquier bin o proyecto creado durante el periodo de prueba de 30 días solo 
podrá utilizarse al activar una licencia de edición completa.
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Para utilizar tu aplicación de edición Avid durante un periodo de 
prueba de 30 días:

1. Inicia la aplicación de edición Avid.

Se abre la ventana de Bienvenida.

2. Selecciona “I want to run a fully-featured, trial version of the Avid editing 
application for 30 days” (“Quiero ejecutar una versión completa de la 
aplicación de edición Avid durante 30 días”). 

3. Haz clic en Continue.

Tu software se ha activado con éxito. En cualquier momento durante ese 
periodo de prueba de 30 días puedes decidir comprar una copia de tu 
aplicación de edición Avid. Si decides no comprar el software, la aplicación 
de edición Avid se desactiva cuando expira el periodo de prueba de 30 días.

Para activar PhraseFind durante el periodo de prueba de 30 días:

1. Abre tu aplicación de edición Avid y un proyecto Avid.

2. Pulsa Ctrl+F o Comando+F, o selecciona Edit > Find.

Se abre la ventana Find.

3. Escribe una palabra o frase en la caja de texto y después haz clic en el botón 
PhraseFind.

El sistema comprueba si tienes PhraseFind en tu sistema y después se abre el 
cuadro de diálogo.

4. Haz clic en Run Trial.

El sistema reinicia tu aplicación de edición Avid y después tendrás acceso a 
PhraseFind.
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Tu versión de prueba de 30 días de PhraseFind también incluye acceso a 
todos los idiomas disponibles durante el periodo de prueba. No tienes que 
activar ningún paquete adicional de idiomas esta vez. Sin embargo, debes 
seleccionar tu idioma del menú Select a Language en la ventana PhraseFind.

5. En la ventana PhraseFind, selecciona tu idioma del menú Select a Language 
y espera hasta que el índice de PhraseFind se vuelva de un verde vivo.

Para activar ScriptSync durante un periodo de prueba de 30 días:

1. Abre tu aplicación de edición Avid y un proyecto Avid.

2. Crea un guion: File > New Script.

3. Echa un vistazo y después haz clic en Open.

4. En el guion, haz clic en la sección donde quieres poner el clip (toma).

La sección se resalta.

5. Desde un bin, arrastra el clip a la sección seleccionada en el guion.

La caja que está debajo del clip en el guion debería resaltarse en negro. Esto 
indica que el clip está seleccionado en el guion.

6. Selecciona Script > ScriptSync.

El sistema comprueba si tienes ScriptSync en tu sistema y después se abre 
un cuadro de diálogo.

7. Haz clic en Run Trial.

Tienes acceso inmediato a la ventana ScriptSync.
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Para comprar la aplicación de edición Avid durante tu periodo de 
prueba de 30 días:

t Ve a la Tienda Avid online: (http://shop.avid.com/store/) para comprar tu 
aplicación de edición Avid.

Para comprar PhraseFind o ScriptSync durante tu periodo de prueba 
de 30 días:

1. Abre tu aplicación de edición Avid y un proyecto Avid.

2. Para ScriptSync, sigue los pasos del 1 al 5 de “Para activar ScriptSync 
durante un periodo de prueba de 30 días:” en la página 174; a continuación, 
selecciona Script > ScriptSync.

3. Pulsa Ctrl+F o Comando+F, o selecciona Edit > Find..

Se abre la ventana Find.

4. Para PhraseFind, escribe una palabra o frase en la caja de texto; después haz 
clic en el botón PhraseFind.

El sistema te indica cuántos días te quedan de tu periodo de prueba de 30 
días. 

5. Haz clic en Buy.

n Si no aparece el botón Buy, cierra la ventana Find y vuelve a iniciar tu aplicación 
de edición Avid. Repite los pasos anteriores.

El sistema abre la Tienda Avid online, que te permite adquirir PhraseFind o 
ScriptSync. Una vez que hayas comprado y adquirido tu ID de activación, 
puedes activar PhraseFind o ScriptSync.

Se abre un cuadro de diálogo que te informa de que la activación finalizará tu 
aplicación de edición Avid e iniciará la herramienta Avid License Control.
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6. Haz clic en Continue.

Se abre la herramienta Avid License Control.

Para activar, consulta “Activación de la aplicación de edición Avid mediante 
activación electrónica” en la página 155 para continuar.

Activación de opciones y características

Además de activar la aplicación de edición Avid, hay varias opciones o 
características de edición que se pueden activar a través de la herramienta Avid 
License Control Tool. 

Para activar estas característivas, sigue los pasos en “Activación de la aplicación 
de edición Avid mediante activación electrónica” en la página 155 o consulta la 
guía apropiada mencionada más abajo.

• PhraseFind
La opción PhraseFind (búsqueda fonética) busca y encuentra diálogo de 
audio en los bins de un único proyecto. PhraseFind se aquiere por separado e 
incluye un paquete de idioma a tu elección. Para más información, consulta 
“Purchasing and Activating PhraseFind” (“Compra y activación de 
PhraseFind”) en la ayuda de edición de Avid o en la guía Getting Started 
with PhraseFind.

• ScriptSync
ScriptSync utiliza tecnología de indexado fonético para analizar el 
fragmento de audio de un clip y vincularlo con las líneas del texto del guion. 
ScriptSync opción se adquiere por separado. Para más información, consulta 
“Purchasing and Activating ScriptSync” (“Compra y activación de 
PhraseFind”) en la ayuda de edición de Avid o en la guía Getting Started 
with ScriptSync.
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• Paquete de idioma PhraseFind
Se pueden comprar otros paquetes de idioma para usarse con PhraseFind. 
Los paquetes de idioma se adquieren por separado. Para más información, 
consulta “Activating Additional Regional Language Packs” (“Activación de 
paquetes adicionales de idiomas regionales”) en la ayuda de edición de Avid 
o en la guía Getting Started with PhraseFind.

• Importación de AVCHD Dolby AC-3 o vínculo a AMA
Esta característica se utiliza para importar archivos AVCHD en formato 
“flujo de transporte” (.mts) o vincularlos a AMA. Si no estás conectado a 
internet la primera vez que importas vinculas a AMA con archivos .mts, el 
sistema abre un cuadro de diálogo y después la herramienta Avid License 
Control. Sigue las instrucciones en pantalla para activar esta característica. 
Si estás conectado a Internet, la activación es automática.

n La característica AVCHD Dolby AC-3 solo aparece si utilizas este formato. 
Normalmente no verás esta opción en la herramienta Avid License Control.

Desactivación de la aplicación de edición Avid y opciones

Si tienes que mover la aplicación de edición Avid a un ordenador diferente, 
desactiva esta y las opciones antes de desinstalar la aplicación de edición Avid.

Desactiva primero PhraseFind y ScriptSync, y después desactiva la aplicación de 
edición Avid.

n Debes tener una conexión a Internet para desactivar el software y sus opciones.

n No hace falta que desactives la versión de prueba.
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Cómo desactivar la aplicación de edición Avid y las opciones:

1. Desde tu aplicación de edición Avid, selecciona Special > Deactivate 
Software License.

2. Aparece un mensaje informándote de que la aplicación de edición Avid se 
cerrará y se abrirá la herramienta Avid License Control; a continuación, haz 
clic en Continue.

3. Se abre un cuadro de diálogo donde se te pregunta si deseas dejar las 
aplicaciónes de edición Avid; haz clic en Leave.

4. O ve a la siguiente ubicación para abrir la herramienta Avid License Control:
- (Windows) Inicio/Todos los Programas/Avid/Utilities/License Control
- (Macintosh) Aplicaciones/Utilidades/Avid Utilities/License Control

Se abre la herramienta Avid License Control. 

5. Al lado de la aplicación de edición Avid, PhraseFind o ScriptSync, haz clic 
en Deactivate.

Si estás desactivando PhraseFind, aparecerá un mensaje informándote de 
que los paquetes de idioma asociados con PhraseFind también se 
desactivarán. 

6. Haz clic en Yes.

El sistema desactiva el objeto seleccionado y el botón cambia a Activate.

7. Haz clic en Quit para cerrar la ventana.
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Desinstalación de la aplicación de edición Avid

Antes de instalar la aplicación de edición, debes desinstalar los Digi Drivers 
mediante Programas y características desde el Panel de control. Reinicia el 
sistema y luego instala la nueva aplicación de edición. Si no quitas los Digi 
Drivers, los plug-ins AudioSuite no se cargan y puede que obtengas el mensaje de 
error “This software requires installation of device driver TPkd and a reboot 
before running” o “DAE Interface NOT Available”. Si ves estos errores en una 
instalación en un sistema completamente nuevo, instala el patch KB926255 de 
Windows Update para solucionar el problema.

Para todas las aplicaciones de edición Avid, inicia sesión y comienza la aplicación 
como un usuario con privilegios administrativos. Si estás trabajando en un entorno 
de almacenamiento compartido, monta tus espacios de trabajo. Posteriormente 
podrás ejecutar la aplicación de edición Avid como un usuario normal.

Si utilizas algún dispositivo de audio Pro Tools (por ejemplo, cualquier 
dispositivo de la familia Avid Mbox o el hardware Avid Pro Tools|HD Native) 
debes instalar los drivers de dispositivo por separado. Los drivers de dispositivo 
de audio de Avid se encuentran en el directorio siguiente:

• (Windows) Archivos de programa\Avid\Utilities\
AudioDriverInstallers

• (Macintosh) Aplicaciones\Utilidades\Avid Utilities\Avid 
Audio Drivers
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(Windows) Para desinstalar el software de la aplicación de edición 
Avid, realiza una de las siguientes opciones:

1. Cierra todas las aplicaciones activas.

2. Accede al Panel de Control y selecciona Programas y características. 
Después selecciona la aplicación de edición y haz clic en Uninstall.

(Macintosh) Para desinstalar el software de la aplicación de edición 
Avid:

1. Cierra todas las aplicaciones activas.

2. Ve a Aplicaciones/Avid_Uninstaller/AvidEditingApplication.

3. Haz doble clic en el desinstalador AvidEditingApplication.

4. Sigue las instrucciones en pantalla.

Nota de actualización de firmware

La primera vez que inicies tu aplicación de edición después de la instalación, es 
posible que se abra un cuadro de diálogo que pide que actualices el firmware del 
hardware Avid. Elige “Update” (Actualizar). Durante el proceso de actualización, 
no accedas a otras aplicaciones ni muevas cualquiera de las ventanas activas. El 
acceso a otra aplicación podría dar lugar a que se oculte el cuadro de diálogo de 
progreso de la actualización. Si esto sucede, verás el progreso de la actualización 
en el 100 %, pero no tendrás opción para continuar. La ventana oculta que 
establece que la actualización se ha completado y que te pide que apagues el 
sistema no se puede traer a primer plano. Si esto sucede, debes apagar (no solo 
reiniciar) el sistema y luego encenderlo otra vez.
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6 Avid編集アプリケーションのインストール・ガイド

Avid編集アプリケーションの最新情報は、オンライン版のReadMeに記載されていま
す。オンライン版は随時更新されます。最新のリリース・ノートやReadMeはオンライ
ンでご確認ください。これらのオンライン版を表示するには、ご使用のAvid編集アプリ
ケーションの［ヘルプ］メニューから［ReadMe］を選択するか、www.avid.com/readme
のナレッジベースをご覧ください。

AvidインストレーションDVDから直接Avid編集アプリケーションをインストールす
るには、ご使用のシステムがデュアル・レイヤーDVDに対応している必要があります。
ご使用のシステムにデュアル・レイヤーDVDに対応したDVDドライブがない場合は、
www.avid.com/support/downloadsのAvidダウンロード・センターからAvid編集ア
プリケーションをダウンロードできます。

Avid編集アプリケーションをインストールしたら、［Avid License Control］ツールを
使ってソフトウェアのアクティベーションを行います。［Avid License Control］ツー
ルは編集オプションのアクティベーションも行います。編集オプションについては詳し
くは、210ページの「オプションと機能のアクティベーションを行う」をご参照ください。

n 有効な Avid サポート契約にはソフトウェアをアップグレードする権利が含まれている
場合があります。詳細は、Avidダウンロード・センターが提供するアップグレードの方
法、またはアップグレード・キットに付属する情報をご参照ください。

c ハード・ドライブの交換、ネットワーク・アダプターの交換、オペレーティング・シス
テムのアップグレードなど、システムの構成を変更する場合は、まずAvidソフトウェア
のアクティベーションを解除する必要があります。アクティベーション解除について詳
しくは、211ページの「Avid編集アプリケーションとオプションのアクティベーション
を解除する」をご参照ください。
 

http://www.avid.com/readme
http://www.avid.com/support/downloads
http://www.avid.com/support/downloads


Avid編集アプリケーションをインストールする前に

編集アプリケーションをインストールする前に、以下をお読みください。これらの手順
は、アップグレードをするユーザー、または新規ユーザーを対象としています。該当す
る手順を選択してください。

新規ユーザー
システムに編集アプリケーションを初めてインストールするユーザーは、182ページか
ら195ページの指示に従ってください。182ページの「Avid編集アプリケーションをイ
ンストールする」から始めてください。

既存のユーザー
以前のバージョンの編集アプリケーションからアップグレードする場合は、新しいソフ
トウェアのインストールとアクティベーションを行う前に、以前のバージョンをアンイ
ンストールしなければなりません。　 

n Avid編集アプリケーションをアンインストールする前にシステム IDをメモしておいて
ください。新しいソフトウェアのアクティベーションを行うために旧システム ID

が必要になります。196ページから205ページの指示に従ってください。196ページの
「Avid編集アプリケーションをアップグレードする」から始めてください。

Avid編集アプリケーションをインストールする

すべてのAvid編集アプリケーションに対し、管理者権限を持つユーザーとしてログイン
してアプリケーションをインストールし、最初は管理者権限を持つユーザーとしてアプ
リケーションを起動してください。共有ストレージ環境で作業する場合は、自分の作業
環境をマウントしてください。初回以降は、普通のユーザとしてAvid編集アプリケー
ションを実行できます。

n 編集アプリケーション・ソフトウェアのインストールには時間がかかります。各編集ア
プリケーションでは、インストールに5分から15分かかることがあります。編集アプリ
ケーション・スイート全体では、インストールに最大35分かかることがあります。
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（Windows） Avid編集アプリケーション・ソフトウェアをインストールするには：

1. 開いているアプリケーションをすべて終了します。

2. 編集アプリケーションDVDを挿入します。

3.［Install the Avid Editor Suite（Avid Editor Suite のインストール）］または
［Individual Product（個別製品のインストール）］をクリックし、画面の指示に従
います。

n ［FileInUse（ファイル使用中）］ダイアログ・ボックスが表示されたら、［無視する］
（Ignore）を選択して操作を続けることができます。

n インストール中にユーザー・アクセス警告が表示されたら、［Continue Anyway］を選
択してインストールを続けてください。

4. メッセージが表示されたら、［コンピュータを再起動］（Yes, restart my computer）
を選択します。

5. 184ページの「Avid編集アプリケーションを起動する」へ進んでください。

（Macintosh） Avid編集アプリケーション・ソフトウェアをインストールするには：

1. アプリケーションをすべて終了します。

2. 編集アプリケーションDVDを挿入します。

3. EditingApplicationName.pkgをダブルクリックします。

4.［Avid Editor Suite のインストール］（Install the Avid Editor Suite）または［個
別製品のインストール］（Individual Product）をクリックし、画面の指示に従い
ます。

5. メッセージが表示されたら、［コンピュータを再起動］（Yes, restart my computer）
を選択します。

6. 184ページの「Avid編集アプリケーションを起動する」へ進んでください。
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Avid編集アプリケーションを起動する

インストレーションの処理は、デスクトップまたはDockのアイコンと、［スタート］メ
ニューのAvid編集アプリケーションへのポインターを追加します。

Avid編集アプリケーションをラップトップ・コンピューターにインストールする場合
は、互換性のない電源管理設定に関するダイアログ・ボックスが表示されることがあり
ます。Avid編集アプリケーションを使用するときは、Windows 7の［高パフォーマン
ス］電源オプションを使用することをお勧めします。他の電源設定は、編集機能（キャ
プチャやデジタルカットなど）のパフォーマンスに影響することがあります。

Avid編集アプリケーション用ソフトウェアをインストールして初めて起動するときは、
そのアプリケーションのアクティベーションを行わなければなりません。

（Windows） Avid編集アプリケーションを起動するには、以下のいずれかを行います。

t ［スタート］ > ［すべてのプログラム］ > ［Avid］ > ［Avid Editing Application］
をクリックします。

t Avid編集アプリケーションのデスクトップ・アイコンをダブルクリックします。

［ようこそ］（Welcome）ウィンドウが開きます。

（Macintosh） Avid編集アプリケーションを起動するには、以下のいずれかを行いま

す。

1. Dockにある Avid編集アプリケーションのエイリアス・アイコンをクリックしま
す。

2. または［移動］ > ［アプリケーション］を選択し、Avid編集アプリケーション・
フォルダーをダブルクリックします。次に、Avid編集アプリケーション・ファイ
ルをダブルクリックします。
184 Avid編集アプリケーションのインストール・ガイド



［ようこそ］（Welcome）ウィンドウが開きます。
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186 Avid編集アプリケーションのインストール・ガイド

3. ソフトウェアのアクティベーションを行うためのオプションの1つを選択します。

t 電子アクティベーションを使ってアクティベーションを行うには、［インター
ネット、別のコンピューター、またはボリューム ライセンス サーバーを使っ
てソフトウェアのアクティベーションを行う］（I want to activate my
software using the Internet, another computer, or a volume license
server）を選択し、［続ける］（Continue）をクリックします。
［Avid License Control］ツールが開きます。189ページの「電子アクティ
ベーションを使ってAvid編集アプリケーションのアクティベーションを行
う」と同じ手順に従ってください。

t ハードウェア・キー（ドングル）を使ってアクティベーションを行うには、
［ドングルを使ってソフトウェアのアクティベーションを行う］（I want to
use a dongle to activate my software）を選択し、［続ける］（Continue）を
クリックします。
システムが情報を確認します。アクティベーションが完了すると、ソフトウェ
アのアクティベーションが無事に行われたことを示すメッセージが表示され
ます。

t ハードウェア・キー（ドングル）を使ってアクティベーションを行うには、
［Avid編集アプリケーションの30日間フル機能試用版を実行する］（I want
to run a fully-featured trial version of the Avid editing application for
30 days）を選択し、［続ける］（Continue）をクリックします。
これでソフトウェアのアクティベーションが無事に行われます。
試用モードについて詳しくは、206ページの「30日試用版を使用する」をご
参照ください。



Avid編集アプリケーションのアクティベーションに必要なものは？

識別（ID）番号： 記載されている場所：

アクティベーション ID このガイドの内表紙。

Avidウェブ ストアから購入した場合は、AvidからEメー
ルでアクティベーション IDが送られてきます。

Avidウェブストアから購入した場合は
http://account.avid.com/のストアのアカウントへログイ
ンしてください。

システム ID 新規ユーザーの場合は、このガイドの内表紙にあります。
既存のユーザーの場合は、旧システムIDが必要になります。

オンラインで購入した場合は、AvidからEメールでシス
テム IDが送られてきます。

Avid編集アプリケーションのスプラッシュ画面（［ヘル
プ］（Help） > ［Avid編集アプリケーションについて］
（About Avid editing application））。

Avid 編集アプリケーションのコンソール（［ツール］
（Tools） > ［コンソール］（Console）、次に［システム ID］
（System ID）へスクロール）。
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Avidウェブ ストアから購入した場合は、
http://account.avid.com/のストアのアカウントへログイ
ンするとシステム IDを確認できます。

システム ID（続き） アクティベーションを行うと、［Avid License Control］
ツールの［ライセンス プロフィール］（License Profile）
タブに、ご使用のシステムに関する情報が表示されます。
［コピー］をクリックして情報をクリップボードへコピー
します。これでクリップボードからEメールへペーストし
たり、テキスト・ファイルを作成したりできます。これは、
この情報を記録として保存しておきたい場合やAvidカス
タマー サポートへ提供する必要がある場合に便利です。

デバイス ID インターネットに接続されていないシステムでソフト
ウェアをアクティベートする場合のみ必要です。これはア
クティベーションを行うときに［Avid License Control］
ツールから提供されます。

識別（ID）番号： 記載されている場所：
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電子アクティベーションを使ってAvid編集アプリケーションのアクティベーショ

ンを行う

• インターネットへアクセスする場合 - 190ページの「インターネット接続と電子ア
クティベーションを使ってAvid編集アプリケーションのアクティベーションを行
う」参照。

• インターネットへアクセスしない場合 - 194ページの「インターネットへ接続せず
に電子アクティベーションを使ってAvid編集アプリケーションのアクティベー
ションを行う」参照。

• ボリューム・ライセンス・サーバーを通して - 195ページの「ボリューム・ライセ
ンス・サーバーを使ってAvid編集アプリケーションのアクティベーションを行う」
参照。
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インターネット接続と電子アクティベーションを使ってAvid編集アプリケーショ

ンのアクティベーションを行う

1.［Avid License Control］ツールが開いた状態で、Avid編集アプリケーションの
隣の［アクティベート］（Activate）をクリックします。
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以下が開きます。

2. インターネットに接続し、電子アクティベーションを使ってアクティ
ベートを行う
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システム情報の入力とご使用の製品の登録ができるウィンドウが開きます。

3.［System ID］テキスト・ボックスにシステム ID番号を入力します。システム ID
の探し方は187ページの「Avid編集アプリケーションのアクティベーションに必
要なものは？」をご参照ください。

4.［Activation ID］テキスト・ボックスにアクティベーション ID番号を入力します。
アクティベーション IDの探し方は187ページの「Avid編集アプリケーションのア
クティベーションに必要なものは？」をご参照ください。

5. Avidのプライバシー・ポリシーを確認したい場合は、［Read Privacy Policy］を
クリックしてください。
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6. 以下のいずれかの操作を行います：

t ［ソフトウェアを登録］（Register your software）を選択し、［次へ］
（Continue）をクリックします。

登録ダイアログ・ボックスが開きます。Avidのオンライン登録をすると、アップ
デートとメンテナンスに関する重要な情報を受信することができます。

t ［ソフトウェアを登録しない］（Don’t register your software）選択し、［ア
クティベート］（Activate）をクリックします。

ご使用のシステムの情報を［Avid License Control］ツールが確認します。
アクティベーションが完了すると、ソフトウェアのアクティベーションが無
事に行われたことを示すメッセージが表示されます。

n ソフトウェアは、Avid編集アプリケーションで［スペシャル］（Special） > ［登録］（Register）
の順に選択すれば、いつでも登録することができます。

7. ソフトウェアの登録をする場合、以下の操作を行います：

a. 登録ダイアログボックスのテキスト・ボックスに、氏名、住所、連絡先をそ
れぞれ入力します。アスタリスク（*）のある箇所は、記入必須項目です。

b. ［次へ］（Next）をクリックします。

登録ダイアログ・ボックスが開きます。

c. 製品情報と顧客情報を正確に入力します。

d. ［アクティベートして登録］（Activate and Register）をクリックします。

8. Avid 編集アプリケーションが開いた場合は、変更が適用されるよう再起動してく
ださい。
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インターネットへ接続せずに電子アクティベーションを使ってAvid編集アプリ

ケーションのアクティベーションを行う

1.［Avid License Control］ツールが開いた状態で、Avid編集アプリケーションの
隣の［アクティベート］（Activate）をクリックします。

［Activation］ウィンドウが開きます。

2.［インターネットに接続していないので、インターネットに接続した他のコン
ピューターを使います］（I am not connected to the Internet and will be using
another computer that is connected to the Internet）を選択し、［続行］
（Continue）をクリックします。

3.［System ID］テキスト・ボックスにシステム ID番号を入力します。システム ID
の探し方は187ページの「Avid編集アプリケーションのアクティベーションに必
要なものは？」をご参照ください。

n デバイス IDは［Activation］ページの一番下に表示されますので、後で使うためにメモ
しておいてください。

4.［Activation ID］テキスト・ボックスにアクティベーション ID番号を入力します。
アクティベーション IDの探し方は187ページの「Avid編集アプリケーションのア
クティベーションに必要なものは？」をご参照ください。

5.［次へ］（Next）をクリックします。

6.［Avid License Control］ツールの指示に従い、［次へ］（Next）をクリックします。

7. インターネットに接続したコンピューターでウェブ・ブラウザーを開き、
http://avid.com/licenseをご覧ください。
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8. ウェブの画面上の指示に従ってください。

ウェブサイトが license.binファイルを作成します。このファイルにはAvid編集ア
プリケーションのアクティベーションに必要なライセンス情報が含まれています。

9. license.binファイルを読み出したら、アクティベートしたいコンピューターへ戻っ
てください。

10.［Avid License Control］ツールが開いた状態で、［ブラウズ］（Browse）をクリッ
クして、システムへ移動した license.binファイルを選択し、［開く］（Open）をク
リックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーションが
完了すると、ソフトウェアのアクティベーションが無事に行われたことを示すメッ
セージが表示され、ボタンが［アクティベートを解除］（Deactivate）に変わります。

n アクティベーションが必要な各編集アプリケーションまたはオプションに対して上記の
手順を繰り返します。

11. Avid 編集アプリケーションが開いた場合は、変更が適用されるよう再起動してく
ださい。

ボリューム・ライセンス・サーバーを使ってAvid編集アプリケーションのアクティ

ベーションを行う

ボリューム・ライセンス・サーバーを使うと複数の編集クライアントのアクティベーショ
ンと管理が行えます。詳しくは、ナレッジベース上の『FlexNet Device Manager for
Avid』ガイドをご参照ください。
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Avid編集アプリケーションをアップグレードする

Avid編集アプリケーションは、既存のソフトウェア・ライセンス、または、ドングル・
ライセンスのいずれからもアップグレードできます。ドングル・ライセンスからアップ
グレードする場合または製品モデルを変更する場合は、アップグレード・キットにドン
グル・アップデータ・カード、アップグレード・コード、ソフトウェア・アクティベー
ション・コードが含まれています。ソフトウェアをアップデートするには、アップグレー
ド・キットの説明をご参照ください。

以前にPhraseFind、PhraseFind Language Packs、またはScriptSyncを購入している
場合は、ライセンスのアクティベーションは自動的にアップデートされます。新しいオ
プションを購入した場合は、新しいアクティベーション IDが提供されます。

n ドングル・ライセンスをソフトウェア・ライセンスへアップグレードすると、ドングル
は無効になります。ソフトウェア・ライセンスのアクティベーションを行うと、Avid編
集アプリケーションを起動するためにドングルを使用する必要がなくなります。

既存のライセンスをアップグレードする場合で、有効なAvidサポート契約をお持ちの場
合は、システムをアップデートする前にAvidダウンロード・センターが提供する説明ま
たはアップグレード・キットに付属の説明をお読みください。すべてのAvidサポート契
約のお客様は、このトピックの最後の手順で説明する通りVersioner.avdファイルを使っ
てソフトウェアをアップグレードしなければなりません。詳細は、Avidナレッジベース
（www.avid.com/US/support）の「サポート・カスタマー用ソフトウェア・ライセンス
のアップグレード・プロセス」をご覧ください。

以下にAvid編集システム、PhraseFind、またはScriptSyncオプションをアップグレー
ドする場合の手順を示します。
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アップグレードの手順 

1. 既存のAvid編集アプリケーションをアンインストールします。

212ページの「Avid編集アプリケーションをアンインストールする」をご参照ください。

PhraseFindとScriptSyncはAvid編集アプリケーションと共にアンインストール
されます。

n Avid編集アプリケーションをアンインストールする前にシステム IDをメモしておいて
ください。新しいソフトウェアのアクティベーションを行うために旧システム IDが必要
になります。

2. 新しいAvid編集アプリケーションをインストールします。

182ページの「Avid編集アプリケーションをインストールする」をご参照ください。

PhraseFindとScriptSyncはAvid編集アプリケーションと共にインストールされ
ます。以前にPhraseFind、PhraseFind Language Packs、またはScriptSyncを
購入している場合は、ライセンスのアクティベーションは自動的にアップデートさ
れます。新しいオプションを購入した場合は、新しいアクティベーション IDが提
供されます。

3. Avid編集アプリケーションのアクティベーションを行います。

セットアップによって、以下のアップグレードの手順をご参照ください。
［Avid License Control］ツールについて詳しくは、189ページの「電子アクティ
ベーションを使ってAvid編集アプリケーションのアクティベーションを行う」を
ご参照ください。

4. PhraseFind、PhraseFind言語パック、または ScriptSyncのアクティベーション
を行います。

189ページの「電子アクティベーションを使ってAvid編集アプリケーションのア
クティベーションを行う」を参照してください。
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インターネット接続を使ってAvid編集アプリケーションを既存のソフトウェア・ライ

センスからアップグレードするには：

1. 以下の場所へ移動します。
（Windows） スタート /すべてのプログラム /Avid/Utilities/License Control
（Macintosh） アプリケーション /ユーティリティ/Avid Utilities/License Control

［Avid License Control］ツールが開きます。

2. Avid編集アプリケーションの隣の［アクティベート］（Activate）をクリックします。

［Activation］ウィンドウが開きます。

3.［インターネットに接続しており、このコンピューターを使います］（I am
connected to the Internet and will use this computer）を選択し、［続行］
（Continue）をクリックします。

システム情報の入力とご使用の製品の登録ができるウィンドウが開きます。

4. システム IDが表示されない場合は、［System ID］テキスト・ボックスにシステム
ID番号を入力します。既存のお客様は旧システム IDをご使用ください。
システム IDの探し方は187ページの「Avid編集アプリケーションのアクティベー
ションに必要なものは？」をご参照ください。

n 以前のエディタにPhraseFindやScriptSyncなどの有料オプションが含まれていた場合、
これらオプションのアクティベーションはアップグレードと共に自動的に行われます。

5.［Activation ID］テキスト・ボックスにアクティベーション ID番号を入力します。
ソフトウェアの新バージョンのアクティベーション ID番号を使用します。
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6. 以下のいずれかを行います：

t 製品の登録がまだの場合は、［製品をAvid Technology, Inc. に今すぐ登録］
(Register your product with Avid Technology, Inc. now）を選択します。Avid
のプライバシー・ポリシーを確認したい場合は、［プライバシー・ポリシーを
読む］（Read）をクリックしてください。［次へ］（Next）をクリックします。

登録ダイアログ・ボックスが開きます。Avidのオンライン登録をすると、アップ
デートとメンテナンスに関する重要な情報を受信することができます。

t ［今回は登録しない］（Don’t register at this time）選択し、［アクティベー
ト］（Activate）をクリックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーショ
ンが完了すると、ソフトウェアのアクティベーションが無事に行われたこと
を示すメッセージが表示されます。

n ソフトウェアは、Avid編集アプリケーションで［スペシャル］（Special） > ［登録］（Register）
の順に選択すれば、いつでも登録することができます。

7. 手順6でソフトウェアを登録することを選択した場合は、以下を行います。

a. 登録ダイアログボックスのテキスト・ボックスに、氏名、住所、連絡先をそ
れぞれ入力します。アスタリスク（*）のある箇所は、記入必須項目です。

b. ［次へ］（Next）をクリックします。

登録ダイアログ・ボックスが開きます。

c. 適切な製品情報と顧客情報を入力します。

d. ［アクティベートして登録］（Activate and Register）をクリックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーショ
ンが完了すると、ソフトウェアのアクティベーションが無事に行われたこと
を示すメッセージが表示され、ボタンが［アクティベートを解除］
（Deactivate）］に変わります。
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8.［OK］をクリックします。

インターネット接続を使ってAvid編集アプリケーションをドングル・ライセンスから

ソフトウェア・ライセンスにアップグレードするには：

1. ドングルをAvid編集システムへ取り付けます。

2. 以下の場所へ移動します。
（Windows） スタート /すべてのプログラム /Avid/Utilities/License Control
（Macintosh） アプリケーション /ユーティリティ/Avid Utilities/License Control

［Avid License Control］ツールが開きます。

3. Avid編集アプリケーションの隣の［アクティベート］（Activate）をクリックします。

［Activation］ダイアログボックスが開きます。

4.［インターネットに接続しており、このコンピューターを使います］（I am
connected to the Internet and will use this computer）を選択し、［続行］
（Continue）をクリックします。

システム情報の入力とご使用の製品の登録ができるウィンドウが開きます。

5. システム IDが表示されない場合は、［System ID］テキスト・ボックスにシステム
ID番号を入力します。既存のお客様は旧システム IDをご使用ください。
システム IDの探し方は187ページの「Avid編集アプリケーションのアクティベー
ションに必要なものは？」をご参照ください。

n 以前のエディタにPhraseFindやScriptSyncなどの有料オプションが含まれていた場合、
これらオプションのアクティベーションはアップグレードと共に自動的に行われます。

6.［Activation ID］テキスト・ボックスにアクティベーション ID番号を入力します。
アクティベーション IDの探し方は187ページの「Avid編集アプリケーションのア
クティベーションに必要なものは？」をご参照ください。
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Avid編集アプリケーションをアップグレードする 201

7. 以下のいずれかを行います。

t 製品の登録がまだの場合は、［製品をAvid Technology, Inc. に今すぐ登録］
(Register your product with Avid Technology, Inc. now）を選択します。
Avidのプライバシー・ポリシーを確認したい場合は、［プライバシー・ポリ
シーを読む］（Read Privacy Policy）をクリックしてください。［次へ］（Next）
をクリックします。

登録ダイアログ・ボックスが開きます。Avidのオンライン登録をすると、アップ
デートとメンテナンスに関する重要な情報を受信することができます。

t ［今回は登録しない］（Don't register at this time）選択し、［アクティベー
ト］（Activate）をクリックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーショ
ンが完了すると、ソフトウェアのアクティベーションが無事に行われたこと
を示すメッセージが表示されます。

n ソフトウェアは、Avid編集アプリケーションで［スペシャル］（Special） > ［登録］（Register）
の順に選択すれば、いつでも登録することができます。

8. 手順7でソフトウェアを登録することを選択した場合は、以下を行います。

a. 登録ダイアログボックスのテキスト・ボックスに、氏名、住所、連絡先をそ
れぞれ入力します。アスタリスク（*）のある箇所は、記入必須項目です。

b. ［次へ］（Next）をクリックします。

登録ダイアログ・ボックスが開きます。

c. 製品情報と顧客情報を正確に入力します。

d. ［アクティベート］（Activate）をクリックします。



9. ドングルを無効にしてよいか尋ねられます。［OK］をクリックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーションが
完了すると、ソフトウェアのアクティベーションが無事に行われたことを示すメッ
セージが表示されます。

10.［OK］をクリックします。

インターネット接続を使わずにAvid編集アプリケーションをソフトウェア・ライセン

スへアップグレードするには： 

1. 以下の場所へ移動します。
（Windows） スタート /すべてのプログラム /Avid/Utilities/License Control
（Macintosh） アプリケーション /ユーティリティ/Avid Utilities/License Control

［Avid License Control］ツールが開きます。

2. Avid編集アプリケーションの隣の［アクティベート］（Activate）をクリックします。

［Activation］ウィンドウが開きます。

3.［インターネットに接続していないので、インターネットに接続した他のコン
ピューターを使います］（I am not connected to the Internet and will be using
another computer that is connected to the Internet）を選択し、［続行］
（Continue）をクリックします。

システム情報の入力とご使用の製品の登録ができるウィンドウが開きます。

4. システム IDが表示されない場合は、［System ID］テキスト・ボックスにシステム
ID番号を入力します。既存のお客様は旧システム IDをご使用ください。
システム IDの探し方は187ページの「Avid編集アプリケーションのアクティベー
ションに必要なものは？」をご参照ください。

n 以前のエディタにPhraseFindやScriptSyncなどの有料オプションが含まれていた場合、
これらオプションのアクティベーションはアップグレードと共に自動的に行われます。
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Avid編集アプリケーションをアップグレードする 203

n デバイス IDは［Activation］ページの一番下に表示されますので、後で使うためにメモ
しておいてください。

5.［Activation ID］テキスト・ボックスにアクティベーション ID番号を入力します。
アクティベーション IDの探し方は187ページの「Avid編集アプリケーションのア
クティベーションに必要なものは？」をご参照ください。

n アクティベーションが必要なシステム上で［Avid License Control］ツールを開いてお
きます。後で追加情報を入力する必要があります。

6.［次へ］（Next）をクリックします。

7.［Avid License Control］ツールの指示に従い、［次へ］（Next）をクリックします。

8. インターネットに接続したコンピューターでウェブ・ブラウザーを開き、
http://avid.com/licenseをご覧ください。

9. ウェブの画面上の指示に従ってください。

ウェブサイトが license.binファイルを作成します。このファイルにはAvid編集ア
プリケーションのアクティベーションに必要なライセンス情報が含まれています。

10. license.binファイルを読み出したら、アクティベートしたいコンピューターへ戻っ
てください。

11.［Avid License Control］ツールが開いた状態で、［ブラウズ］（Browse）をクリッ
クして、システムへ移動した license.binファイルを選択し、［開く］（Open）をク
リックします。

アクティベーション・ツールがシステム情報を確認します。アクティベーションが
完了すると、ソフトウェアのアクティベーションが無事に行われたことを示すメッ
セージが表示され、ボタンが［アクティベートを解除］（Deactivate）に変わります。

n アクティベーションが必要な各編集アプリケーションまたはオプションに対して上記の
手順を繰り返します。

http://avid.com/license
http://avid.com/license


12. Avid 編集アプリケーションが開いた場合は、変更が適用されるよう再起動してく
ださい。

ドングルを使用してAvid編集アプリケーションをアップグレードするには：

1. ドングルがAvid編集システムに装着されていることを確認します。

2. DongleManager.exeがインストールされているディレクトリへ移動します。

t （Windows） Program Files\Avid\Utilities\DongleManager

t （Macintosh） Macintosh HD/アプリケーション/ユーティリティー /AvidUtilities

3. DongleManager.exeをダブルクリックします。

［Dongle Manager］ウィンドウが開きます。

4.［Update］タブをクリックします。

5.［開く］（Open）をクリックし、ドングルのアップデータ（.avd）の保存先へ移動
します。

6. アップデーター・ファイルを選択して、［開く］（Open）をクリックします。

7.［アップデート］（Update）をクリックします。

DongleManager.exeアプリケーションが、ドングルをアップデートし、確認終了
のメッセージが表示されます。

8. Avid編集アプリケーションを起動します。

［ようこそ］（Welcome）ウィンドウが開きます。

9.［ドングルを使ってソフトウェアのアクティベーションを行う］（I want to use a
dongle to activate my software）を選択します。

10.［続行］（Continue）をクリックします。

システムが情報を確認します。アクティベーションが完了すると、ソフトウェアの
アクティベーションが無事に行われたことを示すメッセージが表示されます。
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Versioner.avdファイルを使用して、Avid編集アプリケーションをアップグレードす

るには（Avidサポート契約をお持ちの方のみ）： 

1. 編集アプリケーション用のVersioner.avdファイルをダウンロードします。

2. Versioner.avdファイルを以下の編集アプリケーション・フォルダーへ入れます。

（Windows）[ドライブ ]:/Program Files/Avid/[Avid editing application]

（Macintosh）Macintosh HD/アプリケーション /[Avid editing application]

3. Avid編集アプリケーションを起動します。

［Avid License Control］ツールが開きます。

4. Avid編集アプリケーションの隣の［アクティベート］（Activate）をクリックします。

5. 以下のいずれかを行います。

t ［インターネットに接続しており、このコンピュータを使います］（I am
connected to the Internet and will use this computer）を選択します。

t ［インターネットに接続していないので、インターネットに接続した他のコン
ピューターを使います］（I am not connected to the Internet and will be
using another computer that is connected to the Internet）を選択します。

6.［続行］（Continue）をクリックします。

［Avid Activation］ダイアログボックスが開きます。システムがシステム IDとア
クティベーション IDを自動入力します。

n ドングルを使用する場合は、システムIDとアクティベーションIDはドングルが取り付け
られている場合にのみ入力されます。

7. 手順5で選択したライセンスのオプションについては、このセクションで説明した
アップグレード・ライセンスのアクティベーションの手順に従ってください。
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30日試用版を使用する

Avid編集アプリケーション、PhraseFind、またはScriptSyncは、購入する前に30日
間試用できます。Avid 編集アプリケーションの 30 日試用版を使用する場合は、
PhraseFindとScriptSyncの30日試用版も使用できます。PhraseFindの30日試用版で
は、試用期間中すべての選択可能な言語が使用できます。この時点では追加の言語パッ
クのアクティベーションを行う必要はありません。ただし、［PhraseFind］ウィンドウ
の［Select a Language］メニューから言語を選択する必要があります。

すでにAvid編集アプリケーションをお持ちの場合は、PhraseFindまたはScriptSyncの
30日試用版を使用できます。

30日後、Avid編集アプリケーション、PhraseFind、またはScriptSyncを購入しなかっ
た場合は以後その製品と機能は使えません。試用期間が終了するまでにあと何日使える
かはシステムがお知らせします。

n 30日の試用期間中に作成したビンまたはプロジェクトはフル・ライセンスを得た場合に
のみ使用できます。

Avid編集アプリケーションを30日間試用するには：

1. Avid編集アプリケーションを起動します。

［ようこそ］（Welcome）ウィンドウが開きます。

2.［フル機能の試用版のAvid編集アプリケーションを30日間試用する］（I want to
run a fully-featured, trial version of the Avid editing application for 30days）
を選択します。

3.［続行］（Continue）をクリックします。

これでソフトウェアのアクティベーションが無事に行われます。30日の試用期間
中は、いつでもAvid編集アプリケーションを購入できます。ソフトウェアを購入
しない場合は、30日間の試用期間が終了すると同時に、Avid編集アプリケーショ
ンのアクティベーションは解除されます。
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PhraseFindの30日試用版を使用するには：

1. Avid 編集アプリケーションを起動し、Avidプロジェクトを開きます。

2. Ctrl+FまたはCommand+Fを押すか、［編集］（Edit） > ［検索］（Find）を選択
します。

［検索］（Find）ウィンドウが表示されます。

3. テキスト ボックスに単語またはフレーズをタイプし、［PhraseFind］ボタンをク
リックします。

システムがPhraseFindがあるかどうかをチェックし、ダイアログ・ボックスを表
示します。

4.［試用版を使用］（Run Trial）をクリックします。

システムがAvid編集アプリケーションを再起動し、PhraseFindが使えるようにな
ります。

PhraseFindの30日試用版では、試用期間中すべての選択可能な言語が使用できま
す。この時点では追加の言語パックのアクティベーションを行う必要はありませ
ん。ただし、［PhraseFind］ウィンドウの［Select a Language］メニューから言
語を選択する必要があります。

5.［PhraseFind］ウィンドウで、［Select a Language］メニューから言語を選択し、
［PhraseFind Index］が緑色になるのを待ちます。
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ScriptSyncの30日試用版を使用するには：

1. Avid 編集アプリケーションを起動し、Avidプロジェクトを開きます。

2. スクリプトを作成し、［ファイル］（File） > ［新規スクリプト］（New Script）を
選択します。

3. スクリプトを選択し、［開く］（Open）をクリックします。

4. スクリプト内で、クリップ（テイク）を配置するセクションをクリックします。

そのセクションがハイライトされます。

5. スクリプト内で選択したセクションへビンからクリップをドラッグします。

スクリプト内のクリップの下のボックスが黒くハイライトされます。これはスクリ
プト内でクリップが選択されたことを示しています。

6.［スクリプト］（Script） > ［ScriptSync］を選択します。

システムがScriptSyncがあるかどうかをチェックし、ダイアログ・ボックスを表
示します。

7.［試用版を使用］（Run Trial）をクリックします。

［ScriptSync］ウィンドウへアクセスできるようになります。

30日の試用期間中にAvid編集アプリケーションを購入するには：

t Avid編集アプリケーションはAvidウェブ ストア（http://shop.avid.com/store/）
でご購入ください。
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30日の試用期間中にPhraseFindまたはScriptSyncを購入するには：

1. Avid 編集アプリケーションを起動し、Avidプロジェクトを開きます。

2. ScriptSyncの場合は、208ページの「ScriptSyncの30日試用版を使用するには：」
の手順1から5に従い、次に［スクリプト］（Script） > ［ScriptSync］を選択します。

3. PhraseFind Ctrl+FまたはCommand+Fを押すか、［編集］（Edit） > ［検索］（Find）
を選択します。

［検索］（Find）ウィンドウが表示されます。

4. PhraseFindの場合は、テキスト ボックスに単語またはフレーズをタイプし、
［PhraseFind］ボタンをクリックします。

システムが30日試用版の残りの日数を示します。

5.［購入］（Buy）をクリックします。

n ［購入］（Buy）ボタンが表示されない場合は、［検索］（Find）ウィンドウを閉じ、Avid
編集アプリケーションを再起動してください。上記の手順を繰り返します。

システムがAvid ウェブ ストアを開き、PhraseFindまたはScriptSyncが購入でき
ます。製品を購入してアクティベーション IDを取得すると、PhraseFindまたは
ScriptSyncのアクティベーションが行えます。

アクティベーションがAvid編集アプリケーションを終了して［Avid License
Control ］ツールを起動することを示すダイアログ・ボックスが表示されます。

6.［続行］（Continue）をクリックします。

［Avid License Control］ツールが開きます。

アクティベーションを行うには189ページの「電子アクティベーションを使って
Avid編集アプリケーションのアクティベーションを行う」を参照して続けてくだ
さい。 
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オプションと機能のアクティベーションを行う

Avid編集アプリケーションのアクティベーションに加えて、［Avid License Control］
ツールでアクティベーションが行えるオプションと機能があります。

これらの機能のアクティベーションを行うには、189ページの「電子アクティベーショ
ンを使ってAvid編集アプリケーションのアクティベーションを行う」の手順に従うか、
以下の適切なガイドをご参照ください。

• PhraseFind
PhraseFindオプション（音声検索）は、単一のプロジェクト内の複数のビンから音
声ダイアログを検索します。PhraseFindは別売で、無料の言語パックが選べます。
詳しくは、Avid編集アプリケーションの［ヘルプ］の『PhraseFindの購入とアク
ティベーション』または『PhraseFindスタートアップ』ガイドをご参照ください。

• ScriptSync
ScriptSyncは音声インデックス技術を使ってクリップのオーディオ部分を分析
し、スクリプト・テキストのダイアログと一致させます。ScriptSyncは別売です。
詳しくは、Avid編集アプリケーションの［ヘルプ］の『ScriptSyncの購入とアク
ティベーション』または『ScriptSyncスタートアップ』ガイドをご参照ください。

• PhraseFind言語パック
PhraseFindで使用する追加の言語パックが購入できます。言語パックは別売です。
詳しくは、Avid編集アプリケーションの［ヘルプ］の『追加の地域言語パックのア
クティベーション』または『PhraseFindスタートアップ』ガイドをご参照ください。

• AVCHD Dolby AC-3のインポートまたはAMAへのリンク
この機能はAVCHDトランスポート・ストリーム（.mts）ファイルのインポート
またはAMAへのリンクに使います。初めて .mtsファイルをインポートまたは
AMAへリンクするときにインターネットへ接続していない場合はダイアログ・
ボックスが表示され、［Avid License Control］ツールが開きます。この機能のア
クティベーションを行うには、画面の指示に従ってください。インターネットへ接
続している場合は、アクティベーションは自動的に行われます。
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n AVCHD Dolby AC-3機能は、このフォーマットを使用している場合にのみ表示されま
す。このオプションは、通常は［Avid License Control］ツールには表示されません。

Avid編集アプリケーションとオプションのアクティベーションを解除する

Avid編集アプリケーションを別のコンピューターへ移動する必要がある場合は、Avid
編集アプリケーションをアンインストールする前にAvid編集アプリケーションとオプ
ションのアクティベーションを解除してください。

まずPhraseFindとScriptSyncのアクティベーションを解除し、次にAvid編集アプリ
ケーションのアクティベーションを解除します。

n ソフトウェアとそのオプションのアクティベーションを解除するにはインターネット接
続が必要です。

n 試用版のアクティベーションを解除する必要はありません。

Avid編集アプリケーションとオプションのアクティベーションを解除するには：

1. Avid編集アプリケーションで、［スペシャル］（Special） > ［ソフトウェアライセ
ンスのアクティベーションを解除］（Deactivate Software License）を選択します。

2. Avid編集アプリケーションが終了して［Avid License Control］ツールが開くこ
とを示すメッセージが表示されます。［続行］（Continue）をクリックしてください。

3. Avid 編集アプリケーションを終了してもよいかを尋ねるダイアログ・ボックスが
開きますので、［終了］（Leave）をクリックします。

4. または以下の場所へ移動して［Avid License Control］ツールを開きます。
（Windows） スタート /すべてのプログラム /Avid/Utilities/License Control
（Macintosh） アプリケーション /ユーティリティ/Avid Utilities/License Control

［Avid License Control］ツールが開きます。
Avid編集アプリケーションとオプションのアクティベーションを解除する 211



5. Avid編集アプリケーション、PhraseFind、または ScriptSyncの隣の［アクティ
ベーション解除］（Deactivate）をクリックします。

PhraseFindのアクティベーションを解除する場合は、PhraseFindに関連する言語
パックのアクティベーションも解除されることを示すメッセージが表示されます。

6.［Yes］をクリックします。

システムが選択された項目のアクティベーションを解除し、ボタンが［アクティ
ベーション解除］（Deactivate）に変わります。

7.［Quit］をクリックしてウィンドウを閉じます。

Avid編集アプリケーションをアンインストールする

編集アプリケーションをインストールする前に、コントロールパネルの［プログラムと
機能］を使用してDigi Driversをアンインストールする必要があります。 システムを再
起動した後に、新しい編集アプリケーションをインストールします。Digi Driversを削
除しないと、AudioSuiteプラグインはロードされず、「このソフトウェアを実行する前
に、デバイス・ドライバー TPkdをインストールして再起動する必要があります」また
は「DAEインターフェイスが使用できません」というエラーメッセージが表示されるこ
とがあります。新しいシステムでのクリーン・インストールで、これらのエラーが表示
される場合は、Windows Updateから修正プログラムKB926255をインストールして
ください。

すべてのAvid編集アプリケーションに対して、最初は管理者権限を持つユーザーとして
ログインして起動してください。共有ストレージ環境で作業する場合は、自分の作業環
境をマウントしてください。初回以降は、普通のユーザとして Avid 編集アプリケーショ
ンを実行できます。
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Pro Toolsオーディオ・デバイス（デバイスのAvid MboxファミリーやAvid Pro
Tools|HD Nativeハードウェア等）を使用する場合は、デバイス・ドライバーを別途、
インストールする必要があります。Avidオーディオ・デバイス・ドライバーは、以下の
ディレクトリにあります。

• （Windows） Program Files\Avid\Utilities\ 
AudioDriverInstallers

• （Macintosh)アプリケーション\ユーティリティー\Avid Utilities\Avid 
Audio Drivers

（Windows）Avid編集アプリケーション・ソフトウェアをアンインストールするには、

以下のいずれかを行います。

1. 開いているアプリケーションをすべて終了します。

2.［スタート］ > ［コントロールパネル］ > ［プログラムと機能］を選択します。次に
編集アプリケーションを選択して［アンインストール］をクリックします。

（Macintosh）Avid編集アプリケーション・ソフトウェアをアンインストールするには：

1. 開いているアプリケーションをすべて終了します。

2. アプリケーション /Avid_Uninstaller/AvidEditingApplicationへ移動します。

3. AvidEditingApplicationアンインストーラーをダブルクリックします。

4. 画面のメッセージに従います。　
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ファームウェア・アップデートに関する注意

インストール後、初めて編集アプリケーションを起動すると、Avidハードウェア・ファー
ムウェアのアップデートを求めるダイアログ・ボックスが表示されることがあります。
［アップデート］を選択してください。更新プロセス中は、他のアプリケーションにアク
セスしたり、アクティブなウィンドウ間を移動したりしてはいけません。別のアプリケー
ションにアクセスすると、アップデートの完了ダイアログ・ボックスが背面に位置され
てしまいます。そうなると、アップデートの進捗が100%でも、続行オプションを選択
できません。アップデートの完了を知らせるウィンドウには、システムのシャットダウ
ンを求めるメッセージが表示されますが、このウィンドウは背面にあり、前面にもって
くることはできません。こうした事態が起こった場合には、システムを再起動するので
はなく、シャットダウンした上で、再び電源を入れ起動してください。
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7 Avid 편집 어플리케이션 설치 가이드

Avid 편집 어플리케이션에 대한 최신 정보는 온라인 버전의 참고 자료로 제공됩니다. 새
로운 정보가 발생할 때 마다 온라인 버전이 업데이트되기 때문에 최신 릴리스 노트 또는
참고 자료를 항상 온라인으로 확인해야 합니다. Avid 편집 어플리케이션 도움말 메뉴의
참고 자료를 선택하거나 www.avid.com/readme에서 지식 검색을 방문하여 온라인 버전
을 확인할 수 있습니다.

Avid 편집 어플리케이션을 Avid 설치 DVD로 직접 설치하려면 시스템이 듀얼-레이어
DVD를 지원해야 합니다. 시스템에 듀얼-레이어 DVD를 지원하는 DVD 드라이브가 장
착되어 있지 않은 경우 www.avid.com/support/downloads의 Avid 다운로드 센터에서
Avid 편집 어플리케이션를 다운로드할 수 있습니다. 

Avid 편집 어플리케이션을 설치한 후 Avid License Control 도구로 소프트웨어를 활성
화 시킵니다. Avid License Control 도구 또한 편집 옵션을 활성화 시킵니다. 편집 옵션
에 대한 자세한 내용은 241페이지의 “옵션 및 주요 기능 활성화하기”를 참조 바랍니다.

n Avid 고객 지원 계약이 유효한 경우 소프트웨어 업그레이드를 위한 옵션이 포함되어 있
을 수 있습니다. 업그레이드에 관한 자세한 내용은 Avid 다운로드 센터 또는 업그레이드
키트와 함께 제공되는 안내서를 참조하시기 바랍니다.

c 하드 드라이브 또는 네트워크 어댑터를 교체하거나 운영 체제를 업그레이드하는 등의 방
식으로 시스템 구성을 변경한 경우에는 반드시 먼저 Avid 소프트웨어를 비활성화해야 합
니다. 비활성화에 대한 자세한 내용은 242페이지의 “Avid 편집 어플리케이션 및 옵션 비
활성화하기”를 참조 바랍니다.
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Avid 편집 어플리케이션 설치 전 유의사항

편집 어플리케이션을 설치하기 전에 다음의 절차를 읽고 숙지하십시오. 본 절차는 업그레
이드 고객 및 신규 사용자를 위해 제공됩니다. 설치를 위해 적절한 절차를 선택하십시오:

신규 사용자의 경우
신규 사용자로 이전에 시스템에 편집 어플리케이션을 설치해 본 적이 없는 경우에는 페이
지 216 ~ 페이지 228에 나오는 지시사항를 따릅니다. 216페이지의 “Avid 편집 어플리케
이션 설치하기”에서 시작하십시오.

기존 사용자의 경우
기존의 편집 어플리케이션을 업그레이드하는 경우에는 이전 버전의 소프트웨어를 먼저
제거한 후 새로운 소프트웨어를 설치하고 활성화 시킵니다. 

n Avid 편집 어플리케이션을 제거하기 전에 시스템 ID를 별도로 보관합니다. 새 소프트웨
어를 활성화하려면 기존의 시스템 ID

가 필요합니다.페이지 228에서 페이지 236까지의 지침을 따릅니다. 228페이지의 “Avid
편집 어플리케이션 업그레이드하기”에서 시작하십시오.

Avid 편집 어플리케이션 설치하기

모든 Avid 편집 어플리케이션에서 먼저 관리자 권한이 있는 사용자로 로그인하고 어플리
케이션을 설치한 다음 관리자 권한이 있는 사용자로서 어플리케이션을 처음 시작합니다.
공유 스토리지 환경에서 작업할 경우에는 작업 공간을 마운트하십시오. 그 후 정규 사용
자로 Avid 편집 어플리케이션을 실행할 수 있습니다.

n 편집 어플리케이션의 설치 시 약간의 시간이 소요될 수 있습니다. 개별 편집 어플리케이
션의 경우 설치에 5~15분 정도가 소요될 수 있습니다. 전체 편집 어플리케이션의 경우 설
치에 최고 35분까지 소요될 수 있습니다.
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(Windows) Avid 편집 어플리케이션 소프트웨어를 설치하는 방법:

1. 모든 활성 어플리케이션을 종료합니다.

2. 편집 어플리케이션 DVD를 삽입합니다.

3. Avid 편집 제품군 또는 개별 제품을 클릭하여 설치하고 화면상의 지시를 따릅니다.

n FilesInUse 대화 상자가 표시될 경우에는 무시를 선택하고 계속할 수 있습니다.

n 설치 도중 사용자 액세스 경고 메시지가 나타나면 "계속"을 선택하여 설치를 계속합니다.

4. 메시지가 표시될 경우에는 "예, 지금 시스템을 재시작합니다"를 선택합니다. 

5.  218페이지의 “Avid 편집 어플리케이션 시작하기”으로 계속하십시오.

(Macintosh) Avid 편집 어플리케이션 소프트웨어를 설치하는 방법:

1. 모든 어플리케이션을 종료합니다.

2. 편집 어플리케이션 DVD를 삽입합니다.

3.  EditingApplicationName.pkg을 더블-클릭합니다.

4. Avid 편집 제품군 또는 개별 제품을 클릭하여 설치하고 화면상의 지시를 따릅니다.

5. 메시지가 표시될 경우에는 "예, 지금 시스템을 재시작합니다"를 선택합니다. 

6.  218페이지의 “Avid 편집 어플리케이션 시작하기”으로 계속하십시오.
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Avid 편집 어플리케이션 시작하기

설치 과정 중 데스크톱 또는 Dock 아이콘과 포인터가 시작 메뉴의 Avid 편집 어플리케이
션으로 추가됩니다. 

Avid 편집 어플리케이션을 노트북에 설치할 경우에는 호환되지 않는 전원 관리 체계에
관한 메시지를 담은 대화 상자가 나타납니다. Avid는 Avid 편집 어플리케이션으로 작업
시 Windows 7의 "고성능" 전원 옵션 사용을 권장합니다. 다른 전원 옵션의 사용은 편집
기능(예를 들어 캡처 및 디지털 컷)의 성능에 영향을 미칠 수 있습니다. 

Avid 편집 어플리케이션에 소프트웨어를 처음 설치하고 어플리케이션을 시작한 후 반드
시 어플리케이션 사본을 활성화합니다.

(Windows) Avid 편집 어플리케이션을 시작하려면 다음 중 하나를 수행합니다:

t 시작 > 전체 프로그램 > Avid > Avid 편집 어플리케이션을 클릭합니다.

t Avid 편집 어플리케이션의 데스크탑 아이콘을 더블-클릭합니다.

환영인사 창이 열립니다. 

(Macintosh) Avid 편집 어플리케이션을 시작하려면 다음 중 하나를 수행합니다:

1. Dock에서 Avid 편집 어플리케이션을 위한 앨리어스 아이콘을 더블-클릭합니다.

2. 또는 이동 > 어플리케이션을 선택한 다음 Avid 편집 어플리케이션 폴더를 더블-클
릭합니다. Avid 편집 어플리케이션 파일을 더블-클릭합니다.
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환영인사 창이 열립니다.
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3. 소프트웨어를 활성화하려면 옵션 중 하나를 선택합니다.

t 전자 활성화 방식으로 활성화하려면 “'I want to activate my software using
the internet, other computer, or a volume license server”를 선택한 다음
계속을 클릭합니다. 
Avid License Control 도구가 열립니다. 222페이지의 “전자 활성화를 통해
Avid 편집 어플리케이션 활성화하기” 단계를 따릅니다.

t 하드웨어 키 또는 동글로 활성화하려면 “I want to use a dongle to activate
my software”를 선택하고 유효한 동글을 연결한 다음 계속을 클릭합니다.
시스템이 정보를 확인합니다. 활성화가 완료되면 소프트웨어가 성공적으로
활성화되었다는 메시지가 나타납니다. 

t 평가판 모드로 실행하려면 “'I want to run a fully-featured trial version of
the Avid editing application for 30 days”를 선택한 다음 계속을 클릭합니다.
소프트웨어가 성공적으로 활성화되었습니다.
평가판 모드에 관한 자세한 내용은 237페이지의 “30일 평가판 실행하기”를 참
조하시기 바랍니다.



Avid 편집 어플리케이션 활성화에 필요한 요소

ID 번호: 검색 가능 경로:

활성화 ID 본 가이드의 내부 표지.

Avid 웹 스토어에서 구매했다면 Avid 이메일로 활성화 ID를 수
신하게 됩니다.

Avid 웹 스토어에서 구매했다면 다음에서 스토어 계정에 로그
인합니다:http://account.avid.com/.

시스템 ID 신규 사용자의 경우에는 본 가이드의 내부 표지에서 찾을 수 있
습니다.
기존 사용자의 경우에는 기존의 시스템 ID가 필요합니다.

온라인으로 구입한 경우에는 시스템 ID가 Avid로부터 이메일
로 전송됩니다. 

Avid 편집 어플리케이션 스플래쉬 스크린 (도움말 > Avid 편집
어플리케이션 정보).

Avid 편집 어플리케이션 콘솔 (도구 > 콘솔 선택 후 시스템 ID
로 스크롤).

Avid 웹 스토어에서 구입하셨다면 다음에서 스토어 계정에 로
그인하여 시스템 ID 번호를 확인할 수 있습니다: 
http://account.avid.com/.
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전자 활성화를 통해 Avid 편집 어플리케이션 활성화하기

• 인터넷 연결이 가능한 경우 223페이지의 “인터넷 연결 상태에서 전자 활성화 방식
으로 Avid 편집 어플리케이션 활성화하기”를 참조 바랍니다.

• 인터넷 연결이 불가능한 경우 227페이지의 “인터넷 연결 없이 전자 활성화 방식으
로 Avid 편집 어플리케이션 활성화하기”를 참조 바랍니다.

• 볼륨 라이센스 서버를 사용하는 경우 228페이지의 “볼륨 라이센스 서버를 사용하
여 Avid 편집 어플리케이션 활성화하기”를 참조 바랍니다.

시스템 ID (계속) 활성화된 후에는 Avid License Control 도구의 정보에
서 시스템에 관한 정보를 확인할 수 있습니다. 클립보드로
정보를 복사하려면 복사를 클릭합니다. 그 후 클립보드에서 이
메일로 잘라 붙이거나 텍스트 파일을 생성합니다. 추후 사용을
위해 해당 정보를 저장하거나 시스템 정보를 Avid 고객 지원 센
터로 전송해야 할 경우 유용합니다.

장치 ID 인터넷에 연결되지 않은 시스템에서 소프트웨어를 활성
화할 경우에만 요구됩니다. 활성화 도중에 Avid License
Control 도구를 통해 제공됩니다.

ID 번호: 검색 가능 경로:
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인터넷 연결 상태에서 전자 활성화 방식으로 Avid 편집 어플리케이션 활성화하기

1. Avid License Control 도구가 열려 있는 상태에서 Avid 편집 어플리케이션 옆에
있는 Activate를 클릭합니다.
인터넷 연결 상태에서 전자 활성화 방식으로 Avid 편집 어플리케이션 활성화하기 223



다음이 열립니다.

2. “I am connected to the Internet and will use this computer”를 선택한
후 Continue를 클릭합니다.
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창이 열리면 시스템 정보를 입력하고 제품을 등록할 수 있습니다.

3. 시스템 ID 텍스트 상자에 시스템 ID 번호를 입력합니다. 시스템 ID 검색은 221페
이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.

4. 활성화 ID 텍스트 상자에 활성화 ID 번호를 입력합니다. 활성화 ID 검색은 221페
이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.

5. Avid의 개인 정보 보호 정책을 확인하려면 Read Privacy Policy를 클릭하십시오. 
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6. 다음 중 하나를 수행합니다:

t "Register your software"를 선택한 후 Consinue를 클릭합니다.

등록 대화 상자가 열립니다. Avid 온라인 등록으로 주요 업데이트 및 유지보
수 정보를 받아 볼 수 있습니다.

t “Don't Register your software”를 선택한 다음 활성화를 클릭합니다.

Avid License Control 도구가 시스템 정보를 확인합니다. 활성화가 완료되면
소프트웨어가 성공적으로 활성화되었다는 메시지가 표시됩니다.

n  소프트웨어를 지금 등록하지 않아도 Avid 편집 어플리케이션의 Special> Register를 선
택함으로써 언제든지 등록할 수 있습니다.

7. 소프트웨어 등록을 위해서는 다음을 수행합니다:

a. Register 대화 상자에서 해당 텍스트 상자에 이름과 주소 및 연락처 정보를 입
력합니다. 별표(*)는 필수 입력 필드를 나타냅니다.

b. 다음을 클릭합니다.

등록 대화 상자가 열립니다.

c. 해당 제품 및 고객 정보를 입력합니다. 

d. Activate and Register을 클릭합니다.

8. Avid 편집 어플리케이션이 열린 상태에서 변경 사항을 적용하려면 시스템을 재시
작해야 합니다. 
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인터넷 연결 없이 전자 활성화 방식으로 Avid 편집 어플리케이션 활성화하기

1. Avid License Control 도구가 열려 있는 상태에서 Avid 편집 어플리케이션 옆에
있는 Activate를 클릭합니다.

활성화 창이 열립니다.

2. “I am not connected to the Internet and will be using another computer that
is connected to the Internet”을 선택한 후 Continue를 클릭합니다.

3. 시스템 ID 텍스트 상자에 시스템 ID 번호를 입력합니다. 시스템 ID 검색은 221페
이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.

n 장치 ID가 활성화 페이지의 하단에 표시되면 추후에 사용할 수 있도록 별도로 보관합니다. 

4. 활성화 ID 텍스트 상자에 활성화 ID 번호를 입력합니다. 활성화 ID 검색은 221페
이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.

5. Next를 클릭합니다.

6. Avid License Control 도구의 지침을 수행한 후 Next를 클릭합니다.

7. 인터넷이 연결된 컴퓨터에서는 웹 브라우저에서 http://avid.com/license를 탐색합
니다.

8. 웹 페이지의 화면에 안내되는 지침을 수행합니다. 

웹사이트가 license.bin 파일을 생성합니다 해당 파일에는 Avid 편집 어플리케이션
을 활성화하는데 필요한 라이센스 정보가 포함되어 있습니다.

9. license.bin 파일을 복원한 후 활성화를 원하는 컴퓨터로 돌아갑니다.

10. Avid License Control 도구에서 Browse를 클릭한 후 시스템의 license.bin 파일
로 이동하여 Open을 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료되면 소프트웨어가 성공적
으로 활성화되었다는 메시지가 표시되고 버튼이 Deactivate로 변경됩니다.
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n 활성화에 필요한 각 편집 어플리케이션 또는 옵션의 이전 단계를 반복합니다.

11. Avid 편집 어플리케이션이 열린 상태에서 변경 사항을 적용하려면 시스템을 재시
작해야 합니다. 

볼륨 라이센스 서버를 사용하여 Avid 편집 어플리케이션 활성화하기

볼륨 라이센스 서버를 사용하여 다수의 편집 클라이언트를 활성화하고 관리할 수 있습니
다. 자세한 내용은 지식 검색의 FlexNet Device Manager for Avid 가이드를 참조하시기
바랍니다. 

Avid 편집 어플리케이션 업그레이드하기

Avid 편집 어플리케이션을 기존의 소프트웨어 라이센스 또는 동글 라이센스에서 업그레
이드할 수 있습니다. 동글 라이센스에서 업그레이드하거나 제품 모델을 변경할 경우에는
사용자의 업그레이드 키트에 동글 업데이터 카드, 업그레이드 코드 및 소프트웨어 활성화
코드가 포함되어 있습니다. 업그레이드 키트에 있는 지침을 참조하여 소프트웨어를 업데
이트하십시오.

이전에 PhraseFind, PhraseFind Language Packs 또는 ScriptSync를 구입했다면 라이
센스 활성화로 자동 업데이트 됩니다. 새로운 옵션을 구입하면 새로운 활성화 ID가 제공
됩니다.

n 동글 라이센스를 소프트웨어 라이센스로 업그레이드하면 동글이 비활성화됩니다. 한 번
소프트웨어 라이센스를 활성화하면 Avid 편집 어플리케이션의 실행을 위해 동글이 필요
하지 않으며 더이상 사용할 수 없습니다. 

기존의 라이센스를 업그레이드하거나 Avid 고객 지원 계약이 유효한 경우에는 시스템 업
데이트에 앞서 Avid 다운로드 센터에서 제공되거나 업그레이드 키트에 포함된 안내서를
읽어주시기 바랍니다. 모든 Avid 고객 지원 계약 고객은 Versioner.avd 파일을 사용해서
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본 주제의 마지막 절차에 설명된 내용대로 소프트웨어를 업그레이드해야 합니다. 자세한
내용은 Avid 지식 검색에서 “고객 지원 고객을 위한 소프트웨어 라이센스 업그레이드 절
차”를 확인하십시오 (www.avid.com/ko/support).

아래는 Avid 편집 시스템, PhraseFind 또는 ScriptSync 옵션을 업그레이드하는 경우에
따라야 할 단계입니다.

워크플로우 업그레이드 

1. 기존 Avid 편집 어플리케이션을 제거합니다. 

 243페이지의 “Avid 편집 어플리케이션 제거하기”를 참조 바랍니다.

PhraseFind과 ScriptSync는 Avid 편집 어플리케이션과 함께 제거됩니다.

n Avid 편집 어플리케이션을 제거하기 전에 시스템 ID를 별도로 보관합니다. 새 소프트웨
어를 활성화하려면 기존 시스템 ID가 필요합니다.

2. 새로운 Avid 편집 어플리케이션을 설치합니다.

 216페이지의 “Avid 편집 어플리케이션 설치하기”를 참조 바랍니다.

PhraseFind과 ScriptSync가 Avid 편집 어플리케이션과 함께 설치됩니다. 이전에
PhraseFind, PhraseFind Language Packs 또는 ScriptSync를 구입했다면 라이
센스 활성화로 자동 업데이트 됩니다. 새로운 옵션을 구입하면 새로운 활성화 ID가
제공됩니다.

3. Avid 편집 어플리케이션을 활성화합니다.

설정에 따라 다음의 업그레이드 단계를 참조 바랍니다. 
Avid License Control 도구에 관한 자세한 내용은 222페이지의 “전자 활성화를
통해 Avid 편집 어플리케이션 활성화하기”를 참조하시기 바랍니다.

4. PhraseFind, PhraseFind Language Pack, 또는 ScriptSync를 활성화합니다.

 222페이지의 “전자 활성화를 통해 Avid 편집 어플리케이션 활성화하기”를 참조
바랍니다.
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인터넷 연결을 통해 Avid 편집 어플리케이션을 기존의 소프트웨어 라이센스에서 업그레

이드하는 방법:

1. 다음으로 이동합니다:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

Avid License Control 도구가 열립니다.

2. Avid 편집 어플리케이션 옆에 있는 Activate를 클릭합니다.

활성화 창이 열립니다.

3. “I am connected to the Internet and will use this computer”를 선택한 후
Continue를 클릭합니다.

창이 열리면 시스템 정보를 입력하고 제품을 등록할 수 있습니다. 

4. 시스템 ID가 표시되지 않을 경우 시스템 ID 텍스트 상자에 시스템 ID 번호를 입력
합니다. 기존 고객은 기존 시스템 ID를 사용합니다.
표시되지 않을 경우 시스템 ID 검색을 위해 221페이지의 “Avid 편집 어플리케이션
활성화에 필요한 요소”를 참조하십시오. 

n 기존 편집 시스템에 PhraseFind 또는 ScriptSync 등과 같은 구입 옵션이 포함되어 있다
면 업그레이드 시 자동으로 활성화됩니다.

5. 활성화 ID 텍스트 상자에 활성화 ID 번호를 입력합니다. 새로운 버전의 소프트웨어
활성화 ID 번호를 사용하십시오. 
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6. 다음 중 하나를 수행합니다:

t 제품을 등록한 적이 없는 경우에는 "Register your product with Avid
Technology, Inc. now”를 선택합니다. Avid의 개인 정보 보호 정책을 확인
하시려면 Read privacy policy를 클릭하십시오. 그 후 다음을 클릭합니다.

등록 대화 상자가 열립니다. Avid 온라인 등록을 통해 주요 업데이트 및 유지
보수 정보를 받아 볼 수 있습니다.

t “Don't register at this time”를 선택한 다음 Activate를 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료되면 소프트웨어가
성공적으로 활성화되었다는 메시지가 나타납니다. 

n  소프트웨어를 지금 등록하고 싶지 않다면 Avid 편집 어플리케이션의 Special >
Register를 선택하여 언제든지 등록할 수 있습니다.

7.  6단계에서 소프트웨어 등록을 선택했다면 다음을 수행합니다:

a. 등록 대화 상자에서 해당 상자에 이름과 주소 및 연락처 정보를 입력합니다.
별표(*)는 필수 입력 필드를 나타냅니다.

b. 다음을 클릭합니다.

등록 대화 상자가 열립니다.

c. 해당 제품 및 고객 정보를 입력합니다.

d. Activate and Register을 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료되면 소프트웨어가
성공적으로 활성화되었다는 메시지가 표시되고 버튼이 Deactivate로 변경됩
니다.

8. OK를 클릭합니다. 
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인터넷이 연결된 Avid 편집 어플리케이션을 동글 라이센스 버전에서 소프트웨어 라이센

스 버전으로 업그레이드하는 방법:

1. Avid 편집 시스템에 동글을 연결합니다.

2. 다음으로 이동합니다:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

Avid License Control 도구가 열립니다.

3. Avid 편집 어플리케이션 옆에 있는 Activate를 클릭합니다.

활성화 대화 상자가 열립니다.

4. “I am connected to the Internet and will use this computer”를 선택한 후
Continue를 클릭합니다.

창이 열리면 시스템 정보를 입력하고 제품을 등록할 수 있습니다. 

5. 시스템 ID가 표시되지 않을 경우 시스템 ID 텍스트 상자에 시스템 ID 번호를 입력
하십시오. 기존 고객은 기존 시스템 ID를 사용합니다.
표시되지 않을 경우 시스템 ID 검색을 위해 221페이지의 “Avid 편집 어플리케이션
활성화에 필요한 요소”를 참조하십시오. 

n 기존 편집 시스템에 PhraseFind 또는 ScriptSync 등과 같은 구입 옵션이 포함되어 있다
면 업그레이드 시 자동으로 활성화됩니다.

6. 활성화 ID 텍스트 상자에 활성화 ID 번호를 입력합니다. 활성화 ID를 검색하려면
221페이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.
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7. 다음 중 하나를 수행합니다.

t 제품을 등록한 적이 없는 경우에는 "Register your product with Avid
Technology, Inc. now”를 선택합니다. Avid의 개인 정보 보호 정책을 확인
하시려면 Read privacy policy를 클릭하십시오. 다음을 클릭합니다.

등록 대화 상자가 열립니다. Avid 온라인 등록으로 주요 업데이트 및 유지보
수 정보를 받아 볼 수 있습니다.

t “Don't register at this time”를 선택한 다음 활성화를 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료된 경우에는 소프트
웨어가 성공적으로 활성화되었다는 메시지가 표시됩니다.

n  소프트웨어를 지금 등록하지 않아도 Avid 편집 어플리케이션의 Special> Register을 선
택함으로써 언제든지 등록할 수 있습니다.

8.  7단계에서 소프트웨어 등록을 선택했다면 다음을 수행합니다.

a. 등록 대화 상자에서 해당 상자에 이름과 주소 및 연락처 정보를 입력합니다.
별표(*)는 필수 입력 필드를 나타냅니다.

b. 다음을 클릭합니다.

등록 대화 상자가 열립니다.

c. 해당 제품 및 고객 정보를 입력합니다. 

d. Activate를 클릭합니다.

9. 시스템이 동글의 비활성화를 원하는지 확인합니다. OK를 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료되면 소프트웨어가 성공적
으로 활성화되었다는 메시지가 나타납니다. 

10. OK를 클릭합니다.
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인터넷 연결 없이 Avid 편집 어플리케이션을 소프트웨어 라이센스로 업그레이드하는 방법: 

1. 다음으로 이동합니다:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

Avid License Control 도구가 열립니다. 

2. Avid 편집 어플리케이션 옆에 있는 Activate를 클릭합니다.

활성화 창이 열립니다.

3. “I am not connected to the Internet and will be using another computer that
is connected to the Internet”을 선택한 후 Continue를 클릭합니다.

창이 열리면 시스템 정보를 입력하고 제품을 등록할 수 있습니다. 

4. 시스템 ID가 표시되지 않을 경우 시스템 ID 텍스트 상자에 시스템 ID 번호를 입력
합니다. 기존 고객은 기존 시스템 ID를 사용합니다.
표시되지 않을 경우 시스템 ID 검색을 위해 221페이지의 “Avid 편집 어플리케이션
활성화에 필요한 요소”를 참조하십시오. 

n 기존 편집 시스템에 PhraseFind 또는 ScriptSync 등과 같은 구입 옵션이 포함되어 있다
면 업그레이드 시 자동으로 활성화됩니다.

n 장치 ID가 활성화 페이지의 하단에 표시되면 추후 사용을 위해 사용 별도로 보관합니다. 

5. 활성화 ID 텍스트 상자에 활성화 ID 번호를 입력합니다. 활성화 ID 검색은 221페
이지의 “Avid 편집 어플리케이션 활성화에 필요한 요소”를 참조 바랍니다.

n Avid License Control 도구는 활성화를 원하는 시스템에서 열어둡니다. 추가 정보를 입
력해야 합니다.

6. Next를 클릭합니다.

7. Avid License Control 도구의 지침을 수행한 후 Next를 클릭합니다.
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8. 인터넷이 연결된 컴퓨터에서는 웹 브라우저에서 http://avid.com/license를 탐색합
니다. 

9. 웹 페이지의 화면에 안내되는 지침을 수행합니다.

웹사이트가 license.bin 파일을 생성합니다 해당 파일에는 Avid 편집 어플리케이션
을 활성화하는데 필요한 라이센스 정보가 포함되어 있습니다

10. license.bin 파일을 복원한 후 활성화를 원하는 컴퓨터로 돌아갑니다.

11. Avid License Control 도구에서 Browse를 클릭한 후 시스템의 license.bin 파일
로 이동하여 Open을 클릭합니다.

활성화 도구가 시스템 정보를 확인합니다. 활성화가 완료되면 소프트웨어가 성공적
으로 활성화되었다는 메시지가 표시되고 버튼이 'Deactivate'로 변경됩니다.

n 활성화에 필요한 각 편집 어플리케이션 또는 옵션의 이전 단계를 반복합니다.

12. Avid 편집 어플리케이션이 열린 상태에서 변경 사항을 적용하려면 시스템을 재시
작해야 합니다. 

동글을 사용해 vid 편집 어플리케이션을 업그레이드하는 방법:

1. 동글이 Avid 편집 시스템에 연결되어 있는지 확인하십시오.

2. DongleManager.exe이 설치되어 있는 디렉토리로 이동합니다.

t (Windows) C:\Program Files\Avid\Utilities\DongleManager

t (Macintosh) Macintosh HD\Applications\Utilities\Avid Utilities\ 
DongleManager

3. DongleManager.exe를 더블-클릭합니다.

동글 관리자 창이 열립니다.

4. Update 탭을 클릭합니다.

5. Open을 클릭한 다음 동글 업데이터(.avd) 파일의 저장 위치로 이동합니다.

http://avid.com/license


6. 업데이터 파일을 선택한 다음 Open을 클릭합니다.

7. Update를 클릭합니다.

DongleManager.exe 어플리케이션이 동글을 업데이트하고 "확인 완료" 메시지를
표시합니다.

8. Avid 편집 어플리케이션을 시작합니다.

환영인사 창이 열립니다.

9. “I want to use a dongle to activate my software”를 선택합니다.

10. 계속을 클릭합니다.

시스템이 정보를 확인합니다. 활성화가 완료되면 소프트웨어가 성공적으로 활성화
되었다는 메시지가 나타납니다. 

Versioner.avd 파일을 이용해 Avid 편집 어플리케이션을 업그레이드하는 방법

(Avid 고객 지원 계약 고객 전용): 

1. 해당 편집 어플리케이션을 위한 Versioner.avd 파일을 다운로드합니다.

2. Versioner.avd 파일을 편집 어플리케이션 폴더로 옮깁니다.

(Windows) [drive]:/Program Files/Avid/[Avid editing application]

(Macintosh) Macintosh HD/Applications/[Avid editing application]

3. Avid 편집 어플리케이션을 시작합니다.

Avid License Control 도구가 열립니다. 

4. Avid 편집 어플리케이션 옆에 있는 Activate를 클릭합니다.
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5. 다음 중 하나를 수행합니다:

t “I am connected to the Internet and will use this computer”를 클릭합니
다.

t “I am not connected to the Internet and will be using another computer
that is connected to the Internet”을 클릭합니다.

6. 계속을 클릭합니다.

Avid 활성화 대화 상자가 열립니다. 시스템이 시스템 ID 및 활성화 ID를 자동으로
입력합니다. 

n 동글을 사용하는 경우에는 동글이 연결되어 있다면 시스템 ID 및 활성화 ID가 자동으로
입력됩니다.

7.  5단계에서 선택한 라이센스 옵션을 위해 본 섹션에 설명된 라이센스 업그레이드 활
성화 과정을 계속 진행합니다.

30일 평가판 실행하기

Avid 편집 어플리케이션, PhraseFind 또는 ScriptSync를 구매하기 전 30일 동안 평가판
을 무료로 사용해 볼 수 있습니다. Avid 편집 어플리케이션의 30일 평가판을 실행하면
PhraseFind 및 ScriptSync의 30일 평가판도 사용할 수 있습니다. PhraseFind의 30일
평가판을 사용하면 30일 동안 사용 가능한 모든 기능에 액세스할 수 있습니다. 이 경우에
는 다른 추가적인 언어 팩을 활성화할 필요가 없습니다. 하지만 PhraseFind 창의 언어 선
택 메뉴에서 원하는 언어를 선택해야 합니다.

Avid 편집 어플리케이션을 이미 소유하고 있다면 PhraseFind 또는 ScriptSync의 30일
평가판을 실행할 수 있습니다.

30일 평가 기간 후 Avid 편집 어플리케이션, PhraseFind 또는 ScriptSync을 구매하지
않는다면 더 이상 제품 및 기능들에 엑세스 할 수 없습니다. 평가 기간이 끝나기 전까지 시
스템이 남은 일자를 계속 통지합니다.



n 30일 평가 기간 동안 생성된 모든 빈 또는 프로젝트 파일들은 풀 버전 라이센스를 활성화
할 때만 사용할 수 있습니다.

Avid 편집 어플리케이션을 30일 평가 기간 동안 사용하는 방법:

1. Avid 편집 어플리케이션을 시작합니다.

환영인사 창이 열립니다.

2. "'I want to run fully-featured, trial version of Avid editing Application for 30
days"를 선택합니다.

3. 계속을 클릭합니다.

소프트웨어가 성공적으로 활성화되었습니다. 30일 평가 기간 동안 언제라도 Avid
편집 어플리케이션을 구입할 수 있습니다. Avid 편집 소프트웨어를 구입하지 않기
로 한 경우 30일 평가 종료 시 어플리케이션이 자동으로 비활성화됩니다.

30일 평가 기간 동안 PhraseFind를 실행하는 방법:

1. Avid 편집 어플리케이션을 연 후 Avid 프로젝트를 엽니다.

2. Ctrl+F 또는 Command+F를 누르거나 Edit > Find를 선택합니다.

검색 창이 열립니다.

3. 텍스트 상자에 단어나 구문을 입력한 다음 PhraseFind 버튼을 클릭합니다.

시스템이 시스템 상에 PhraseFind가 설치되어 있는지 확인하면 대화 상자가 열립
니다.

4. Run Trial을 클릭합니다.

시스템이 Avid 편집 어플리케이션을 다시 시작하면 PhraseFind에 액세스 할 수 있
습니다.

PhraseFind의 30일 평가판을 사용하면 30일 동안 사용 가능한 모든 어에 액세스할
수 있습니다. 이 경우에는 다른 추가적인 언어 팩을 활성화할 필요가 없습니다. 하지
만 PhraseFind 창의 언어 선택 메뉴에서 원하는 언어를 선택해야 합니다.
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5. PhraseFind 창의 언어 선택 메뉴에서 원하는 언어를 선택하고 PhraseFind 색인이
완전한 녹색으로 변할 때까지 기다립니다.

30일 평가 기간 동안 ScriptSync을 실행하는 방법:

1. Avid 편집 어플리케이션을 연 후 Avid 프로젝트를 엽니다.

2. 스크립트를 생성하려면 File > New Script를 선택합니다.

3. 스크립트로 이동한 다음 열기를 클릭합니다.

4. 스크립트에서 클립(테이크)을 배치할 섹션을 클릭합니다.

해당 섹션이 하일라이트 됩니다.

5. 빈에서 클립을 드래그하여 스크립트의 선택된 섹션으로 가져다 놓습니다.

스크립트의 클립 아래에 있는 상자가 검은색으로 하일라이트 됩니다. 이것은 클립
이 스크립트에서 선택되었다는 것을 나타냅니다.

6. Script > ScriptSync를 선택합니다.

시스템이 ScriptSync가 설치되어 있는지 확인한 다음 대화 상자가 열립니다.

7. Run Trial을 클릭합니다.

ScriptSync 창으로 즉시 액세스할 수 있습니다.

Avid 편집 어플리케이션을 30일 평가 기간 동안 구입하는 방법:

t Avid 편집 어플리케이션을 구입하려면 다음으로 이동합니다:
Avid 웹 스토어: http://shop.avid.com/store/ 
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30일 평가 기간 동안 PhraseFind 또는 ScriptSync를 구입하는 방법:

1. Avid 편집 어플리케이션을 연 후 Avid 프로젝트를 엽니다.

2. ScriptSync의 경우에는 239페이지의 “30일 평가 기간 동안 ScriptSync을 실행하
는 방법:”의 1~5단계를 따른 다음 Script > ScriptSync를 선택합니다.

3. PhraseFind의 Ctrl+F 또는 Command+F를 누르거나 Edit > Find를 선택합니다.

찾기 창이 열립니다.

4. PhraseFind의 경우에는 텍스트 상자에 단어나 구문을 입력한 다음 PhraseFind 버
튼을 클릭합니다.

평가 기간이 끝나기 전까지 시스템이 남은 일자를 계속 통보합니다. 

5. Buy를 클릭합니다.

n 구입 버튼이 표시되지 않을 경우 검색 창을 닫고 Avid 편집 어플리케이션을 다시 실행합
니다. 위의 단계를 반복합니다.

시스템이 Avid 웹 스토어를 열면 이 곳에서 PhraseFind 또는 ScriptSync를 구입할
수 있습니다. 제품을 구매하고 활성화 ID를 받으면 PhraseFind 또는 ScriptSync를
활성화할 수 있습니다.

대화 상자가 열리면서 활성화가 Avid 편집 어플리케이션을 종료하고 Avid
License Control 도구를 다시 실행할 것이라는 것을 통보합니다.

6. 계속을 클릭합니다.

Avid License Control 도구가 열립니다.

활성화를 계속하기 위해서는 222페이지의 “전자 활성화를 통해 Avid 편집 어플리
케이션 활성화하기”를 참조 바랍니다.
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옵션 및 주요 기능 활성화하기

Avid 편집 어플리케이션을 활성화하는 것 외에도 Avid License Control 도구를 통해 활
성화 할 수 있는 몇 가지 편집 옵션 및 주요 기능들이 있습니다. 

이러한 주요 기능들을 활성화하려면 222페이지의 “전자 활성화를 통해 Avid 편집 어플
리케이션 활성화하기”의 단계를 따르거나 아래 나열된 해당 가이드를 참조 바랍니다.

• PhraseFind
PhraseFind 옵션(음성 검색)을 이용하면 단일 프로젝트의 전체 빈 파일에서 오디오 다이
얼로그를 검색할 수 있습니다. PhraseFind는 별도로 구입해야 하며 선택한 무료 언어 팩
이 포함되어 있습니다. 자세한 내용은 Avid 편집 도움말 또는 PhraseFind 시작하기 가이
드에서 “PhraseFind 구입 및 활성화하기”를 참조 바랍니다.

• ScriptSync
ScriptSync는 음성 색인 기술을 사용하여 클립의 오디오 부분을 분석한 후 결과물을
스크립트 텍스트 라인에 매칭시킵니다. ScriptSync는 별도로 구입해야 합니다. 자세
한 내용은 Avid 편집 도움말 또는 ScriptSync 시작하기 가이드에서 “ScriptSync 구
입 및 활성화하기”를 참조 바랍니다.

• PhraseFind Language Pack
추가 언어 팩을 구매하면 PhraseFind와 함께 사용할 수 있습니다. 언어 팩은 별도로
구매해야 합니다. 자세한 내용은 Avid 편집 도움말 또는 PhraseFind 시작하기 가
이드에서 “추가 언어 팩 활성화하기”를 참조 바랍니다.

• AVCHD Dolby AC-3 불러오기 또는 AMA 링크하기
이 기능은 AVCHD 전송 스트림(.mts) 파일을 불러오거나 AMA로 링크하는데 사
용됩니다. 처음 .mts 파일을 불러오거나 AMA로 링크하려는데 인터넷에 연결되어
있지 않은 경우에는 시스템이 대화 상자를 먼저 연 후 Avid License Control 도구
를 엽니다. 화면상의 지시를 따라 이 기능을 활성화 합니다. 인터넷에 연결되어 있는
경우에는 활성화가 자동으로 실행됩니다.

n 해당 형식을 사용할 경우에만 AVCHD Dolby AC-3 기능이 표시됩니다. 일반적으로
Avid License Control 도구에서는 이 옵션을 찾아볼 수 없습니다.
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Avid 편집 어플리케이션 및 옵션 비활성화하기

Avid 편집 어플리케이션을 다른 컴퓨터로 이동해야 하는 경우에는 먼저 Avid 편집 어플
리케이션과 옵션을 비활성화한 다음 Avid 편집 어플리케이션을 제거해야 합니다.

PhraseFind 및 ScriptSync를 먼저 비활성화한 다음 Avid 편집 어플리케이션을 비활성
화합니다.

n 소프트웨어 및 옵션을 비활성화하려면 인터넷 연결이 필요합니다.

n 평가판은 비활성화가 필요하지 않습니다. 

Avid 편집 어플리케이션 및 옵션 비활성화하기:

1. Avid 편집 어플리케이션에서 Special > Deactivate Software License를 선택합
니다.

2. 메시지가 Avid 편집 어플리케이션은 닫히고 Avid License Control 도구가 열린다
는 것을 알리면 계속을 클릭합니다.

3. 대화 상자가 Avid 편집 어플리케이션을 그대로 둘지 확인하면 Leave를 클릭합니다.

4. 또는 다음 위치로 이동해 Avid License Control 도구를 엽니다:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

Avid License Control 도구가 열립니다. 

5. Avid 편집 어플리케이션, PhraseFind 또는 ScriptSync 옆에 있는 Deactive를 클
릭합니다.

PhraseFind를 비활성화하는 경우에는 메시지가 표시되어 PhraseFind와 관련된 언
어 팩 또한 비활성화될 것을 통지합니다. 
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6. Yes를 클릭합니다.

시스템이 선택된 항목을 비활성화하고 버튼이 Activate로 변경됩니다.

7. 종료를 클릭하여 창을 닫습니다.

Avid 편집 어플리케이션 제거하기

편집 어플리케이션을 설치하기 전에 제어판의 프로그램 및 주요 기능을 사용하여 Digi
Drivers를 제거해야 합니다. 시스템을 다시 부팅한 다음 새 편집 어플리케이션을 설치하
십시오. Digi Drivers를 제거하지 않은 경우에는 Audiosuite 플러그-인이 로딩되지 않기
때문에 "이 소프트웨어는 장치 드라이버 TPkd 설치 및 실행 전 재부팅이 요구됩니다" 또
는 "DAE 인터페이스 사용 불가능"이라는 오류 메시지가 표시됩니다. 새 시스템에서 설
치 중 이러한 오류 메시지가 나타나면 문제 해결을 위해 Windows 업데이트의 Hot fix
KB926255를 설치해야 합니다.

모든 Avid 편집 어플리케이션의 경우 로그인 후 관리자 권한이 있는 사용자로서 어플리
케이션을 처음 시작해야 합니다. 공유 스토리지 환경에서 작업할 경우 작업 공간을 마운
트하십시오. 그러면 정규 사용자로 Avid 편집 어플리케이션을 실행할 수 있습니다.

Avid Mbox 장치 제품군 또는 Avid Pro Tools|HD Native 하드웨어를 비롯한 Pro
Tools 오디오 장치를 사용할 경우에는 장치 드라이버를 별도로 설치해야 합니다. Avid 오
디오 장치 드라이버는 다음 디렉토리에서 찾을 수 있습니다:

• (Windows) Program Files\Avid\Utilities\
AudioDriverInstallers

• (Macintosh) Applications\Utilities\Avid Utilities\Avid 
Audio Drivers
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(Windows) Avid 편집 어플리케이션을 시작하려면 다음 중 하나를 수행합니다.

1. 모든 활성 어플리케이션을 종료합니다.

2. 제어판에 액세스한 다음 프로그램 및 주요 기능을 선택합니다. 그런 다음 편집 어플
리케이션을 선택하고 제거를 클릭합니다.

(Macintosh) Avid 편집 어플리케이션 소프트웨어를 제거하는 방법:

1. 모든 활성 어플리케이션을 종료합니다.

2. Applications/Avid_Uninstaller/AvidEditingApplication으로 이동합니다.

3.  AvidEditingApplication 언인스톨러를 더블-클릭합니다.

4. 화면상의 지시를 따릅니다.

펌웨어 업데이트 참고

설치 후 처음으로 편집 어플리케이션을 시작할 때 Avid 하드웨어 펌웨어 업데이트를 요
구하는 대화 상자가 표시될 수 있습니다. 업데이트를 선택합니다. 업데이트 진행 도중에
는 다른 어플리케이션에 액세스하거나 활성 창을 옮기지 마십시오. 다른 어플리케이션에
액세스할 경우에는 업데이트 완료 대화 상자가 표시되지 않을 수 있습니다. 이 경우에는
업데이트 진행 상황이 100%로 표시되더라도 다음 단계로 진행할 수 없습니다. 업데이트
완료 및 시스템 종료 요구 창이 가려져서 화면의 전면에 표시되지 않게 됩니다. 이 경우에
는 시스템을 재시작하지 말고 시스템을 완전히 종료한 다음 다시 전원을 켜야 합니다.
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8 Avid 編輯應用程式安裝手冊

「讀我檔案」的線上版本內含 Avid 編輯應用程式的最新資訊。您應經常線上查閱最新的版
本資訊或讀我檔案，因為線上版本隨時會利用最新資訊進行更新。要查看線上版本，請在
Avid 編輯應用程式的 Help （幫助）功能表中選取 ReadMe （讀我檔案），或瀏覽知識
庫，網站為 www.avid.com/readme。

若要直接從安裝 DVD 安裝 Avid 編輯應用程式，系統需要支援雙層 DVD。如果系統沒
有 DVD 硬碟，您可從 Avid 下載中心下載 Avid 編輯應用程式，網址為 www.avid.com/
support/downloads。

安裝 Avid 編輯應用程式後，您將會使用 Avid 授權控制工具啟動軟體。Avid 授權控制工
具亦會啟動編輯選項。如需關於編輯選項的詳細資訊，請參閱第 270頁的 「啟動選項及
功能」。

n 如果您擁有有效的 Avid 支援合同，或許可選擇升級軟體。如需詳細資訊，請參閱 Avid 下
載中心提供的升級指示或升級套件隨附的指示。

c 如果您變更系統設定，例如更換硬碟、更換網路配接器或升級作業系統，則必須先停用

Avid 軟體。如需關於停用的詳細資訊，請參閱第 271頁的 「停用 Avid 編輯應用程式及
選項」。
 

http://www.avid.com/readme
http://www.avid.com/support/downloads
http://www.avid.com/support/downloads


安裝 Avid 編輯應用程式前

請在安裝編輯應用程式前閱讀以下步驟。升級客戶及新使用者必須執行不同的步驟。選取
適用的安裝步驟：

新使用者
若是新使用者且從未在系統上安裝編輯應用程式，請按照 第 246页 至 第 258页 的指示操
作。開始第 246頁的 「安裝 Avid 編輯應用程式」。

現有使用者
若要從編輯應用程式的先前版本進行升級，則必須在安裝並啟用新軟體前，解除安裝先前
版本。

n 解除安裝 Avid 編輯應用程式前，請寫下您的系統 ID。將需要舊系統 ID

 以啟動新軟體。

請按照 第 258页 至 第 266页 的指示操作。開始第 258頁的 「升級 Avid 編輯應用程
式」。

安裝 Avid 編輯應用程式

對於所有 Avid 編輯應用程式，以擁有管理權限的使用者身份登入，安裝應用程式，然後
以擁有管理權限的使用者身份初始開啟應用程式。如果使用共享儲存環境，請安裝您的工
作空間。然後您能以一般使用者身份執行 Avid 編輯應用程式。

n 安裝編輯應用程式軟體可能需要一些時間。安裝個別的編輯應用程式可能需要 5 到 15 分
鐘。安裝全套編輯應用程式可能最多需要 35 分鐘。
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(Windows) 安裝 Avid 編輯應用程式軟體：

1. 結束所有使用中的應用程式。

2. 插入編輯應用程式 DVD。

3. 點擊安裝 Avid Editor Suite（Avid 編輯器套件）或 Individual Product（個別產
品）並按照畫面上的指示操作。

n 如果畫面上顯示 FilesInUse 對話方塊，您可安全選取 Ignore （忽略）並繼續執行操作。

n 如果在安裝過程中收到使用者存取警告，請選取 Continue Anyway （仍然繼續）以繼續
安裝。

4. 在系統提示時，選取 Yes, restart my computer （是，重新啟動我的電腦）。

5. 繼續執行第 248頁的 「啟動 Avid 編輯應用程式」。

(Macintosh) 安裝 Avid 編輯應用程式軟體：

1. 結束所有應用程式。

2. 插入編輯應用程式 DVD。

3. 連按兩下 EditingApplicationName.pkg。

4. 點擊安裝 Avid Editor Suite（Avid 編輯器套件）或 Individual Product（個別產
品）並按照畫面上的指示操作。

5. 在系統提示時，選取 Yes, restart my computer （是，重新啟動我的電腦）。

6. 繼續執行第 248頁的 「啟動 Avid 編輯應用程式」。
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啟動 Avid 編輯應用程式

安裝過程在 Start （開始）功能表中添加一個桌面或 Dock 圖示及一個指向 Avid 編輯應
用程式的指標。

如果您在筆記型電腦安裝 Avid 編輯應用程式，畫面上可能會打開一個對話方塊，顯示電
源管理配置不相容的訊息。當您在 Windows 7 執行 Avid 編輯應用程式，Avid 建議您使
用 High Performance （高效能）電源選項。其他電源配置可能會影響編輯功能的效能
（如擷取和數位截取）。

安裝 Avid 編輯應用程式的軟體並首次啟動應用程式後，您必須啟動應用程式的複本。

(Windows) 要啟動您的 Avid 編輯應用程式，請執行以下操作之一：

t 按一下 Start > All Programs > Avid > Avid editing application（開始 > 所有程
式 > Avid > Avid 編輯應用程式）。

t 連按兩下 Avid 編輯應用程式桌面圖示。

畫面上將會打開 Welcome （歡迎）視窗。

(Macintosh) 要啟動您的 Avid 編輯應用程式，請執行以下操作之一：

1. 按一下 Dock 上的 Avid 編輯應用程式別名圖示。

2. 選取 Go > Applications （轉至 > 應用程式）並連按兩下 Avid 編輯應用程式資料
夾。然後連按兩下 Avid 編輯應用程式檔案。
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畫面上將會打開 Welcome （歡迎）視窗。
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250 Avid 編輯應用程式安裝手冊

3. 選取其中一個選項以啟動軟體。

t 要使用電子啟動進行啟動，選取 I want to activate my software using the
Internet, another computer, or a volume license server （我想使用網際網路、另
一台電腦或磁碟區授權伺服器啟動我的軟體），然後按一下 Continue （繼續）。
畫面上將會打開 Avid 授權控制工具。按照第252頁的 「使用電子啟動啟動 Avid
編輯應用程式」上的提示執行操作。

t 要使用硬體金鑰或硬體鎖進行啟動，選取 I want to use a dongle to activate
my software （我想使用硬體鎖啟動我的軟體），然後按一下 Continue （繼
續）。
系統將會確認您的資訊。啟動操作完成後，畫面上將會顯示一則訊息，通知您
軟體已成功啟動。

t 要執行 Trial Mode （試用模式），選取 I want to run a fully-featured trial
version of the Avid editing application for 30 days（我想執行 Avid 編輯
應用程式完整功能試用版本 30 天），然後按一下 Continue （繼續）。
軟體已成功啟動。
如需關於試用模式的其他詳細資訊，請參閱第 267頁的 「執行 30 天試用版」。



我需要什麼來啟動 Avid 編輯應用程式？

識別 (ID) 碼： 尋找位置：

啟動 ID 本手冊的封面內頁。

如果您從 Avid 網路商店購買，會透過 Avid 電子郵件收到啟動 ID。

如果您從 Avid 網路商店購買，請登入您的商店帳戶，網址為

http://account.avid.com/。

系統 ID 如果是新使用者，將於本手冊的封面內頁找到。
如果是現有使用者，您需要舊系統 ID。

如果線上購買，會透過電子郵件收到系統 ID。

Avid 編輯應用程式啟動顯示畫面 (Help > About Avid editing
application) （幫助 > 關於 Avid 編輯應用程式）。

Avid 編輯應用程式的主控台（Tools > Console（工具 > 主控台 ）），
然後捲動至 System ID （系統 ID）。

如果您從 Avid 網路商店購買，可登入商店帳戶檢視系統 ID 編號，
網址為 http://account.avid.com/。
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使用電子啟動啟動 Avid 編輯應用程式

• 備有網際網路存取 - 請參閱第 253頁的 「使用備有網際網路存取的電子啟動啟動
Avid 編輯應用程式」。

• 沒有網際網路存取 - 請參閱第 257頁的 「使用沒有網際網路存取的電子啟動啟動
Avid 編輯應用程式」。

• 透過磁碟區授權伺服器 - 請參閱第 258頁的 「使用磁碟區授權伺服器啟動 Avid 編
輯應用程式」。

系統 ID （續） 啟動後，Avid 授權控制工具的 License Profile（授權設定
檔）標籤會顯示系統的資訊。按一下 Copy（複製）將資訊複製至

Clipboard（剪貼簿）。您可從剪貼簿剪下並在電子郵件貼上或建立文
字檔案。如果您需要儲存此資訊作記錄，或需要向 Avid 支援客戶發送
系統資訊時便會有幫助。

裝置 ID 如果您在沒有連接至網際網路的系統上啟動軟件才需要。將
會於啟動期間透過 Avid 授權控制工具向您提供。

識別 (ID) 碼： 尋找位置：
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使用備有網際網路存取的電子啟動啟動 Avid 編輯應用程式

1. 開啟 Avid 授權控制工具，按一下 Avid 編輯應用程式旁的 Activate （啟動）。
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畫面上將會打開以下項目。

2. 選取 I am connected to the Internet and will use this computer（我已
連接至網際網路，并將會使用本電腦），然後按一下 Continue （繼續）。
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畫面上將會打開視窗，讓您輸入系統資訊和註冊產品。

3. 在 System ID （系統 ID）文字方塊中輸入您的系統識別碼。要尋找系統 ID，請參
閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

4. 在 Activation ID（啟動 ID）文字方塊中輸入您的啟動識別碼。要尋找啟動 ID，請
參閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

5. 如果您要查看 Avid 的隱私權政策，請按一下 Read Privacy Policy（閱讀隱私權政策）。
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6. 執行以下其中一項操作：

t 選取 Register your software （註冊您的軟體），然後按一下 Continue （下一
步）。

畫面上將會打開一個註冊對話方塊。 Avid 的線上註冊可讓您接收重要更新與
維護資訊。

t 選取 Don’t register your software （不要註冊您的軟體） ，然後按一下
Activate （啟動）。

Avid 授權控制工具確認您的系統資訊。啟動操作完成後，畫面上將會顯示一則
訊息，通知您軟體已成功啟動。

n 如果不想現在註冊軟體，可隨時在 Avid 編輯應用程式中選取 Special > Register （特殊
> 註冊）以註冊軟體。

7. 如果選取註冊軟體，請執行以下操作：

a. 在 Register （註冊）對話方塊內的適當文字方塊中輸入名字、地址及聯絡資
訊。星號 (*) 表示必填欄位。

b. 按一下 Next （下一步）

畫面上將會打開一個註冊對話方塊。

c. 輸入適當的產品及客戶資訊。

d. 按一下 Activate and Register （啟動和註冊）。

8. 如果已打開 Avid 編輯應用程式，您應重新啟動應用程式以套用變更。
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使用沒有網際網路存取的電子啟動啟動 Avid 編輯應用程式

1. 開啟 Avid 授權控制工具，按一下 Avid 編輯應用程式旁的 Activate （啟動）。

畫面上將會打開啟動視窗。

2. 選取 I am connected to the Internet and will be using another computer（我沒
有連接至網際網路，并將會使用另一台備有網際網路連接的電腦） ，然後按一下
Continue （繼續）。

3. 在 System ID （系統 ID）文字方塊中輸入您的系統識別碼。要尋找系統 ID，請參
閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

n 您的裝置 ID 於啟動頁面底部顯示，請寫下此編號稍後使用。

4. 在 Activation ID（啟動 ID）文字方塊中輸入您的啟動識別碼。要尋找啟動 ID，請
參閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

5. 按一下 Next （下一步）。

6. 請按照 Avid 授權控制工具的指示操作，然後按一下 Next （下一步）。

7. 在備有網際網路連接的電腦上，打開網路瀏覽器并導航至 http://avid.com/license。

8. 請按照網頁上的畫面指示。

網站建立 license.bin 檔案。此檔案包含啟動 Avid 編輯應用程式所需的授權資訊。

9. 取得 license.bin 檔案后， 返回到您要啟動的電腦。
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10. 在 Avid 授權控制工具中，按一下 Browse （瀏覽）並導航至您系統的 license.bin
檔案，然後按一下 Open （開啟）。

啟動工具將確認您的系統資訊。啟動完成後，畫面上將會顯示一則訊息，通知您軟體
已成功啟動，而按鈕會變更為 Deactivate （停用）。

n 為每個編輯應用程式或需要啟動的選項重複上述步驟。

11. 如果已打開 Avid 編輯應用程式，您應重新啟動應用程式以套用任何變更。

使用磁碟區授權伺服器啟動 Avid 編輯應用程式

您可使用磁碟區授權伺服器啟動及管理多個編輯用戶端。如需詳細資訊，請參閱知識庫上
的 《Avid 專用的 FlexNet 裝置管理員》手冊。

升級 Avid 編輯應用程式

您可從現有的軟體授權或硬體鎖授權版本升級您的 Avid 編輯應用程式。如果從硬體鎖授
權版本升級或變更產品型號，升級套件中將包含一個硬體鎖更新程式卡、升級碼及軟體啟
動碼。請參閱升級套件中的指示以更新軟體。

如果您之前已購買 PhraseFind、PhraseFind Language Pack 或 ScriptSync，您的授權
啟動應該會自動更新。如果您購買新選項，將會收到新啟動 ID。

n 升級硬體鎖授權版本至軟體授權將會停用您的硬體鎖。在啟動軟體授權後，您不需要並無
法使用硬體鎖以執行 Avid 編輯應用程式。

如果您升級現有的授權且擁有有效的 Avid 支援合同，請在更新系統前參閱 Avid 下載中
心提供的指示或升級套件隨附的指示。所有 Avid 支援合同客戶必須如本主題內上個步驟
的描述使用 Versioner.avd 檔案更新軟體。如需詳細資訊，請參閱 Avid 知識庫上的 「支
援客戶的軟體授權升級過程」（www.avid.com/US/support）。

如果升級 Avid 編輯系統、 PhraseFind 或 ScriptSync 選擇，應按照以下高階步驟。
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升級工作流程 

1. 解除安裝現有的 Avid 編輯應用程式。

請參閱第 272頁的 「解除安裝 Avid 編輯應用程式」。

PhraseFind 及 ScriptSync 與 Avid 編輯系統一併解除安裝。

n 解除安裝 Avid 編輯應用程式前，請寫下您的系統 ID。將需要舊系統 ID 以啟動新軟體。

2. 安裝新 Avid 編輯應用程式。

請參閱第 246頁的 「安裝 Avid 編輯應用程式」。

PhraseFind 及 ScriptSync 與 Avid 編輯系統一併安裝。如果您之前已購買
PhraseFind、 PhraseFind Language Pack 或 ScriptSync，您的授權啟動應該會
自動更新。如果您購買新選項，將會收到新啟動 ID。

3. 啟動 Avid 編輯應用程式。

請參閱以下升級步驟 （視乎您的安裝程式而定）。
如需關於 Avid 授權控制工具的詳細資訊，請參閱第 252頁的 「使用電子啟動啟動
Avid 編輯應用程式」。

4. 啟動 PhraseFind、 PhraseFind Language Pack 或 ScriptSync。

請參閱第 252頁的 「使用電子啟動啟動 Avid 編輯應用程式」。

從現有的軟體授權版本自升級備有網際網路連接的 Avid 編輯應用程式：

1. 轉至以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

畫面上將會打開 Avid 授權控制工具。

2. 按一下 Avid 編輯應用程式旁的 Activate （啟動）。

畫面上將會打開啟動視窗。
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3. 選取 I am connected to the Internet and will use this computer（我已連接至網
際網路，并將會使用本電腦），然後按一下 Continue （繼續）。

畫面上將會打開視窗，讓您輸入系統資訊和註冊產品。

4. 如果沒有顯示您的系統 ID，請在 System ID （系統 ID）文字方塊中輸入您的系統
識別碼。如果是現有客戶，請使用您的舊系統 ID。
如果沒有顯示，可尋找您的系統 ID，請參閱第 251頁的 「我需要什麼來啟動 Avid
編輯應用程式？」。

n 如果您先前編輯器包含已購買的選項，如 PhraseFind 或 ScriptSync，這些選項將會跟您
的升級自動啟動。

5. 在 Activation ID （啟動 ID）文字方塊中輸入您的啟動識別碼。將啟動 ID 碼用於
新版本的軟體。

6. 執行以下其中一項操作：

t 如果您從未註冊您的產品，請選取 Register your product with Avid
Technology, Inc. now（立即向 Avid Technology, Inc. 註冊您的產品）。如
果您要查看 Avid 的隱私權政策，請按一下 Read Privacy Policy （閱讀隱私
權政策）。然後按一下 Next （下一步）。

畫面上將會打開一個註冊對話方塊。 Avid 的線上註冊可讓您接收重要更新與
維護資訊。

t 選取 Don’t register at this time（現在不想註冊），然後按一下 Activate（啟
動）。

啟動工具將確認您的系統資訊。啟動操作完成後，畫面上將會顯示一則訊息，
通知您軟體已成功啟動。

n 如果不想現在註冊軟體，可隨時在 Avid 編輯應用程式中選取 Special > Register （特殊
> 註冊）以註冊軟體。
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7. 如果在第 6 步驟選擇註冊軟體，請執行以下操作：

a. 在 Register （註冊）對話方塊內的適當文字方塊中輸入名字、地址及聯絡資
訊。星號 (*) 表示必填欄位。

b. 按一下 Next （下一步）

畫面上將會打開一個註冊對話方塊。

c. 輸入適當的產品及客戶資訊。

d. 按一下 Activate and Register （啟動和註冊）。

啟動工具將確認您的系統資訊。啟動完成後，畫面上將會顯示一則訊息，通知
您軟體已成功啟動，而按鈕會變更為 Deactivate （停用）。

8. 按一下 OK （確定）。

從升級硬體鎖授權版本或軟體授權升級備有網際網路連接的 Avid 編輯應用程式：

1. 將硬體鎖連接至 Avid 編輯系統。

2. 轉至以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

畫面上將會打開 Avid 授權控制工具。

3. 按一下 Avid 編輯應用程式旁的 Activate （啟動）。

畫面上將會打開啟動對話方塊。

4. 選取 I am connected to the Internet and will use this computer（我已連接至網
際網路，并將會使用本電腦），然後按一下 Continue （繼續）。

畫面上將會打開視窗，讓您輸入系統資訊和註冊產品。
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5. 如果沒有顯示您的系統 ID，請在 System ID （系統 ID）文字方塊中輸入您的系統
識別碼。如果是現有客戶，請使用您的舊系統 ID。
如果沒有顯示，可尋找您的系統 ID，請參閱第 251頁的 「我需要什麼來啟動 Avid
編輯應用程式？」。

n 如果您先前編輯器包含已購買的選項，如 PhraseFind 或 ScriptSync，這些選項將會跟您
的升級自動啟動。

6. 在 Activation ID（啟動 ID）文字方塊中輸入您的啟動識別碼。要尋找啟動 ID，請
參閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

7. 執行以下其中一項操作：

t 如果您從未註冊您的產品，請選取 Register your product with Avid
Technology, Inc. now（立即向 Avid Technology, Inc. 註冊您的產品）。如
果您要查看 Avid 的隱私權政策，請按一下 Read Privacy Policy （閱讀隱私
權政策）。然後按一下 Next （下一步）。

畫面上將會打開一個註冊對話方塊。 Avid 的線上註冊可讓您接收重要更新與
維護資訊。

t 選取 Don’t register at this time（現在不想註冊），然後按一下 Activate（啟動）。

啟動工具將確認您的系統資訊。啟動操作完成後，畫面上將會顯示一則訊息，
通知您軟體已成功啟動。

n 如果不想現在註冊軟體，可隨時在 Avid 編輯應用程式中選取 Special > Register （特殊
> 註冊）以註冊軟體。
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8. 如果在第 7 步驟選擇註冊軟體，請執行以下操作：

a. 在 Register （註冊）對話方塊內的適當文字方塊中輸入名字、地址及聯絡資
訊。星號 (*) 表示必填欄位。

b. 按一下 Next （下一步）

畫面上將會打開一個註冊對話方塊。

c. 輸入適當的產品及客戶資訊。

d. 按一下 Activate （啟動）。

9. 系統會詢問您是否確認要停用硬體鎖。按一下 OK （確定）。

啟動工具將確認您的系統資訊。啟動操作完成後，畫面上將會顯示一則訊息，通知您
軟體已成功啟動。

10. 按一下 OK （確定）。

將沒有網際網路連接的 Avid 編輯應用程式升級到軟體授權版： 

1. 轉至以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

畫面上將會打開 Avid 授權控制工具。

2. 按一下 Avid 編輯應用程式旁的 Activate （啟動）。

畫面上將會打開啟動視窗。

3. 選取 I am connected to the Internet and will be using another computer（我沒
有連接至網際網路，并將會使用另一台備有網際網路連接的電腦） ，然後按一下
Continue （繼續）。

畫面上將會打開視窗，讓您輸入系統資訊和註冊產品。
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4. 如果沒有顯示您的系統 ID，請在 System ID （系統 ID）文字方塊中輸入您的系統
識別碼。如果是現有客戶，請使用您的舊系統 ID。
如果沒有顯示，可尋找您的系統 ID，請參閱第 251頁的 「我需要什麼來啟動 Avid
編輯應用程式？」。

n 如果您先前編輯器包含已購買的選項，如 PhraseFind 或 ScriptSync，這些選項將會跟您
的升級自動啟動。

n 您的裝置 ID 於啟動頁面底部顯示，請寫下此編號稍後使用。

5. 在 Activation ID（啟動 ID）文字方塊中輸入您的啟動識別碼。要尋找啟動 ID，請
參閱第 251頁的 「我需要什麼來啟動 Avid 編輯應用程式？」。

n 在需要啟動的系統上打開 Avid 授權控制工具。您將需要輸入額外資訊。

6. 按一下 Next （下一步）。

7. 請按照 Avid 授權控制工具的指示操作，然後按一下 Next （下一步）。

8. 在備有網際網路連接的電腦上，打開網路瀏覽器并導航至 http://avid.com/license。

9. 請按照網頁上的畫面指示。

網站建立 license.bin 檔案。此檔案包含啟動 Avid 編輯應用程式所需的授權資訊。

10. 取得 license.bin 檔案后， 返回到您要啟動的電腦。

11. 在 Avid 授權控制工具中，按一下 Browse （瀏覽）並導航至您系統的 license.bin
檔案，然後按一下 Open （開啟）。

啟動工具將確認您的系統資訊。啟動完成後，畫面上將會顯示一則訊息，通知您軟體
已成功啟動，而按鈕會變更為 Deactivate （停用）。

n 為每個編輯應用程式或需要啟動的選項重複上述步驟。

12. 如果已打開 Avid 編輯應用程式，您應重新啟動應用程式以套用任何變更。
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升級 Avid 編輯應用程式 265

使用硬體鎖升級 Avid 編輯應用程式：

1. 確定已將硬體鎖連接至 Avid 編輯系統。

2. 導航至安裝 DongleManager.exe 的目錄：

t (Windows) C:\Program Files\Avid\Utilities\DongleManager

t (Macintosh) Macintosh HD\Applications\Utilities\Avid Utilities\ 
DongleManager

3. 連按兩下 DongleManager.exe

畫面上將會打開 Dongle Manager （硬體鎖管理員）視窗。

4. 按一下 Update （更新）標籤。

5. 按一下 Open （開啟），然後導航至硬體鎖更新程式 (.avd) 檔案的所在位置。

6. 選取該更新程式檔案，然後按一下 Open （開啟）。

7. 按一下 Update （更新）。

DongleManager.exe 應用程式將更新您的硬體鎖並顯示 Verification Complete
（驗證已完成）的訊息。

8. 啟動您的 Avid 編輯應用程式。

畫面上將會打開 Welcome （歡迎）視窗。

9. 選取 I want to use a dongle to activate my software （我想使用硬體金鑰或硬體
鎖啟動我的軟體）。

10. 按一下 Continue （繼續）。

系統將會確認您的資訊。啟動操作完成後，畫面上將會顯示一則訊息，通知您軟體已
成功啟動。



使用 Versioner.avd 檔案升級 Avid 編輯應用程式 （僅限於 Avid 支援合同客戶）： 

1. 下載適用於編輯應用程式的 Versioner.avd 檔案。

2. 將 Versioner.avd 檔案放在編輯應用程式的資料夾內：

(Windows) [drive]:/Program Files/Avid/[Avid editing application]

(Macintosh) Macintosh HD/Applications/[Avid editing application]

3. 啟動您的 Avid 編輯應用程式。

畫面上將會打開 Avid 授權控制工具。

4. 按一下 Avid 編輯應用程式旁的 Activate （啟動）。

5. 執行以下其中一項操作：

t 選取 I am connected to the Internet and will use this computer （我已連
接至網際網路，并將會使用本電腦）。

t 選取 I am connected to the Internet and will be using another computer
（我沒有連接至網際網路，并將會使用另一台備有網際網路連接的電腦）。

6. 按一下 Continue （繼續）。

畫面上將會打開 Avid 啟動對話方塊。系統自動填入您的系統 ID 及啟動 ID。

n 如果使用硬體鎖，如果您已連接硬體鎖才會填入系統 ID 及啟動 ID。

7. 按照您在本章節第  5 步所選的授權選項之升級授權啟動步驟繼續執行操作。
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執行 30 天試用版 267

執行 30 天試用版

購買 Avid 編輯應用程式、PhraseFind 或 ScriptSync 前，您可試用 30 天。如果您執行
Avid 編輯應用程式的 30 天試用版，也會取得 PhraseFind 及 ScriptSync 的 30 天試用
版。PhraseFind 的 30 天試用版在試用期間也包含存取所有可用語言。您暫時無須啟動任
何額外語言套件。但是，您需要在 PhraseFind 視窗的 Select a Language （選取語言）
功能表中選取語言。

如果您已擁有 Avid 編輯應用程式，可執行 PhraseFind 或 ScriptSync 的 30 天試用版。

30 天過後，如果您沒有購買 Avid 編輯應用程式、PhraseFind 或 ScriptSync，則不再能
夠存取相關產品及功能。系統會持續通知您試用期餘下多少日便完結。

n 30 天試用期間建立的任何 bin 或專案只於啟動完整編輯授權後才能使用。

試用 Avid 編輯應用程式 30 天：

1. 啟動您的 Avid 編輯應用程式。

畫面上將會打開 Welcome （歡迎）視窗。

2. 選取 I want to run a fully-featured, trial version of the Avid editing application
for 30 days （我想執行 Avid 編輯應用程式完整功能試用版本 30 天）。

3. 按一下 Continue （繼續）。

軟體已成功啟動。 30 天試用期內任何時候，您可選擇購買 Avid 編輯應用程式的複
本。如果您選取不購買軟體，您的 Avid 編輯應用程式會在 30 天的試用期結束後被
停用。



執行 PhraseFind 30 天試用版：

1. 啟動 Avid 編輯應用程式，然後開啟 Avid 專案。

2. 按 Ctrl+F 或 Command+F 或選取 Edit > Find （編輯 > 尋找）。

畫面上將會打開 Find （尋找）視窗。

3. 在文字方塊中輸入單字或詞組，然後按一下 PhraseFind 按鈕。

系統將會檢查您的系統是否裝有 PhraseFind 並打開對話方塊。

4. 按一下 Run Trial （執行試用版）。

系統會重新啟動 Avid 編輯應用程式，然後您便能夠存取 PhraseFind。

PhraseFind 的 30 天試用版在試用期間也包含存取所有可用語言。您暫時無須啟動
任何額外語言套件。但是，您需要在 PhraseFind 視窗的 Select a Language （選
取語言）功能表中選取語言。

5. 在 PhraseFind 視窗從 Select a Language （選取語言）選取語言，並等待
PhraseFind Index （索引）變為綠色。

執行 ScriptSync 30 天試用版：

1. 啟動 Avid 編輯應用程式，然後開啟 Avid 專案。

2. 建立腳本， File > New Script （檔案 > 新腳本）。

3. 瀏覽至您的腳本，然後按一下 Open （開啟）。

4. 在腳本中按一下您想放置片段 （鏡頭）的部分。

畫面上將會反白顯示部分。

5. 從 bin 拖曳片段至腳本的選取部分。

腳本中片段下的方塊應亮顯為黑色。表示已選取腳本中的相關片段。

6. 選取 Script （腳本） > ScriptSync。

系統將會檢查您的系統是否裝有 ScriptSync 並打開對話方塊。
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7. 按一下 Run Trial （執行試用版）。

您可即時存取至 ScriptSync 視窗。

30 天試用期間購買 Avid 編輯應用程式：

t 轉至  Avid 網路商店：http://shop.avid.com/store/  以購買 Avid 編輯應用程式。

30 天試用期間購買 PhraseFind 或 ScriptSync：

1. 啟動 Avid 編輯應用程式，然後開啟 Avid 專案。

2. 對於 ScriptSync，請按照第 268頁的 「執行 ScriptSync 30 天試用版：」 下的第1
步至第 5 步，然後選取 Script （腳本） > ScriptSync。

3. 對於 PhraseFind，按 Ctrl+F 或 Command+F 或選取 Edit > Find （編輯 > 尋
找）。

畫面上將會打開 Find （尋找）視窗。

4. 對於 PhraseFind，在文字方塊中輸入單字或詞組，然後按一下 PhraseFind 按鈕。

系統將會通知您 30 天試用期餘下多少日便完結。

5. 按一下 Buy （購買）。

n 如果沒有顯示 Buy （購買）按鈕，關閉 Find （尋找）視窗並重新啟動 Avid 編輯應用程
式。重複上述步驟。

系統打開 Avid 網路商店，讓您購買 PhraseFind 或 ScriptSync。購買並取得啟動
ID 後，您可啟動 PhraseFind 或 ScriptSync。

畫面上將會打開對話方塊，通知您啟動將會退出 Avid 編輯應用程式並啟動 Avid 授
權控制工具。
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6. 按一下 Continue （繼續）。

畫面上將會打開 Avid 授權控制工具。

若要啟動，請參閱第 252頁的 「使用電子啟動啟動 Avid 編輯應用程式」以繼續操
作。

啟動選項及功能

Avid 授權控制工具除了可啟動 Avid 編輯應用程式，也可啟動多個編輯選項或功能。

要啟動這些功能，請按照第 252頁的 「使用電子啟動啟動 Avid 編輯應用程式」 的步驟或
參閱以下列出的適當手冊。

• PhraseFind
PhraseFind 選項 （尋找語音）在單一專案中透過 bin 搜尋並尋找聲訊對話。
PhraseFind 需另行購買，並包含您所選的免費語言套件。如需詳細資訊，請參閱
Avid 編輯 Help （幫助）或 《開始使用 PhraseFind》手冊的 Purchasing and
Activating PhraseFind （購買及啟動 PhraseFind）。

• ScriptSync
ScriptSync 使用語音索引技術，分析片段的音訊部分並與腳本文字的每行配對。
ScriptSync 需另行購買。如需詳細資訊，請參閱 Avid 編輯 Help （幫助）或 《開
始使用 ScriptSync》手冊的 Purchasing and Activating ScriptSync（購買及啟動
ScriptSync）。

• PhraseFind Language Pack
可購買額外語言套件配合 PhraseFind 使用。語言套件需另行購買。如需詳細資訊，
請參閱 Avid 編輯 Help （幫助）或 《開始使用 PhraseFind》手冊的 Activating
Additional Regional Language Packs （啟動額外地區語言套件）。

• AVCHD Dolby AC-3 匯入或連結至 AMA
此功能用於匯入或 AMA 連結至 AVCHD 傳輸串流 (.mts) 檔案。如果首次匯入或 AMA
連結至 .mts 檔案時沒有連接至網際網路，系統將會打開對話方塊及 Avid 授權控制工具。
請按照畫面上的指示啟動此功能。如果您已連接至網際網路，啟動會自動進行。
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停用 Avid 編輯應用程式及選項 271

n 如果您使用相關格式，才會顯示 AVCHD Dolby AC-3 功能。通常在 Avid 授權控制工
具中不會看見此選項。

停用 Avid 編輯應用程式及選項

如果您需要將 Avid 編輯應用程式移動至其他電腦，請先停用 Avid 編輯應用程式及選項，
然後解除安裝 Avid 編輯應用程式。

先停用 PhraseFind 及 ScriptSync，然後停用 Avid 編輯應用程式。

n 您必須備有網際網路連接以停用軟體及其選項。

n 您無須停用試用版本。

停用 Avid 編輯應用程式及選項：

1. 從 Avid 編輯應用程式，選取 Special > Deactivate Software License（特殊 > 停
用軟體授權）。

2. 畫面上將會出現訊息，通知您 Avid 編輯應用程式將會關閉而 Avid 授權控制工具將
會打開，按一下 Continue （繼續）。

3. 畫面上將會打開對話方塊並詢問您是否要離開 Avid 編輯應用程式，按一下 Leave
（離開）。

4. 或轉至以下位置以開啟 Avid 授權控制工具：
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

畫面上將會打開 Avid 授權控制工具。

5. 按一下 Avid 編輯應用程式、PhraseFind 或 ScriptSync 旁的 Deactivate（停用）。

如果您正在停用 PhraseFind，將會顯示訊息通知您與 PhraseFind 相關的語言套件
也會被停用。



6. 按一下 Yes （是）。

系統停用選取項目，而按鈕變更為 Activate （啟動）。

7. 按一下 Quit （結束）關閉視窗。

解除安裝 Avid 編輯應用程式

在安裝編輯應用程式前，您應該利用 Control Panel （控制台）的 Programs and
Features （程式及功能）以解除安裝 Digi 驅動程式。重新啟動系統，然後安裝新的編輯
應用程式。如果不移除 Digi 驅動程式，將無法載入 AudioSuite 插件程式，而您會收到
This software requires installation of device driver TPkd and a reboot before
running （本軟體要求安裝裝置驅動程式 TPkd 並在執行前重新啟動系統）或 DAE
Interface NOT Available （DAE 介面不可用）的錯誤訊息。如果在全新的系統上進行
全新安裝時出現這些錯誤，請利用 Windows Update 安裝 Hotfix KB926255，修正此
問題。

對於所有 Avid 編輯應用程式，以擁有管理權限的使用者身份登入並初始啟動應用程式。
如果使用共享儲存環境，請安裝您的工作空間。然後您能以一般使用者身份執行 Avid 編
輯應用程式。

如果您使用任何 Pro Tools 聲訊裝置 — 例如任何 Avid Mbox 系列裝置或 Avid Pro
Tools|HD Native 硬體 — 您必須個別安裝裝置驅動程式。 Avid 聲訊裝置驅動程式位於
以下目錄：

• (Windows) Program Files\Avid\Utilities\AudioDriverInstallers

• (Macintosh) Applications\Utilities\Avid Utilities\Avid Audio 
Drivers
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韌體更新附註 273

(Windows) 要解除安裝 Avid 編輯應用程式軟體，請執行以下操作之一：

1. 結束所有使用中的應用程式。

2. 存取 Control Panel （控制台）並選取 Programs and Features （程式及功能）。
然後選取編輯應用程式並按一下 Uninstall （解除安裝）。

(Macintosh) 解除安裝 Avid 編輯應用程式軟體：

1. 結束所有使用中的應用程式。

2. 轉至 Applications/Avid_Uninstaller/AvidEditingApplication。

3. 連按兩下 AvidEditingApplication 解除安裝程式。

4. 按照畫面上的提示執行操作。

韌體更新附註

在完成安裝操作後初次啟動編輯應用程式時，您可能會收到要求您更新 Avid 硬體韌體的
對話方塊。選取 Update （更新）。在更新過程中，請勿存取任何其他應用程式或移動任
何使用中的視窗。存取其他應用程式可能會使更新完成的對話方塊被隱藏起來。如果發生
此情況，更新進度會保持在 100% 但畫面上將不會顯示任何選項以繼續。顯示更新操作已
完成並提示您關閉系統的隱藏視窗將無法前置。如果發生此情況，您必須關閉而不僅僅是
重新啟動系統，然後再開啟系統電源。
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9 Avid 编辑应用程序安装指南。

有关 Avid 编辑应用程序的最新信息可从在线版本的“自述文件”中获取。您应经常在线查
看最新的发行说明或自述文件，因为在线版会随时在有新信息时更新。若要查看在线版本，
请在 Avid 编辑应用程序的 Help （帮助）菜单中选择 ReadMe （自述文件） ，或访问
Knowledge Base （知识库）：www.avid.com/readme。

直接从 Avid 安装 DVD 安装 Avid 编辑应用程序要求您的系统支持双层 DVD。如果您
的系统没有支持双层 DVD 的 DVD 驱动器，您可以从 Avid 下载中心 (www.avid.com/
support/downloads) 下载 Avid 编辑应用程序。

安装 Avid 编辑应用程序后，您可以使用 Avid 授权控制工具激活软件。Avid 授权控制工
具还可激活编辑选项。有关编辑选项的信息，请参阅“激活选项和功能” ， 第300页。

n 如果您拥有有效的 Avid 支持合同，您可以选择升级软件。有关详细信息，请参阅 Avid 下
载中心中提供的升级相关的说明或升级套件随带的说明。

c 如果更改系统配置（例如，更换硬盘、更换网卡或升级操作系统），应先停用 Avid 软件。
有关停用的信息，请参阅“停用 Avid 编辑应用程序及其选项” ， 第301页。
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安装 Avid 编辑应用程序之前

安装编辑应用程序之前，请仔细阅读以下步骤。这些步骤仅供升级客户或新用户使用。请
为您的安装选择适用的步骤：

新用户
如果是新用户且从未在系统中安装过编辑应用程序，请按照第 9页至第 9页的说明操作。
从“安装 Avid 编辑应用程序” ， 第276页开始。

现有用户
如果是升级先前版本的编辑应用程序，则在安装和激活新软件之前，必须先卸载先前版本。

n 卸载 Avid 编辑应用程序之前，请写下系统 ID。您将需要旧系统 ID

 来激活新软件。

按照第 9页至第 9页说明操作。从“升级 Avid 编辑应用程序” ， 第288页开始。

安装 Avid 编辑应用程序

对于所有 Avid 编辑应用程序，以具有管理权限的用户身份登录，安装应用程序，并以具
有管理权限的用户身份对应用程序进行初始启动。如果使用共享存储环境，请安装您的工
作区。您以后就能以普通用户的身份运行 Avid 编辑应用程序。

n 安装编辑应用程序软件可能需要一些时间。对于个别编辑应用程序，可能需要 5 至 15 分
钟完成安装。安装整个编辑应用程序套件可能需要长达 35 分钟才能完成安装。
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(Windows) 若要安装 Avid 编辑应用程序软件：

1. 退出使用中的所有应用程序。

2. 插入编辑应用程序 DVD。

3. 单击以安装 Avid 编辑器套件或单个产品，并按屏幕说明操作。

n 如果显示 FilesInUse 对话框，您可以安全地选择“Ignore” （忽略）并继续操作。

n 如果在安装期间收到用户访问警告，请选择 Continue Anyway（仍然继续）以继续安装。

4. 在系统提示时选择 “Yes, restart my computer” （是，重新启动我的计算机）。

5. 继续执行“启动 Avid 编辑应用程序” ， 第278页。

(Macintosh) 若要安装 Avid 编辑应用程序软件：

1. 退出所有应用程序。

2. 插入编辑应用程序 DVD。

3. 双击 EditingApplicationName.pkg。

4. 单击以安装 Avid 编辑器套件或单个产品，并按屏幕说明操作。

5. 在系统提示时选择 “Yes, restart my computer” （是，重新启动我的计算机）。

6. 继续执行“启动 Avid 编辑应用程序” ， 第278页。
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启动 Avid 编辑应用程序

安装过程中会添加一个桌面或 Dock 图标，并在 Start（开始）菜单中添加一个指向 Avid
编辑应用程序的指针。

如果您在便携式电脑上安装 Avid 编辑应用程序，可能打开一个对话框，显示有关不兼容
电源管理方案的消息。 Avid 建议您在使用 Avid 编辑应用程序时，对 Windows 7 使用
“High Performance” （高性能）电源选项。其他电源方案可能会影响编辑功能的性能
（例如，捕捉和数字剪切）。

安装 Avid 编辑应用程序的软件并且首次启动应用程序后，必须激活您的应用程序。

(Windows) 若要启动 Avid 编辑应用程序，请执行以下操作之一：

t 单击 Start > All Programs > Avid > Avid editing application（开始 > 所有程序
> Avid > Avid 编辑应用程序）。

t 双击 Avid 编辑应用程序桌面图标。

将打开 Welcome （欢迎）窗口。

(Macintosh) 若要启动 Avid 编辑应用程序，请执行以下操作之一：

1. 单击 Dock 上的 Avid 编辑应用程序别名图标。

2. 或选择 Go > Applications （转到 > 应用程序），然后双击 Avid 编辑应用程序文
件夹。然后双击 Avid 编辑应用程序文件。
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将打开 Welcome （欢迎）窗口。
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280 Avid 编辑应用程序安装指南。

3. 选择其中一个选项以激活您的软件。

t 若要使用电子激活进行激活，请选择 “I want to activate my software using
the Internet, another computer, or a volume license server”（我要使用因
特网、其他计算机或批量授权服务器激活软件），并单击 Continue （继续）。
将打开 Avid 授权控制工具。按照“使用电子激活对 Avid 编辑应用程序进行激
活” ， 第282页中的步骤操作。

t 若要使用硬件钥匙或加密狗激活，请选择 “I want to use a dongle to activate
my software”（我要使用加密狗激活软件），连接您拥有的加密狗，然后单击
Continue （继续）。
系统会确认您的信息。激活完成后，会显示一条消息，通知您软件已成功激活。

t 若要在“试用”模式下运行，请选择 “I want to run a fully-featured trial
version of the Avid editing application for 30 days” （我要运行全功能试
用版 Avid 编辑应用程序 30 天），并单击 Continue （继续）。
您的软件已成功激活。
有关“试用”模式的其他信息，请参阅 “运行 30 天试用版” ， 第297页。



我需要什么来激活 Avid 编辑应用程序？

识别 (ID) 码： 在哪里可以找到它们：

激活 ID 本指南的封面内页。

如果是从 Avid 网上商店购买，您将通过 Avid 电子邮件收到激活

ID。

如果是从 Avid 网上商店购买，请在 http://account.avid.com/ 
登录至您的商店帐户。

系统 ID 新用户请查看本指南的封面内页。
现有用户需要使用旧的系统 ID。

如果是在线购买， Avid 会通过电子邮件给您发送系统 ID。

Avid 编辑应用程序初始屏幕 (Help > About Avid editing
application) （帮助 > 关于 Avid 编辑应用程序）。

Avid 编辑应用程序控制台 (Tools > Console, then scroll to
System ID) （工具 > 控制台，然后滚动至系统 ID）。

如果是从 Avid 网上商店购买，您可以在 
http://account.avid.com/ 登录至商店帐户，以查看您的系统 
ID 号码。
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使用电子激活对 Avid 编辑应用程序进行激活

• 如可访问因特网 - 请参阅“在有因特网连接时使用电子激活对 Avid 编辑应用程序进
行激活” ， 第283页。

• 如不可访问因特网 - 请参阅“在无因特网连接时使用电子激活对 Avid 编辑应用程序
进行激活” ， 第287页。

• 如通过批量授权服务器 - 请参阅“使用批量授权服务器激活 Avid 编辑应用程序” ，
第288页。

系统 ID （续） 激活后，Avid 授权控制工具的 授权配置文件选项卡会显
示您的系统相关信息。单击 Copy（复制）将信息复制到剪贴
板。然后，您可以从剪贴板将其剪切并复制到电子邮件，或创建
文本文件。如果需要保存此信息以供日后参考，或需要发送信息
给 Avid 客户支持团队，此操作会有用。

设备 ID 仅限当您在一个没有连接到互联网的系统上激活您的软
件。此信息会在激活时通过 Avid 授权控制工具提供给您。

识别 (ID) 码： 在哪里可以找到它们：
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在有因特网连接时使用电子激活对 Avid 编辑应用程序进行激活

1. 使 Avid 授权控制工具保持打开状态，单击 Avid 编辑应用程序旁的 Activate（激活）。
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将打开以下内容。

2. 选择 “ 我已连接到互联网，并将使用这台计算机 ”，然后单击 “ 继续
”(Continue)。
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将打开一个窗口，您可在其中输入系统信息并注册产品。

3. 在 System ID （系统 ID）文本框中输入系统识别码。若要查找您的系统 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。

4. 在 Activation ID （激活 ID）文本框中输入激活识别码。若要查找激活 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。

5. 如果要查阅 Avid 的隐私政策，请单击 Read Privacy Policy （阅读隐私政策）。
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6. 请执行以下操作之一：

t 选择 “Register your software” （注册软件） ，然后单击 Continue （下一
步）。

将打开注册对话框。 Avid 的在线注册可让您接收重要更新和维护信息。

t 选择 “Don’t register your software” （不要注册软件），然后单击 Activate
（激活）。

Avid 授权控制工具确认系统信息。激活完成后，会显示一条消息，通知您软件
已成功激活。

n 如果不想现在注册软件，您可随时在 Avid 编辑应用程序中选择 Special > Register（特殊 >
注册）进行注册。

7. 如果选择注册您的软件，请执行以下操作：

a. 在 Register （注册）对话框的相应文本框中键入您的名字、地址和联系信息。
星号 (*) 标示必填字段。

b. 单击 Next （下一步）

将打开注册对话框。

c. 输入相应的产品和客户信息。

d. 单击 Activate and Register （激活和注册）。

8. 如果 Avid 编辑应用程序已打开，应重新启动以使更改生效。
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在无因特网连接时使用电子激活对 Avid 编辑应用程序进行激活

1. 使 Avid 授权控制工具保持打开状态，单击 Avid 编辑应用程序旁的 Activate（激活）。

将打开激活窗口。

2. 选择 “ 我没有连接到互联网，并将使用另一台连接到互联网的计算机 ”，然后点击继
续 (Continue)。

3. 在 System ID （系统 ID）文本框中输入系统识别码。若要查找您的系统 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。

n 设备 ID 显示在 Activation （激活）页面的底部，请写下此号码以便日后使用。

4. 在 Activation ID （激活 ID）文本框中输入激活识别码。若要查找激活 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。

5. 单击“下一步”(Next)。

6. 按照 Avid 授权控制工具的指示，然后单击“下一步”(Next)。

7. 在 一 台 连 接 到 互 联 网 的 计 算 机 上，打 开 一 个 网 络 浏 览 器 并 导 航 到
http://avid.com/license。

8. 按照屏幕上的网页说明。

系统创建一个 license.bin 文件。此文件包含激活您的 Avid 编辑应用程序所需的授
权信息。

9. 一旦您检索到 license.bin 文件，请返回到您想要激活的计算机。

10. 在 Avid 授权控制工具中，单击“浏览”(Browse)并导航至您系统中的 license.bin
文件，然后单击“打开”(Open)。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激活，并
且按钮变为 Deactivate （停用）。
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n 对每个需要激活的编辑应用程序或选项重复先前的步骤。

11. 如果 Avid 编辑应用程序已打开，应重新启动以使任何更改生效。

使用批量授权服务器激活 Avid 编辑应用程序

您可以使用批量授权服务器激活和管理多个编辑客户端 有关详细信息，请参阅知识库中的
FlexNet Device Manager for Avid （适用于 Avid 的 FlexNet 设备管理器）指南。

升级 Avid 编辑应用程序

您可将 Avid 编辑应用程序从现有的软件授权或加密狗授权升级。如果从加密狗授权升级
或更改产品型号，则升级套件包含一个加密狗升级卡、升级码以及软件激活码。请参阅升
级套件随附的说明，以更新软件。

如果先前已购买 PhraseFind、 PhraseFind Language Packs 或 ScriptSync，您的授权
激活应可自动更新。如果购买新选项，您将收到新的激活 ID。

n 将加密狗授权升级至软件授权，会禁用加密狗。激活软件授权后，不需要加密狗即可运行
Avid 编辑应用程序，并且加密狗已无法使用。

如果您升级现有授权且您拥有有效的 Avid 支持合同，请在更新系统前先阅读 Avid 下载中
心提供的说明或升级套件随附的说明。所有 Avid 支持合同客户必须使用 Versioner.avd.文
件升级软件，如本主题的上一步骤所述。有关详细信息，请参阅 Avid 知识库中的
“Software Licensing Upgrade Process for Support Customers”（适用于支持客户的软
件授权升级过程）主题 (www.avid.com/US/support)。

以下是升级 Avid 编辑系统、PhraseFind 或 ScriptSync 选项时应遵照执行的高级别步骤。
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升级工作流程 

1. 卸载现有 Avid 编辑应用程序。

请参阅“卸载 Avid 编辑应用程序” ， 第302页。

PhraseFind 和 ScriptSync 会随 Avid 编辑应用程序一起卸载。

n 卸载 Avid 编辑应用程序之前，请写下系统 ID。您将需要旧系统 ID 来激活新软件。

2. 安装新的 Avid 编辑应用程序。

请参阅“安装 Avid 编辑应用程序” ， 第276页。

PhraseFind 和 ScriptSync 会随 Avid 编辑应用程序一起安装。如果先前已购买
PhraseFind、PhraseFind Language Packs 或 ScriptSync，您的授权激活应可自
动更新。如果购买新选项，您将收到新的激活 ID。

3. 激活 Avid 编辑应用程序。

视您的设置而定，请参阅以下升级步骤。
有关 Avid 授权控制工具的详细信息，请参阅“使用电子激活对 Avid 编辑应用程序
进行激活” ， 第282页。

4. 激活 PhraseFind、 PhraseFind 语言包或 ScriptSync。

请参阅“使用电子激活对 Avid 编辑应用程序进行激活” ， 第282页。
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若要在有因特网连接时从现有软件授权升级 Avid 编辑应用程序：

1. 转到以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control （开始 / 所有程
序 /Avid/实用程序 /授权控制）
(Macintosh) Applications/Utilities/Avid Utilities/License Control （应用程序
/实用程序 /Avid 实用程序 /授权控制）

将打开 Avid 授权控制工具。

2. 单击 Avid 编辑应用程序旁的 Activate （激活）。

将打开激活窗口。

3. 选择“我已连接到互联网，并将使用这台计算机”，然后单击“继续”(Continue)。

将打开一个窗口，您可在其中输入系统信息并注册产品。

4. 如果未显示系统 ID，请在 System ID （系统 ID）文本框中输入系统识别码。现有
客户请使用旧的系统 ID。
如果未显示系统 ID 且要进行查找，请参阅“ 我需要什么来激活 Avid 编辑应用程
序？ ” ， 第281页。

n 如果先前的编辑器包括已购买的 PhraseFind 或 ScriptSync 等选项，这些选项会在升级
时自动激活。

5. 在 Activation ID（激活 ID）文本框中输入激活识别码。使用新版本软件的激活 ID。
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6. 请执行以下操作之一：

t 如果从未注册产品，请选择 Register your product with Avid Technology,
Inc. now （请立即向 Avid Technology, Inc. 注册您的产品） 。如果要查阅
Avid 的隐私政策，请单击 Read Privacy Policy（阅读隐私政策）。然后单击
Next （下一步）。

将打开注册对话框。 Avid 的在线注册可让您接收重要更新和维护信息。

t 选择 Don’t register at this time（此时不注册），然后单击 Activate（激活）。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激活。

n 如果不想现在注册软件，您可随时在 Avid 编辑应用程序中选择 Special > Register（特殊 >
注册）进行注册。

7. 如果在步骤 6 中选择注册软件，请执行以下操作：

a. 在 Register （注册）对话框的相应文本框中键入您的名字、地址和联系信息。
星号 (*) 标示必填字段。

b. 单击 Next （下一步）

将打开注册对话框。

c. 输入相应的产品和客户信息。

d. 单击 Activate and Register （激活和注册）。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激
活，并且按钮变为 Deactivate （停用）。

8. 单击 OK （确定）。
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若要在有因特网连接时将 Avid 编辑应用程序从加密狗授权升级为软件授权：

1. 将加密狗连接至 Avid 编辑系统。

2. 转到以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control （开始 / 所有程
序 /Avid/实用程序 /授权控制）
(Macintosh) Applications/Utilities/Avid Utilities/License Control （应用程序
/实用程序 /Avid 实用程序 /授权控制）

将打开 Avid 授权控制工具。

3. 单击 Avid 编辑应用程序旁的 Activate （激活）。

将打开 Activation （激活）对话框。

4. 选择“我已连接到互联网，并将使用这台计算机”，然后单击“继续”(Continue)。

将打开一个窗口，您可在其中输入系统信息并注册产品。

5. 如果未显示系统 ID，请在 System ID （系统 ID）文本框中输入系统识别码。现有
客户请使用旧的系统 ID。
如果未显示系统 ID 且要进行查找，请参阅“ 我需要什么来激活 Avid 编辑应用程
序？ ” ， 第281页。

n 如果先前的编辑器包括已购买的 PhraseFind 或 ScriptSync 等选项，这些选项会在升级
时自动激活。

6. 在 Activation ID （激活 ID）文本框中输入激活识别码。若要查找激活 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。
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7. 请执行以下操作之一：

t 如果从未注册产品，请选择 Register your product with Avid Technology,
Inc. now （请立即向 Avid Technology, Inc. 注册您的产品） 。如果要查阅
Avid 的隐私政策，请单击 Read Privacy Policy（阅读隐私政策）。然后单击
Next （下一步）。

将打开注册对话框。 Avid 的在线注册可让您接收重要更新和维护信息。

t 选择 Don’t register at this time （此时不注册） ，然后单击 Activate （激
活）。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激
活。

n 如果不想现在注册软件，您可随时在 Avid 编辑应用程序中选择 Special > Register （特
殊 > 注册）进行注册。

8. 如果在步骤 7 中选择注册软件，请执行以下操作：

a. 在 Register （注册）对话框的相应文本框中键入您的名字、地址和联系信息。
星号 (*) 标示必填字段。

b. 单击 Next （下一步）

将打开注册对话框。

c. 输入相应的产品和客户信息。

d. 单击“Activate” （激活）。

9. 系统询问您是否确定要停用加密狗。单击 OK （确定）。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激活。

10. 单击 OK （确定）。
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若要在无因特网连接时将 Avid 编辑应用程序升级至软件授权： 

1. 转到以下位置：
(Windows) Start/All Programs/Avid/Utilities/License Control （开始 / 所有程
序 /Avid/实用程序 /授权控制）
(Macintosh) Applications/Utilities/Avid Utilities/License Control （应用程序
/实用程序 /Avid 实用程序 /授权控制）

将打开 Avid 授权控制工具。

2. 单击 Avid 编辑应用程序旁的 Activate （激活）。

将打开激活窗口。

3. 选择 “ 我没有连接到互联网，并将使用另一台连接到互联网的计算机 ”，然后点击继
续 (Continue)。

将打开一个窗口，您可在其中输入系统信息并注册产品。

4. 如果未显示系统 ID，请在 System ID （系统 ID）文本框中输入系统识别码。现有
客户请使用旧的系统 ID。
如果未显示系统 ID 且要进行查找，请参阅“ 我需要什么来激活 Avid 编辑应用程
序？ ” ， 第281页。

n 如果先前的编辑器包括已购买的 PhraseFind 或 ScriptSync 等选项，这些选项会在升级
时自动激活。

n 设备 ID 显示在 Activation （激活）页面的底部，请写下此号码以便日后使用。

5. 在 Activation ID （激活 ID）文本框中输入激活识别码。若要查找激活 ID，请参
阅“我需要什么来激活 Avid 编辑应用程序？ ” ， 第281页。

n 在需要激活的系统中使 Avid 授权控制工具保持打开状态。您将需要输入其他信息。

6. 单击“下一步”(Next)。
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7. 按照 Avid 授权控制工具的指示，然后单击“下一步”(Next)。

8. 在 一 台 连 接 到 互 联 网 的 计 算 机 上，打 开 一 个 网 络 浏 览 器 并 导 航 到
http://avid.com/license。

9. 按照屏幕上的网页说明。

系统创建一个 license.bin 文件。此文件包含激活您的 Avid 编辑应用程序所需的授
权信息。

10. 一旦您检索到 license.bin 文件，请返回到您想要激活的计算机。

11. 在 Avid 授权控制工具中，单击 Browse（浏览）并导航到至您系统中的 license.bin
文件，然后单击 Open （打开）。

激活工具确认系统信息。激活完成后，会显示一条消息，通知您软件已成功激活，并
且按钮变为 Deactivate （停用）。

n 对每个需要激活的编辑应用程序或选项重复先前的步骤。

12. 如果 Avid 编辑应用程序已打开，应重新启动以使任何更改生效。

若要使用加密狗升级 Avid 编辑应用程序：

1. 确保已将加密狗连接至 Avid 编辑系统。

2. 浏览至安装 DongleManager.exe 的目录：

t (Windows) C:\Program Files\Avid\Utilities\DongleManager （
C:\程序文件 \Avid\实用程序 \DongleManager）

t (Macintosh) Macintosh HD\Applications\Utilities\Avid Utilities\ 
DongleManager （Macintosh HD\应用程序 \实用程序 \Avid 实用程序
\DongleManager）

3. 双击 DongleManager.exe

将打开 Dongle Manager （加密狗管理器）窗口。

http://avid.com/license


4. 单击 Update （更新）选项卡。

5. 单击 Open （打开），然后浏览到加密狗更新器 (.avd) 文件的位置。

6. 选择更新器文件，并单击 Open （打开）。

7. 单击 Update （更新）。

DongleManager.exe 应用程序会更新您的加密狗，并显示一条 Verification
Complete （完成验证）消息。

8. 启动 Avid 编辑应用程序。

将打开 Welcome （欢迎）窗口。

9. 选择 “I want to use a dongle to activate my software” （我要使用加密狗激活软
件）。

10. 单击“Continue” （继续）。

系统会确认您的信息。激活完成后，会显示一条消息，通知您软件已成功激活。

若要使用 Versioner.avd 文件（仅供 Avid 支持合同客户使用）升级 Avid 编辑应用
程序： 

1. 下载适用于您的编辑应用程序的 Versioner.avd 文件。

2. 将 Versioner.avd 文件放在编辑应用程序文件夹中：

(Windows) [驱动器 ]:/程序文件 /Avid/[Avid 编辑应用程序 ]

(Macintosh) Macintosh HD/应用程序 /[Avid 编辑应用程序 ]

3. 启动 Avid 编辑应用程序。

将打开 Avid 授权控制工具。

4. 单击 Avid 编辑应用程序旁的 Activate （激活）。
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5. 请执行以下操作之一：

t 选择“我已连接到互联网，且我将使用这台计算机。 ”

t 选择“我没有连接到互联网，我将使用另一台已连接到互联网的计算机。 ”

6. 单击“Continue” （继续）。

将打开 Avid Activation（Avid 激活）对话框。系统自动填充系统 ID 和激活 ID。

n 如果使用加密狗，则仅在连接加密狗后才会填充系统 ID 和激活 ID。

7. 对于您在步骤 5 中选择的授权选项，请继续执行本章节中所述的升级授权激活步骤。

运行 30 天试用版

购买 Avid 编辑应用程序、PhraseFind 或 ScriptSync 之前，您可以试用 30 天。如果运
行 30 天试用版 Avid 编辑应用程序，您会同时获得 30 天试用版 PhraseFind 和
ScriptSync。30 天试用版 PhraseFind 还包括在试用期间对所有可用语言的访问权限。此
时您无需激活任何其他语言包。但是，您需要在 PhraseFind 窗口中的 Select a
Language （选择语言）菜单中选择您的语言。

如果已拥有 Avid 编辑应用程序，您可以运行 30 天试用版 PhraseFind 或 ScriptSync。

30 天后，如果不购买 Avid 编辑应用程序、PhraseFind 或 ScriptSync，您将无法再使用
产品及其功能。系统将持续通知您试用期的剩余天数。

n 在 30 天试用期内创建的任何素材屉或项目仅在您激活完全编辑授权后才可使用。



若要试用 Avid 编辑应用程序 30 天：

1. 启动 Avid 编辑应用程序。

将打开 Welcome （欢迎）窗口。

2. 选择 “I want to run a fully-featured, trial version of the Avid editing
application for 30 days” （我要运行全功能试用版 Avid 编辑系统 30 天 ）。

3. 单击“Continue” （继续）。

您的软件已成功激活。在 30 天试用期中的任何时候，您均可选择购买 Avid 编辑应
用程序。如果不选择购买软件， Avid 编辑应用程序会在 30 天试用期到期后停用。

若要在 30 天试用期内运行 PhraseFind：

1. 打开 Avid 编辑应用程序，并打开 Avid 项目。

2. 按 Ctrl+F 或 Command+F 或选择 Edit > Find （编辑 > 查找）。

将打开 Find （查找）窗口。

3. 在文本框中输入词语或词组，然后单击 PhraseFind 按钮。

系统检查您的系统中是否有 PhraseFind，然后打开一个对话框。

4. 单击 Run Trial （运行试用版）。

系统重新启动 Avid 编辑应用程序，然后您将可访问 PhraseFind。

30 天试用版 PhraseFind 还包括在试用期间对所有可用语言的访问权限。此时您无
需激活任何其他语言包。但是，您需要在 PhraseFind 窗口中的 Select a Language
（选择语言）菜单中选择您的语言。

5. 在 PhraseFind 窗口中，从 Select a Language（选择语言）菜单中选择您的语言，
然后等待 PhraseFind Index （索引）变成稳定的绿色。
298 Avid 编辑应用程序安装指南。



若要在 30 天试用期内运行 ScriptSync：

1. 打开 Avid 编辑应用程序，并打开 Avid 项目。

2. 创建脚本， File > New Script （文件 > 新建脚本）。

3. 浏览至您的脚本，然后单击 Open （打开）。

4. 在脚本中，单击您要放置素材片段 （提取）的部分。

该部分将加亮显示。

5. 对于素材屉，将素材片段拖动到脚本的所选部分。

脚本中素材片段下方的方框应该会加亮显示为黑色。这表示在脚本中选择了该素材
片段。

6. 选择 Script > ScriptSync （脚本 > ScriptSync）。

系统检查您的系统中是否有 ScriptSync，然后打开一个对话框。

7. 单击 Run Trial （运行试用版）。

现在您即可访问 ScriptSync 窗口。

若要在 30 天试用期内购买 Avid 编辑应用程序：

t 请转到 Avid 网上商店：http://shop.avid.com/store/ 购买 Avid 编辑应用程序。

若要在 30 天试用期内购买 PhraseFind 或 ScriptSync：

1. 打开 Avid 编辑应用程序，并打开 Avid 项目。

2. 对于 ScriptSync，按照“若要在 30 天试用期内运行 ScriptSync：” ， 第299页中
的步骤 1 至 5 操作，然后选择 Script > ScriptSync （脚本 > ScriptSync）。

3. 对于 PhraseFind，按 Ctrl+F 或 Command+F 或选择 Edit > Find （编辑 > 查
找）。

将打开 Find （查找）窗口。
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4. 对于 PhraseFind，在文本框中输入词语或词组，然后单击 PhraseFind 按钮。

系统将持续通知您 30 天试用期的剩余天数。

5. 单击 Buy （购买）。

n 如果未显示 Buy （购买）按钮，请关闭 Find （查找）窗口，并重新启动 Avid 编辑应用
程序。重复上述步骤。

系统将打开 Avid 网上商店，以让您购买 PhraseFind 或 ScriptSync。购买并获取
激活 ID 后，您可以激活 PhraseFind 或 ScriptSync。

将打开一个对话框，通知您激活过程将退出您的 Avid 编辑应用程序，并启动 Avid
授权控制工具。

6. 单击“Continue” （继续）。

将打开 Avid 授权控制工具。

若要激活，请参阅“使用电子激活对 Avid 编辑应用程序进行激活” ， 第282页继
续。

激活选项和功能

除激活 Avid 编辑应用程序以外，还可通过 Avid 授权控制工具激活多个编辑选项和功能。

若要激活这些功能，请按照“使用电子激活对 Avid 编辑应用程序进行激活” ， 第282页
中的步骤操作，或参阅下方所列的适当指南。

• PhraseFind
PhraseFind 选项 （拼音查找）在单个项目的素材屉中搜索和查找音频对话。
PhraseFind 需要单独购买，其中包括您选择的免费语言包。有关详细信息，请参阅
Avid 编辑帮助或 Getting Started with PhraseFind （PhraseFind 快速入门）指
南中的 “Purchasing and Activating PhraseFind” （购买和激活 PhraseFind）。
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• ScriptSync
ScriptSync 使用拼音索引技术分析素材片段的音频部分，并将其与脚本文本的行匹
配。 ScriptSync 需要单独购买。有关详细信息，请参阅 Avid 编辑帮助或 Getting
Started with ScriptSync （ScriptSync 快速入门）指南中的 “Purchasing and
Activating ScriptSync” （购买和激活 ScriptSync）。

• PhraseFind 语言包
可购买其他语言包，以与 PhraseFind 搭配使用。语言包需要单独购买。有关详细信
息，请参阅 Avid 编辑帮助或 Getting Started with PhraseFind （PhraseFind 快
速入门）指南中的 “Activating Additional Regional Language Packs” （激活其
他地区语言包）。

• AVCHD Dolby AC-3 导入或 AMA 链接
此功能用于导入或 AMA 链接至 AVCHD 传输流 (.mts) 文件。如果首次导入或
AMA 链接至 .mts 文件时未连接至因特网，则系统会打开一个对话框，然后打开
Avid 授权控制工具。按屏幕上的说明激活此功能。如果您已连接到因特网，则将自
动激活此功能。

n AVCHD Dolby AC-3 功能仅在您使用此格式时显示。您一般不会在 Avid 授权控制工具
中看到此选项。

停用 Avid 编辑应用程序及其选项

如果需要将 Avid 编辑应用程序移至其他电脑，请在卸载 Avid 编辑应用程序前停用 Avid
编辑应用程序及其选项。

首先停用 PhraseFind 和 ScriptSync，然后停用 Avid 编辑应用程序。

n 您必须有因特网连接，才能停用软件及其选项。

n 您无需停用试用版。
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停用 Avid 编辑应用程序及其选项：

1. 在 Avid 编辑应用程序中，选择 Special > Deactivate Software License（特殊 >
停用软件授权）。

2. 将显示一条消息，通知您 Avid 编辑应用程序将关闭， Avid 授权控制工具将打开，
单击 Continue （继续）。

3. 将打开一个对话框，询问您是否要离开 Avid 编辑应用程序，单击 Leave （离开）。

4. 或转到以下位置，以打开 Avid 授权控制工具：
(Windows) Start/All Programs/Avid/Utilities/License Control （开始 / 所有程
序 /Avid/实用程序 /授权控制）
(Macintosh) Applications/Utilities/Avid Utilities/License Control （应用程序
/实用程序 /Avid 实用程序 /授权控制）

将打开 Avid 授权控制工具。

5. 在 Avid 编辑应用程序、PhraseFind 或 ScriptSync 旁，单击 Deactivate（停用）。

如果停用 PhraseFind，将显示一条消息，通知您与 PhraseFind 关联的语言包也会
停用。

6. 单击 Yes （是）。

系统停用所选项目，按钮变为 Activate （激活）。

7. 单击 Quit （退出）关闭窗口。

卸载 Avid 编辑应用程序

安装编辑应用程序之前，您应使用 Control Panel （控制面板）中的 Programs and
Features （程序和功能）来卸载 Digi 驱动程序。重新启动系统，然后安装新的编辑应用
程序。如果不卸载 Digi 驱动程序，系统就不会加载 Audiosuite 插件程序，您或许会收到
“This software requires installation of device driver TPkd and a reboot before
running” （本软件要求安装设备驱动程序 TPkd 并在运行前重新启动系统）或 “DAE
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Interface NOT Available” （DAE 接口不可用）错误消息。如果在全新的计算机上进行
全新的安装时出现这些错误消息，请利用 Windows Update 安装热修复补 KB926255
以修复此问题。

对于所有 Avid 编辑应用程序，以具有管理权限的用户身份登录并对应用程序进行初始启
动。如果使用共享存储环境，请安装您的工作区。您以后就能以普通用户的身份运行 Avid
编辑应用程序。

如果您使用任意 Pro Tools 音频设备 （例如，任意一个 Avid Mbox 系列的设备或 Avid
Pro Tools|HD Native 硬件），则您必须单独安装该设备的驱动程序。Avid 音频设备的驱
动程序位于以下目录：

• (Windows) 程序文件\Avid\实用程序\AudioDriverInstallers

• (Macintosh) 应用程序\实用程序\Avid 实用程序\Avid 音频驱动程序

(Windows) 若要卸载 Avid 编辑应用程序软件，请执行以下操作之一：

1. 退出使用中的所有应用程序。

2. 访问 Control Panel（控制面板）并选择 Programs and Features（程序和功能）。
然后选择编辑应用程序并单击 Uninstall （卸载）。

(Macintosh) 若要卸载 Avid 编辑应用程序软件：

1. 退出使用中的所有应用程序。

2. 转到应用程序 /Avid_Uninstaller/AvidEditingApplication。

3. 双击 AvidEditingApplication 卸载程序。

4. 按照屏幕上的提示完成操作。
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固件更新备注

安装编辑应用程序后首次使用时，您可能会收到需要您更新 Avid 硬件固件的对话框。选
择进行“更新”。在更新过程间，请不要访问任何其他应用程序或移动任意一个活动窗口。
访问其他应用程序可能会导致隐藏完成更新的进度对话框。如果发生这种情况，您将会看
到更新进度停留在 100%，而您无法选择继续更新。将无法前置说明更新已完成及提示您
关闭系统的隐藏窗口。如果发生这种情况，您必须关闭系统然后再次打开系统电源，而不
仅仅是重新启动系统。
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